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PHAN 1
TONG QUAN VE CAC MENU LENH CUA GEOPLAN-GEOSPACE

I. GIAO DIEN CUA PHAN MEM GEOPLAN-GEOSPACE: ,
Sau khi cai dat va khéoi dong chuong trinh thi méc dinh chuong trinh xuat

hién giao dién bang tiéng Phap nhu sau:

EY Geoplan-Geospace =R |E=H Ex=

Fichier Fenétre Aide Options

= | &

A

Cette version de Geoplan-Geospace,
mise gratutement 4 dizpostion du monde
enseignant en Juin 2007, contient de
nouvelles options permettant d'utthzer les
nombres complexes et la langue stalienne.

Ces nouvelles options ne sont pas
référencées dans les fichiers d'aide.

Le développement de cette version
exclustrement "PC et Windows" n'est
plus un objectif de 'ATD - CREEDL

Pé chuyén sang giao dién tiéng Anh ta click vao menu Options chon langue va

chon Anglais (dong thir hai), giao dién chuong trinh chuyén sang tiéng Anh nhu

&
Sau:

Fy Geoplan-Geospace [F=E|EoH ==

File Window Help Options

= | o

Cette version de Geoplan-Geospace,
tmise gratuiternent 4 disposition du monde
enseighant en Juin 2007, contient de
nouvelles options permettant d'utilizer les
notnbres complexes et la langue italienne.

Ces nowvelles options ne sont pas
référencées dans les fichiers d'aide.

Le développement de cette wersion
exclusivement "PC et Windows" n'est
plus un ohjectifde 'ATD - CREEM
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Trén thanh menu cua Geoplan — Geospace, ta chon File > New Geospace figure

xuat hién giao di¢n cua Geospace nhu sau:

Y Geoplan-Geospace - [Geospace_1] = |2 ]
# File Create Pilating  Showing  Other  Edit  Wiews Window Help Options - |5 =
|| W | o || > [ < [ R[5 |vis |Mp| 0| Ts| @D roe|uss|nn 5| P

\

[

"N\

bis

B

T

Y nghia cic niit 1énh t@n}%anh cong cu (toolbar):

2| Mo tap tin Geoplan (hinh Vf 2D)
L0\ \

\33 MG¢ tap tin Geospace (hinh vé 3D)

Luu tap tin hinh v€ hién thot

Mo bang dan}l muc cac \(\i’gi tuong da dung

Mo bang kiéu vé hinh

Phong to hinh

Thu nhé k\lin\h

Bat/tit ché do hién thi dam/nhat

Bat/ tit ché do hién thi hé truc toa do

Bat/tat ché d6 hién thi khung hinh anh

Lip lai 1énh vira thuc hién trudc d6 (phim tit Ctrl+B)
Stra chira/Nhan ban hinh vé

Bat tat ché do tao vét
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Bat/tat ché do tao vét theo yéu cau
B Bat/ tit ché do xem anh dang hinh khéi
Bat/tat ché do xem anh dang hinh v€& nét lién — nét dut

#««] Xem hinh vo1 cach nhin lién trudc cach nhin hién tai

>3] Xem hinh v6i cach nhin lién sau cach nhin hién tai /“'\ /\
2 Bat/tat ché do chiéu song song

7t Xoay hinh xung quanh truc vudéng géc véi man hinh (két h(_)p«(érii)him chuot
phai)

@ Nhin hinh theo mit phang riéng \ Y

II. TONG QUAN VE CAC LENH CUA GEOSPACE:

1. FILE: T4p tin:
File | Create Piloting Showing  Other  Edit  Wiews Winde

Mew Geoplan figure

Mew Geospace figure

Open a plane figure

Open a figure of the space

Save Ctrl+3%
ave as

Close active figure
Print
Print setup
Sawe a picture
Quit (Geaplan-Geaspace)
( ]31: New Geoplan figuare: Tap tin hinh vé 2D moi.
1-2: New Geospace figure: Tap tin hinh v€ 3D moi.
x 1-3: Open a plan figure: M& mot hinh vé& phang
1-4: Open a figure of the space: M¢ hinh v€ khong gian.
1-5: Save (Ctrl + S): Luu tap tin.
1-6: Save as: Luu tap tin voi tén khac
1-7: Close active figure: Dong hinh v€ hién thoi.
1-8: Print: In

@’w Thark M - THTT Nyi Gia T G T, Tay Vi y
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1-9: Print setup: Thiét dit in.
1-10: Save a picture: Luu hinh

1-11: Quit (Geoplan-Geospace): Thoat chuong trinh.
2. CREATE: Dung hinh

Create | Piloting  Showing

Faint

Line

Plane
Transformation
Murmeric
Coordinate system
Length unit
Wector

Solid
Display

Command

2-1: Point: Dung diém

2-1-1: Free point: Dyng diém tu do:

Create | Piloting showing  Oth

Paint

Line

Plane
Transformation
Mumeric
Coordinate systern
Length unit

YWector
=olid
Display

Command

k

4

Free point

Paint by coordinate(s)
Intersection 2 lines
Intersection line-plane
Intersection line-circle
Intersection 2 circles
Intersection line-sphere
Midpaoint

Center frarious)
Barpcenter

Irnage paoint by

Oth

In space

On a plane

Cnaline

On a ray

On a segment

Cnoa circle

O an arc

Wiédith integer coordinates
Wéith integer abscissa
Ina paolygon

On a sphere

2-1-1-1: In space: Trong khong gian

2-1-1-2: On a plan: Trén 1 mat phang

2-1-1-3: On a line: Trén 1 duong thang
2-1-1-4: On a ray: Trén 1 tia

2-1-1-5: On a segment: Trén mot doan thang

2-1-1-6: On a circle: Trén mdt dudong tron

@’w Thanh Mhin - THIC Nyi Gia T G D, Ty N
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2-1-1-7: On a arc: Trén mot cung tron
2-1-1-8: With intege coodinates: v61 toa d§ nguyén
2-1-1-9: With integer abscissa: Trén truc voi hoanh do
nguyeén
2-1-1-10: In a polygon: Trong mdt da giac 16
2-1-1-11: On a sphere: Trén mot mit cau A /\
2-1-2: Point by coodinate(s): Bi€m x4c dinh bditoa dd cia nod

Create | Piloting showing  Oth

Paint » Free point »
Line » Point by coordinate(s) L}P In space
Plane k Intersection 2 lines On a plane
Transfarmation » Intersection line-plane Onoaline
Mumeric » Intersection line-circle » On a ray
Coordinate system Intersection 2 circles »
Length unit Intersection line-sphere 3
Yerctor » Midpaint
Salid N Center frarious) r

Barycenter
Display g Irmage point by 3
Command k

2-1-2-1: In srpace: Trong khong gian

2-1-2-2: On a plane: Trong mot mat phang

2-1-2-3 / On a line: Trén mot duong thang

2-1-2-2: On a ray: Trén mot tia
2-1-3: Intersection 2 lines: Giao diém ciia hai duong thang
2-1-4: Intersection line-plane: Giao diém cua duong thang

va mat phang
N 2-1-5: Intersection line-circle: Giao diém cia duong thang

va duong tron
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Create | Piloting  Showing  Oth

Foint ]
Line ]
Plane k
Transformation ]
Murmeric ]

Coordinate systern

Length unit

Wector ]
Solid 3
Cisplay 2
Command 2

Free point

Point by coordinate(s)
Intersection 2 lines
Intersection line-plane
Intersection line-circle
Intersection 2 circles
Intersection line-sphere
Midpaint

Center frarious)
Barycenter

Irmage point by

[

2-1-5-1: 2 points: 2 giao diém

L 2 points

* Second point

2-1-5-2: Second point: giao diém thir hai

2-1-6: Intersection 2 circles: Giao diém cua hai duong tron

2-1-6-1: 2 points: 2 giao diém

Y

2-1-6-2: Second point: giao diém thr hai

Create | Piloting  Showing  Oth

Foint ]
Line ]
Plane k
Transformation ]
Murmeric ]

Coordinate systern

Length unit

Wector ]
Solid 3
Cisplay 2
Command 2

Free point

Point by coordinate(s)
Intersection 2 lines
Intersection line-plane
Intersection line-circle
Intersection 2 circles
Intersection line-sphere
Midpaint

Center frarious)
Barycenter

Irmage point by

[

* 2 points
3 Second point

2-1-7: Intersection line-sphere: Giao diém cua duong thang

2-1-7-1: 2 points: 2 giao diém

- mat cau

2-1-7-2: Second point: giao diém thir hai
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Piloting  Showing  Oth

Foint r Free paoint *

Line b Faoint by coordinate(s) b

Flane [ Intersection 2 lines

Transformation r Intersection line-plane

Murneric 2 Intersection line-circle 2

Coordinate system Intersection 2 circles *

Length unit Intersection line-sphere L 2 points % -

Wector [ Midpaint Second point /

<olid N Center fwarious) »

Barycenter
Display J I .
rnage paint by [
Command r
2-1-8:Midpoint: Trung di€ém
Piloting  Showing  Oth
Foint r Free paoint *
Line b Faoint by coordinate(s) b
Flane [ Intersection 2 lines
Transformation r Intersection line-plane
Murneric 2 Intersection line-circle 2
Coordinate system Intersection 2 circles *
Length unit Intersection line-sphere L
Wector [ Midpaint
<olid N Center fwarious) » Centroid [
Barycenter Incenter
Display g Irmage point by [ Circurncenter
Comrnand 3 Orthocenter
Of a circle
2-1-9: Center (various): Tam
2-1-9-1: Centroid: Trong tam
\ 2-1-9-2: Incenter: Tam dudng tron ndi ti€p tam gidc
2-1-9-3: Circumcenter: Tam duong tron ngoai ti€p tam
gidc

\ 2-1-9-4: Orthocenter: Truc tdm cua tam giac
2-1-9-5: Of a circle: Tam cua duong tron da dung

2-1-10: Barycenter: Tam ti cw
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Pilating  Showing  Oth

Paint J Free point

Line k Paoint by coordinate(s)
Plane » Intersection 2 lines
Transformation » Intersection line-plane
Murmeric b Intersection line-circle

Coordinate system

Intersection 2 circles

Lerngth unit Intersection line-sphere
Wector » Fidpoint
Salid 5 Center (warious)
Barycenter
Display b I .
mage point by
Camrmand [

Existing transformation %

Syrmmetry through a line
Syrmmetry through a point
Syrmmetry through a plane

Translation {wector)

Translation {point-image)
Rotation (axis-angle)

Hornothety (center-ratio)
Hornothety (center-point-image)

Orthogonal projection on a line
Orthogonal projection on a plane

Projection on a plane with direction of

2-1-11: Image point by: Piém anh ciia:

2-1-11-1: Exsiting transfomation: Mot phép bién hinh da xac

dinh

2-1-11-2: Symmetry through a line: Phép ddi xung truc

2-1-11-3: Symmetry through a point: Phép dbi ximg tam

2-1-11-4: Symmetry through a plane: Phép ddi xting qua mit

phang

2-1-11-5: Translation (vector): Tinh tién (theo vecto)

2-1-11-6: Translation (point-image): Tinh tién (theo diém

& anh cua no)

2-1-11-7: Rotation (axis-angle): Phép quay (truc — goc

quay)

2-1-11-8: Homothety (center-ratio): Phép vi ty (tam - ti s6

vi tur)

2-1-11-9: Homothety (center-point-image): Phép vi ty
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(tAm-diém-anh)
2-1-11-10: Orthogonal projection on a line: Phép chiéu
vudng goc 1én duong thang
2-1-11-11: Orthogonal projection on a plane: Phép chiéu
vudng goc 1én mat phang
2-1-11-12: Projection on a plane with direction of: Phép chiéli A
1én mat phang theo mot phuong chiéu 1a mot duong thang cho trude

2-2: Line: Dyng duwong:

Piloting  Showing  Oth ¢
\

Faint [

% Line » Straight line(s) r
Plane » Ray(s) r
Transformation k Segment(s) r
Murneric * Corwvex polygan »
Coordinate system Circle k
Length unit Brc
Wector r Curve r

1 2

<olid , Meshing
Display [
Comtmnand [

2-2-1: Straight line(s): Pwong thing:
Pilating  Showing  Oth

Paint *
Lire * Straight line(s) * Through 2 points E
Plane » Rayls) » Parallel
Transformation [ Seqmment(s) [ Perpendicular to a line
Murneric * Caorwex polygon * Perpendicular to a plane
Coordinate system Circle 2 Intersection of 2 planes
Length unit A Bisector line
Wectar * Curve * Irmage of a line
Solid , Meshing 2 Point and wectar

\ Wifith a coordinate systern
Elapaleyy g Marmed, by 2 points
Cornrmand *

2-2-1-1: Through 2 points: Qua 2 diém
2-2-1-2: Parallel: Qua mot diém va song song véi mot

duong thang

@’w Thark M - THTT Nyi Gia T G T, Tay Vi 7
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2-2-1-3: Perpendicular to a line: Qua mot diém va
vudng goc voi mot duong thang
2-2-1-4: Perpendicular to a plane: Qua mot diém va
vuong goc vi mot mit phang

2-2-1-5: Intersection of 2 planes: Giao tuyén cta 2 mit

. phang
2-2-1-6: Bisector line: Phan gidc ciia mgt goc
2-2-1-7: Image of a line: anh ctia mot dudng thang
2-2-1-8: Point and vector: Diém va mot vécto c\hi ¢
phuong

2-2-1-9: With a coordinate system: Gan V('Yi\‘tl'l_lC toa do
2-2-1-10: Named, by 2 point: Dat tén lai cho duong
\ thang qua 2 diém
2-2-2: Ray(s): Tia (nira dwong thzzmﬁ\):
2-2-2-1: By 2 points{;\ Tao boi 2 diém
2-2-2-2: Named, by 2 po\nt: bit tén lai cho tia qua 2

N diém
Pilating  Showing  Oth
Paint 3
Line r Straight line(s) k
Plane * Rayis) * By 2 points L\{
Transformation 2 Segment(s) 2 Marmed, by 2 points
Murreric [ Conwvex palygan [
Coordinate system Circle r
Length unit Arc
Wector * Curve *
p zalid , Meshing L
Display 2
Cormmand 3

2-2-3: Segment(s): Poan thing:
2-2-3-1: By 2 points: Tao boi 2 diém
2-2-3-2: Named, by 2 point: Pit tén lai cho tia qua 2 diém

@’w Thark M - THTT Nyi Gia T G T, Tay Vi s
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[Create | Piloting Showing Otk

Paint r
Line b Straight line(s) b
Plane k Ray(s) k
Transfarmation r Segrment(s) k By 2 points %
Murneric 2 Corvex palygon 2 Marmed, by 2 points
Coordinate systerm Circle *
Length unit Arg A\
Wector * Curve * ’
i [
Solid N Meshing
Display ]
Command r
2-2-4: Convex polygon: Dung da giac 10i:
Piloting Showing  Oth
Paoint r
Line b Straight line(s) b
Plane b Rayis) »
Transformation r Segrment(s) r
Mureric 2 Corvex polygon 2 By wertices %
Coordinate systern Circle * Section of a polyhedron by a plane
Length unit Arc Irmage of a polygaon
Wector [ Curve [ Regqular polygon
i [
Solid N Meshing Corvex hull
Display ]
Caomrmand r

2-2-4-1: By vertices: (Xac dinh) boi cac dinh
2-2-4-2: Section of a polyhedron a plane: Giao tuyén cua
mét khdi da dién va mot mit phéng
/ .+ 2-2-4-3: Image of a polygon: Anh ctia mot da giac
 22-4-4: Regular polygon: Da giac déu
2-2-4-5: Convex hull: Bao hinh 16i
2-2-5: Circle: Dung dwong tron:

@’w Thark M - THTT Nyi Gia T G T, Tay Vi 4
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Piloting  Showing  Oth

Paint r
Line b Straight line(s) 3
Plane k Rayis 3
Transformation r Segrment(s) r
Murneric 2 Corvex polygon »
Coordinate system Circle » By plane, center and radius %
Length unit BApc By plane, center and a point \
Wector [ Curve » By axis and a point ’
<olid N Meshing » Circurncircle
Incircle
Display g Section of a sphere by a plane
Caornimand b Intersection of 2 spheres

2-2-5-1: By plane, center and radius: Bi mit phang, tim
. © vabénkinh
2-2-5-2: By plane, center and a point; Boi mat phang, tim
\ va mot diém
2-2-5-3: By axis and a point: Boi truc va mot diém
2-2-5-4: Circumcirclei?Ngbai tiép tam giac
2-2-5-5: Incircle: Noi tiép tam giac
2-2-5-6: Section 0?3 sphere by a plane: Giao tuyén cua
mit cau & mat phang
2-2-5-7: Intersection of 2 spheres: Giao tuyén cta 2 mit
2-2-6: Arcﬁ)ung cung tron
2-2-7: Curve: Dung duong cong:




Piloting  Showing  Oth

Paint

Line

Plane
Transformation

Murmeric

Coordinate system

Length unit

Wector
Solid
Display

Cormmand

3

3

Straight line(s)
Ray(s)
Segment(s)
Corwvex polygan
Circle

Brc

Curee

Meshing

£ 2 ~ N = 5
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Pararnetric %
Locus of a point

Graph of a function

2-2-7-1: Parametric: X4ac dinh boi phuong trinh tham sb

2-2-7-2: Locus of a point: Quy tich ctia mot diém

2-2-7-3: Graph of a function: D6 thi'cia mot ham sd.
2-2-8: Meshing:

Piloting  Showing  Oth
Faint [
Line » Straight line(s)
Plane k Rayis)
Transfarmation » Segrment(s)
Murneric [ Corvex polygon
Coordinate system Circle
Length unit B
Yectar 3 Cupse L
salid N keshing » Locus of a point with 2 pilots R
Graph of a 2-variables function

Display *

p Comtmnand [

™~

2-2-8-1: Locus of a point with 2 pilots: Quy tich ciia mdt
diem boi 2 dicu khien
2-2-8-2: Graph of a 2-variables function: D6 thi ctia ham
2 bien.
2-3: Plane: Dyng mit phang:
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Piloting  Showing

Foint

Line

Flane
Transformation
Murneric
Coordinate systerm
Length unit

Wectar
Solid
Display

Command

Oth

k

4

By 2 pointand a line

By 2 lines %

Parallel to a plane

Parallel to 2 lines

Ferpendicularto a line -
Perpendicular bisectar
By an equation

With a coordinate systern

Mamed, by 3 paints Ve

2-3-1: By a point and a line: Xac dinh béi'\l diém va 1 dudng thang
2-3-2: By 2 lines: Xac dinh boi hai dudng thang. (
2-3-3: Parallel to a plane: Song song v&i 1 mat phang

2-3-4: Parallel to 2 lines: Song song v6i-2 duong thang

2-3-5: Pependicular to a line: Vuong goc v6i mot duong thang

2-3-6: Pependicular biseEtor:\Meit phang trung truc

2-3-7: By an equatim\lz Xac dinh boi phuong trinh

2-3-8: With a coordinate system: Gan véi hé truc toa do

2-3-9: Named, by 3 points: Pit tén lai cho mit phang xac dinh

&

boi 3 diém

2-4: Transformation: Phép bién hinh:

Piloting  Showing

Foint

Line

Flane
Transformation
Murneric
Coordinate systerm
Lenigth unit

Wectar
Solid
Display

Command

Oth

4

k

Swrmimetry through a plane I}
Iymmetry through a line
Syrmmetry through a point

Translation (wector)

Translation (point-irmage)

Rotation (axis-angle)

Rotation (axis and 2 paints)

Hormothety (center-ratio)
Haomothety (center-point-itnage)

Compaosition of 2 transformations
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2-4-1: Symmetry through a plane: Phép ddi xting qua mit phang
2-4-2: Symmetry through a line: Phép d6i xing truc
2-4-3: Symmetry through a point: Phép dbi xtmg tdm
2-4-4: Translation (vector): Tinh tién theo vecto
2-4-5: Translation (point-image): Tinh tién theo diém - diém 4nh
2-4-6: Rotation (axis-angle): Phép quay (truc-goc) /‘
2-4-7: Rotation (axis and 2 points): Phép quay (truc va 2 di€m)
2-4-8: Homothety (center-ratio): Phép vi tu (tam-ti s6 vi'tu)
2-4-9: Homothety (center-point-image): Phép vi tu Qén{-diém-énh)
2-4-10: Composition of 2 transformations: Tich cua hai phép bién
hinh
2-5: Numeric: thudc vé sb
Piloting Showing Oth

Paoint r

Line 3

Plane 4

Transformation k

Mumeric k Free real variable in an interval

Coordinate systern Free real wariable

Length unit . ) . .

3 Free integer wariable in an interval

Yectar 3 . .
Free integer wariable

Zolid k . . .
Geormetric measurement % » Radius of a circle

Display » Algebraic calculation Distanice point-line

. Distance point-plane
Cormmand k Function k P P

Area of a trangle
Mon-recurrent sequence

Area of a convex polygon
Recurrent sequence of order 1 pelyd

Volume of a solid
Recurrent sequence of arder 2

Index of the first null term of a sequence Geometric angle
Ahbscissa of a point on a line
H¥-coordinate of a point in space
Y-coordinate of a paointin space
Z-toordinate of a paintin space
H-coordinate of a wector
Y-coordinate of a wector

Z-coordinate of a wector

Petirneter of a polygon

2-5-1: Free real variable in an interval: bién sd thuc tu do trong
mot doan
2-5-2: Free real variable: bién sd thuc tu do

2-5-3: Free integer variable in an interval: bién s6 nguyén tu do
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trong mot doan
2-5-4: Free interger variable: Bién s6 nguyén tu do
2-5-5: Geometric measurement: tinh toan trong hinh hoc
2-5-5-1: Radius of a circle: Ban kinh ctia duong tron
2-5-5-2: Distance point-line: Khoang cach tir diém dén duong
~ thang
2-5-5-3: Distance point-plane: Khoang cach tir diém dén mat .
phang
2-5-5-4: Area of a triangle: Di¢n tich cia mot tam m\giéé
2-5-5-5: Area of a convex polygon: Di¢n tich da gidc 161
2-5-5-6: Volume of a solid: Thé tich cia mot vat thé
2-5-5-7: Geometric angle: S6 do goc l}mh th\\ |
2-5-5-8: Abscissa of point on a line: Hoanh do cuia mot diém trén
\ mot truc
2-5-5-9: X-coordinate (‘\of a point in a space: Hoanh d§ cua mot
Q diém trong khong gian
2-5-5-10: Y-coofi-'di}mte of a point in a space: Tung d§ cua mdt
diém trong khong gian
2-5-5-11: Z-coordinate of a point in a space: Cao do ciia mdt
g diém trong khong gian
2-5—5-12:\X-c\\00rdinate of a vector: Hoanh do cua mot vécto
2-5-5-13\.\Y-c00rdinate of a vector: Tung do cua mot vécto
2-5-5-14: Z-coordinate of a vector: Cao do cua mot vécto

2-5-5-15: Perimeter of a polygon: Chu vi cia mot da giac
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Piloting  Showing  Oth

Paint »
Line r
Flane 2
Transformation 2
Murneric 2 Free real variable in an interval
Coordinate systermn Free real variable
Length unit . . . .

9 Free integerwvariable in an interval
Wector b . .

Free integer wariable

. , .
selid Gearnetric reasurement L4
Display r Algebraic calculation
Cormtmand b Function b

1-variahle function [:"

Mon-recurrent sequence 2-variables function

Recurrent sequence of arder 1 3-wariables function

Recurrent sequence of arder 2 Function defined by values

Index of the first null term of a sequence

2-5-6: Algebraic calculation: Cac phép tinh dai sé
2-5-7: Function: Ham so: \

2-5-7-1: 1-vafiable function: ham mot bién

2-5-7-2: 2-vafiable function: ham 2 bién

2-5-7-3: 3-vafiable function: ham 3 bién

2-5-7-4: Function Aeﬁned by values: Ham sb cho bdi bang gié tri
2-5-8: Non-recurrent sequence: Diy s6 khong hoi quy
2-5-9: Non-recurrent sequence of order 1: Diy s hdi quy bac 1
2-5-10: Non-recurrent sequence of order 2: Diy s6 hoi quy béc 2
2-5-11: Index of the first null term of a sequence: Chi s cua sd

hang th{r nhat cua day

2-6: Coordinate system: Tao h¢ toa dd moi
| 2-7: Length unit: Doi dai cua don vi
2-8: Vector: Vécto

@’w Thark M - THTT Nyi Gia T G T, Tay Vi
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Pilating  Showing  Oth

Paint k
Line k
Plane r
Transformation k
Murmeric k

Coordinate systern

Length unit \
; Ve
Wertar K Wectar expression %
Solid , By coordinates
Display b p
~
Comrmand r

2-8-1: Vector expression: Xac dinh boi biéu thuc vécto
2-8-2: By coordinates: X4c dinh bdi cac biéu thitc toa do cua no
2-9 Solid: Vit thé:
Pilating Showing  Oth

Paoint b
Line »
Plane »
Transformation »
Mumeric »

Coordinate systern

Length unit
Wectar 4
solid » Corwex polyhedron % » By wertices
Bigaliy v Sphere Intersection polyhedron/half-space
Crlinder Intersection of 2 polyhedrons
L ' Cone Irmage of a polyhedron
Frusturm of a cone Regular prism
Developrment of a palyhedron Regqular pyramid
Corrvex hull

2-9-1: Convex polyhedron: Khéi da dién 16i:
2-9-1-1: By vertices: xac dinh bdi cac dinh da dung
2-9-1-2: Intersection polyhedron/half-space: Phan giao cta khoi
da dién v&i mot nira khong gian
2-9-1-3: Intersection of 2 polyhedrons: Phan giao cua hai khdi da
dién
2-9-1-4: Image of a polyhedron: Anh ctia mot khoi da dién
2-9-1-5: Regular prism: Khéi lang tru déu
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2-9-1-6: Regular pyramid: Hinh chop déu

2-9-1-7: Convex hull: Bao hinh 16i
2-9-2: Sphere: Mit cau
2-9-3: Cylinder: Hinh try
2-9-4: Cone: Hinh nén
2-9-5: Frusturn of a cone: Hinh nén cut A \
2-9-6: Development of a polyhedron: Hinh khai trién clia mot hin/h

da dién
2-10: Display: Su hién thi ¢
Pilating  Showing  Oth

Paint
Line
Plane

Transformation

T v ¥ ¥

Mumeric

Coordinate system

Length unit

Wector b

Solid r

Display 3 Existing numeric wariable
Comrmand 9 Length of a segment

Coordinates of a point
Equation of a plane

Text

2-10-1: Exi\sting numeric variable: Mot bién sd d3 xac dinh
2-10-2: Length of a segment: Do dai ciia mot doan thiang
2-10-3: Coordinates of a point: Toa do cua mot diém
( 2:10-4: Equation of a plane: Phuong trinh ctia mot mit phang
2-10-5: Text: Van ban
* 2-11: Command:Tao Iénh
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Piloting  Showing  Oth

Point 4
Line 4
Plane 4
Transformatian »
Murmeric »

Coordinate system

Length unit

Wector *

Solid 3

Display »

Cormrmand » YWhole-drawing

Step-drawing
Trace
Trace-dermand
Exiting trace mode

Selection for piloting with keyhoard

Direct affectations
Randorm affectations

Mernorised affectations
Change of wiew » By rmermory %

: - By choice of a front pl
Tterative creation iy EABIEE @ B e [BIEnE

. B |ati tati
Caommand repetition y relative rotatian

By absolute rotation
Tahle of values ¥

Oblique projection
2-11-1: Whole-drawing: V& hinh theo khéi
2-11-2: Step-drawing: V¢ hinh theo budc
2-11-3: Trace: Tao vét
2-11-4: Trace-demand: Tao vét theo yéu cau
p 2-11-5: Exiting trace mode: Thoat khéi ché do tao vét
2-11-6: Selection for piloting with keyboard: Chon d6i twong dé di
chuyén bang ban phim
2-11-7: Direct affectations: Str dung sy tinh toan
2-11-8: Random affectations: Su thay doi ngdu nhién
2-11-9: Memorised affectations: St dung kiéu bién da nhé
2-11-10: Change of view: Thay d6i cach nhin
2-11-10-1: By memory: Boi sy ghi nho
2-11-10-2: By choice of a front plane: Bang cach nhin
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chinh dién mot mat phéng duoc chon
2-11-10-3: By relative rotation: Boi mot phép quay tuong doi
2-11-10-4: By absolute rotation: Boi mot phép quay tuyét dbi
2-11-11: Interative creation: Tao phep lap
2-11-12: Command repetition: Phép lip mot hodc nhiéu cau tric
diéu khién
2-11-13: Tables of values: Bang cac gia tri .
2-11-14: Oblique projection: Phép chiéu xién

3. Piloting: H¢ 1énh diéu khién: ¢

3-1:
3-2:

3-3:
34:
1 3-5:
3-6:

3-8:
3-9:

3-7:

Showdng  Other  Edit  Wiews ‘Window Help

Piloting with keyboard %
Change parameters of piloting with keyboard

"4

Loop the piloting
Unloop the pilating

Affect a free numeric wariahle
Place a free point on a point

Place a free point by its coordinates

Lctivate tirmer (rmaj T)

Duration between time reading
Import
Piloting with keyboard: Piéu khién bang ban phim
Change parameters of pllotlng with keyboard: Diéu chinh cic tham
\ s6 cua thao tac diéu khién bang ban phim
Loop the piloting: Gidi han sy diéu khién
Unloop the piloting: Huy bo gid1 han sy diéu khién
Affect a free numeric variable: Gan gia tri cho mot bién tu do
Piace a free point on a point: Do1 mot diém tu do dén vi tri cia mot
diém khac
Place a free point by its coordinates: Ddi mot diém ty do boi nhitng
toa dO cua no
Activate timer (maj T): Khoi dong bién thoi gian

Duration between time reading: Sira d6i khoang thoi gian cho

3-10: Import: Nhap khau
4. Showing: Hién thi
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Other  Edit  Wiews ‘Window Help O

Trace selection
Trace rmode (flip-flap)
Trace-dernand mode (flip-flop)

Reminder (F2}
Cormments (F3)

v Display the names of the points {maj M)
Split the narmes of the points (tnaj ) Y AN
Display Rxyz coordinate systermn {maj By V4
Thick drawing (flip-flop)

Larger (=)
Srmaller (<)

Wifire rnode display ™
Dotted hidden parts

Isolate plane

4-1: Trace selection: Chon ddi tuong sé tao Vet khi di chuyén
4-2: Trace mode (flip-flop): Kiéu tao vét lién net (chon/bo chon)
4-3: Trace-demand mode (ﬂlf-ﬂop) Kiéu tao vét theo yéu cau (chon/bo
chon)
4-4: Reminder (F2): Goi lai danh myc dinh nghia cac ddi twong
4-5: Comments (F3): Hién thi ctra s6 ghi cha cho hinh vé
4-6: Display the names/ of the points (maj N): Hién thi tén cua cac d6i
tuong
4-7: Split the names of the points (maj S): Tach tén cua cac diém gan
\ nhau
4-8: Display Rxyz coordinates system (maj R): Hién thi hé toa do
4-9: Thick drawing (flip-flop): 4 ét v& manh hodc day (chon/bo chon)
4-10: L\arger (>): Phong to hinh vé (Shift+>)
4-11: Smaller (<): Thu nhé hinh v& (Shift+<)
' 4-12: Wire mode display: Xem hinh vé& dudi dang toan duong lién nét
4-13: Dotted hidden parts: Xem hinh v& véi cac duong khuat dugc vé
bang nét dit
4-14: Isolate plane: Mit phang riéng
5. Other: Cac lénh khac
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Edit Wiews iindow Help
Drawvitig styles
Clipping
Unclipping
ModifyDuplicate (Ctrl bA)
Repeat (Ctrl B)

Suppress ; \
Renarme &
History
Filter % Faorbid piloting
I ¢
Protect Allowy pilating ~
Unprotect Forbid access
Modify menus Lllowr access

Create a prototype
5-1: Drawing styles: Kiéu vé&
5-2: Clipping: Gi6i han phan hinh vé \)
5-3: Unclipping: Huy bo 1énh giéi-han phan hinh vé
5-4: Modify/Duplicate (Ctrt M): Chinh stra/ tao thém hinh tuong tu
5-5: Repeat (Ctrl B): Lap lai'thao tac vura thyc hién
5-6: Suppress: Xo0a déng\ thei nhirng ddi twong khong duoc bao vé di chon
trong danh muc
5-7: Rename: Dit lai tén cho mét ddi tuong
5-8: History: Tai hi¢n lai hinh v€ chi tiét theo tung budc
5-9: Filter: Loc
5-9-1: Forbid piloting: Cam di chuyén cac ddi tugng da chon
5-9-2: Allow piloting: Huy bo 1énh cim di chuyén cac d6i tuong da thiét
. \ lap
5-9-3: Forbid access: CAm truy cip vao mot sé ddi tuong
5-9-4: Allow access: Huy bo 1énh cap truy cap
5-10: Protect: Bao v¢é
5-11: Unprotect: Huy bo 1énh bao vé
5-12: Modify menus: Diéu chinh lai trinh don
5-13: Create a prototype: tao mot nguyén miu (miu dau tién)
6. Edit: Hi¢u chinh, soan thio:
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Wiews Window Help  Options
Copy picture (autormatic) %
Copy picture (adjust copyd
Copy selected descriptions

Edit text of figure

Edit comments

Undo ‘ X
Reda ’
Lirnit picture

6-1: Copy piture (automatic): Sao chép hinh v€ (tu dong) /
6-2: Copy piture (adjust copy): Sao chép hinh v€ (dat cho vira khit)
6-3: Copy seclected descriptions: sao chép cac dong mé ta cac dbi
tuong, cac thao tac Iénh hinh vé da duge chon vtrong bang Rappel
6-4: Edit text of figure: Hi¢u chinh van ban mo ta hinh vé (cac 1¢énh dung
\ hinh)
6-5: Edit comments: Hi¢u chinh 101 chu thich cho hinh vé
6-6: Undo: Hoan tac lai cac lénﬁ truoc do
6-7: Redo: Huy bo 1énh hoé\n tac truoc do
6-8: Limit picture: Gio1 han hinh anh
7. Views: Cac cach nhin:

Winduw Help Options

Initial wiew (CTRL-F1) %

Standard wiews with oyz as front plane (FT)
Standard wiew with oxy as front plane (F8)
Standard view with oz a3 front plane (F9)

iews with another front plane

Precedentwiew (F11)
M et e (F12)

Frant plane maintained

Ohlique projection

Oblique projection parameters

7-1: Innital view (CRTL F1): Tro vé cach nhin dau tién

7-2: Standard view with oyz as front plane (F7): Cach nhin véi tia nhin
vudng goc v6i mit phang oyz

7-3: Standard view with oxy as front plane (F8): Cach nhin véi tia nhin
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vudng goc v6i mit phang oxy
7-4: Standard view with oxz as front plane (F9): Cach nhin véi tia nhin
vudng goc v6i mit phang oxz
7-5: View with another plane: Cich nhin dbi dién v6i mot mat phéng
khac
7-6: Precedent view (F11): 4 hin hinh véi vi tri ké truée cach nhin hién /\
thot
7-7 Next view (F12): 4 hin hinh véi vi tri ké sau cach nhin hién thoi
7-8: Front plane maintained: Mit phang trudc mit giir ngu\yérf Vi tri
7-9: Oblique projection: a hin hinh v& vd1 phép chiéu xién
7-10: Oblique projection parameters: Chon tham sb chg) phép chiéu xién
8. Window: Cira s : N

Help Options

Cascade % \\
Tile thorizontal)
Tile {twertical)

v 1Geaspace_l
8-1: Cascade: Kiéu xép ‘;éng
8-2: Tile (horizontal): Xép ké (ngang)
8-3: Tile (vertical): Xép ké (doc)
9. Help: Tro¢ giup

\ N

\\ Dptions

\ Help for Geoplan %
Help for Geospace
Ahout
Help for Geoplan-Geospace

\
( 9-1: Help for Geoplan: Tro gitup cho Geoplan
9-2: Help for Geospace: Trg gitip cho Geospace
~ 9-3: About: Thong tin
9-4: Help for Geoplan-Geospace: Tro gitp cho Geoplan-Geospace
10. Options: Tuy chon:
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3.

Language [
Associate v
Preferences

Figqures on a black background

v Toolbar
10-1: Language: 4 gon ngi
10-1-1: French: Tiéng Phap
10-1-2: English: Tiéng Anh
10-1-3: German: Tiéng Dt
10-1-4: Italien: Tiéng Y

French
English
German

Italien

10-2: Associate: Két hop (Geoplane va Geospace)

10-3: Preferences: Su uu tién

\ Y

10-4: Figure on a black background: Hinh v& voi nén mau den.
DANH MUC CAC HAM VA CAC PHEP TOAN'DUGC HO TRQ TRONG

GEOSPACE

. Céc phép toan trén tap hepsé:

Cong: + f\\}ﬁ\
Tru: - \

a han: *

Chia: / -

Lily thira: A N

Giati thura: ! \\

. Cac phép toan trén vecto:

Cong vecto: vec(u) + vec(A,B)

Tru Vgp\tO’: vec(u)-vec(v)

a han so thuc k vdi1 vecto: kvec(u)

D§ dai cua 1 vecto: norm(u)

Binh phuong v6 huéng cua 1 vecto: vec(u)2

Tich v6 hudng cua 2 vecto: vec(u)&vec(v).

Tich c6 hudng cua 2 vecto: vec(u)§vec(v) (click vao biéu tuong trong

cac hdp thoai hién ra)

Phép toan trén tip hop diém:
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Khoang cach giita 2 diém: dist(A,B) hodc don gian hon 12 AB.

Vecto AB : vec(A,B)
Ham s6 1 bién so thuec:
Ham logarit 4 epe: In().
Ham s6 mil: exp()

Ham gia tri tuyét d6i: abs()
Ham phan nguyén: int()
Ham can bac hai: rac()
Ham s sin: sin()

Ham s6 cosin: cos()

Ham s6 tang: tan()

A . . \L
Ham so6 arcsin: arcsin()
Ham s6 arccos: arccos() )

\ f’\ \ \\
Ham so6 arctan: arctan()
Ham 2 bién so: A\

/ 9 o . AN AN

Ham lay GTa a : min(, ) \

Ham lay GTLa : max(, ) ;\\y

Chinh hop chép p cua n phan ti: anp( , )
T hop chap p cta n phan ti: cnp( , )
Ham logic: 4( ) g

%)
Cac phép toan lggic:
Va: et

Hoac: ou.

Phu dinh: non

3

o[ Lo

\)
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DHAN 2

DUNG HINH VOI GEOSPACE
I. NHUNG PIEU CAN LUU Y KHI DUNG HINH VOI GEOSPACE:

- bé dung mot ddi tuong, trudce tién ta phai dung cac thanh phr:in cAu tao nén
nd, ngoai trur cac ddi tuong mac dinh nhu: mat phéng qua 3 diém, du’g‘)gg
théng, tia, doan thflng xac dinh boi 2 diém. Vi du dé dung t&r dién ;;\BCD ta
phai dyng trudc cac diém A,B,C,D 1a dinh cua ti dién...

- Khi tao mot dbi twong nhat thiét ta phai dit tén cho né boi Vi/tén cua d6i

tugng duoc sir dung dé dung hinh & budc tiép theo. 4 éu quén tén'dbi tuong da

dung ta c6 thé click nut rap| trén thanh cong cu dé mo bang danh muc md ta

cac d6i twong. Tén cac doi tuong cé thé viét nhu trong toan hoc (vi du diém
A.B.,C,... mat phéng ABC,...) tén ddi tuong phan'bi¢t chir hoa thuong.

- Khi dung hinh, ta thudng xuyén phai dién tén cac d6i twong vao cac 6 cua
hop thoai thi ngoai viéc go truc tiép tén ctia d6i twong vao 0, ta cd thé click
truc tiép vao dbi tuong trén man hinh Qang hién thi hodc click vao nut @ dé
m¢ bang danh muc mo ta cac d61 tuong va click chon cac dbi tuong trong do.

- Trong ban v€ Geospace céé ﬁk)i tuong dugc bao vé bdi van ban mo ta hinh vé
(Edit > Edit text of figure):'Lénh nay cho phép hién thi bang mé ta cac ddi
tuong trong hinh vé giéng/nhu: viéc lap trinh, ta c6 thé thém, bat, hiéu chinh
cac ddi twong bang viée thém, bét, hidu chinh cac dong 1énh trong bang mo ta

nay va click vao d(‘ng‘g [énh Execute va click Yes dé thay doi c6 hiéu luc.

- Muén lap lai Iénh ma1 vira thyc hién trude do thi click vao nit ‘E‘ trén thanh
cong cu. Cach khac: 4 han Ctrl B trén ban phim.
/- Khi thup\hién cac lénh ngoai viéc click chon trén thanh Menu ta cling co6 thé

click dtip vao ving bat ki trén ban vé& dé hién menu nay, viéc nay giup chiing
S ta thao tic v& hinh nhanh hon. Pic biét ta ¢ thé b6t di cac thanh phén it su

dung cua menu chon bang cach nay.

- Viéc hoan tac (Undo) hoic Lam lai (Redo) mét 1énh truée d6 khong gidng

nhu cach thuong 1am vé6i cac phan mém khac (nhan Ctrl Z hodc Ctrl Y, Ctrl R)

ma ciing phai thuc hién bang 1énh (Edit > Undo (Redo)). 4 hung ta ciing c6 thé

két hop v6i to hop phim Ctrl B dé lap lai cac thao tac nay.

Vaugén Chanh cNhan - CHPC Ngi Gia Cu, Go Do, Cay o Nin 9
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- Viéc d6i tén mot dbi tuong thi ta thuc hién béng Iénh Other >Rename. Xo0a
mot d6i tuong cling thuc hién b@ing 1énh Other >Supress, va chon cac dbi
tugng can xoa (két hop véi phim Shift dé chon nhiéu dbi twong lién tuc hoic
v6i phim Ctrl dé chon cac ddi tuong riéng 18) trong bang rappel hién ra va
click OK hoic click dup vao ddi twong can x6a. Chu ¥ néu x6a mot d6i tugng
nao d6 thi cac ddi twong dugc tao tir né ciing sé bi xdéa di. Con mot cﬁch khﬁc
12 m& bang van ban mo ta cac doi twong (Edit >Edit text of figure) va sta hay
x0a tryc tiép trong d6, nhung néu khong ranh ngoai ngir thi khong nén'sirdung
cach nay. ~ ¢

- B¢ di chuyén mot diém tu do ta click chudt trai vao diém do (tré chudt s€ doi
thanh @;\}) va kéo dén vi tri can chon. Dé thay\ 6i céc\h ‘nhin thi nhan gitr
phim SHIFT va cac phim miii tén va PGUP, PGDA hoac click chudt phai va

ré chudt (con tro chudt doi thanh ™) ). Bé di chuyén hinh v& cho tron man hinh
ta nhan git phim SHIFT va phim phéi chudt va kéo (con tré chudt ddi thanh

wa)_ OXN

- Khi str dung hinh vé da cé(sé}} nén nhan phim F3 dé biét thong tin vé hinh vé&
hoic hudng dan cia tac gia ban vé dé (néu cb).
- Pé xem thong tin ctia ddi tu:O’ng nao d6 ta nhan phim Ctrl va phim chudt trai

dé xem. Xem h1nh

A free point in space
Chiect with forbidden piloting

hhhhhhhhhhhhh

AN i

. - Trong sach c6 st dung khai niém “Quy tic ban tay phai”: Quy tic ndy xac
dinh nhu sau: dit ngén tay cai theo chiéu mili tén cta vecto thi chiéu quay cta
hinh 1a di theo hudng tir c6 tay dén dau cac ngodn tay ciia ban tay phai.

II. DUNG HINH CO BAN VOI GEOSPACE:
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Trong phan nay, chi yéu ta sir dung cac 1énh ctia menu Create, c6 thé goi
cac 1énh tir thanh menu hodc ¢6 thé click dip vao bat ki ving nao trong ban vé

dé mé menu (xem hinh).

Create » Paoint » Free point » In space

Pilating ] Line » Paoint by coordinate(s) » On a plane

showing * Plane » Intersection 2 lines On aline %

Other » Transformation » Intersection line-plane On a ray

Edit * Murneric r Intersection line-circle r On a segrment

Wiews 2 Coordinate systermn Intersection 2 circles » On acircle

Help Length unit Intersection line-sphere » O oan arc
Wector » kidpaoint Wfith integer coordinates
colid . Center fvarious) k Wfith integer abscissa

Banycenter In a polygon

Dligallesy g Irnage point by » On a sphere
Command »

2
A

a éu lan dau tién str dung thi cic ban s& cam tth khé khan khi v€ hinh, béi
khong nhu cac phan mém The Geometer’s Sketchpad hay Cabri v& hinh bang céac
cong cu v€ hinh (nhu céng cu vé dlem duong thang, dudng tron,...), ma
Geospace dyng hinh bang cac 1énh trong menu 1énh. Chinh vi vay khi doc sach
thdy co ciing nén mé chuong trlnh\de thie hanh cho quen dan.
Trong qua trinh dung hinh, néu can 1ap lai mot thao tac trude doé thi nhan
Ctrl B. P
a eéu khi dung hinh mf‘} quén tén do1 twong da dung thi co6 thé click vao nut
R dé md bang danh muce cac ddi twong da dung (dé nghi), chon d6i twong nao thi
click dtp vao dong mo6 ta doi tuong do.
C6 thé click truc tiép vao ddi tuong co trong ban v& dé chon dién tén vao
ca;c hop thoai dang mo.
1. DUNG DIEM: Create > Point:
1.1) Dung diém tuw do:
\ 1.1.1) Dung diém tw do trong khong gian: Create >Point >
. Free point > In space:
* Lénh nay cho phép ta dung mot diém tu do trong khong gian, ta ¢ thé thay doi
. vi tri ctia diém bang cach kéo tha (click va nhan giit phim trai chudt vao diém va

kéo dén vi tri thich hop hoi tha). Sau khi goi 1énh, man hinh xuét hién hop thoai:
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Free pointin space

k
‘Hame of the point: J

HEIp| Cﬂm::EI| Ok |

- Bién tén cua diém vao 6 Name of the point va nhan Enter hodc clich OK.
a han Ctrl B dé dung diém tiép theo (néu cb). \
* Thiee hanh: Dung 3 diém tu do A,B,C trong khong gian: Pau tién ta dlfng diém
A, sau d6 nhan Ctrl B va dung cac diém con lai.
Chii y: Khi dung diém tu do thi ta c¢6 thé di chuyén né bang cach clisk chudt trai

\1s . as ) Ao 1s A \ N\
va kéo, khi d6 con tré chuot bién thanh %.

1.1.2) Dung diém tw do trong mdt phang: Create >Point >
Free point > On a plan: N e
* Lénh nay cho phép dung mot diém tu do trén mot mat phéng da dung trudce do.
Thong thuong khi dung hinh choép, lang tru,... ta néh\‘dung cac dinh cia mat day
thudc mit phing oxy dé d& quan sat. Sau khi 'goi 1énh, man hinh xuét hién hop
thoai: W\

Free pointin a plane

Hame of the plane: J

Hame of the point:

HE|FI | Cﬂm::el| Ok |

- Dién tén cua mat phang (43 dung trudc do) vao 6 sd (1), co thé click vao
nut R dé chon trong bang danh muc.

- Bién tén ctia diém vao 6 s6 (2). 4 han Enter hoic click OK.
* T hirc hanh: Dung diém D 1a diém tu do trong mp(ABC) (mat phang qua 3 diém
ABC trong vi du trén).

- Goi 1énh, dién ABC vao 6 s6 (1).

" - Pién D vao 6 sd (2). Enter.

.Chi y: Khi ta thay d6i vi tri ctia A,B,C thi D s& thay ddi theo.
1.1.3) Dung diém tw do trén dwong thing: Create >Point >

i

Free point > In a line:
* Lénh nay cho phép tao mot diém tu do trén mot duong théng da dung, ta co thé

thay ddi vi tri ctia diém b.':ing cach kéo diém truot trén duong théng hoac tao Iénh
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thay d6i vi tri cia diém bang cach diéu khién bang ban phim. Sau khi goi 1énh,

man hinh xuét hién hop thoai:

Free point on a line

Hame of the line: ’1} J

Hame of the point:

Help | Cancel | /\ \
. &

- Pién tén cua duong thang da dung trude d6 vao 6 sb (1), click vao nat R
dé chon hoic click truc tiép duong thang trong hinh vé.
_ Pidn tén ciia diém cin dung vao 6 sb (2). Click OK hoge nhn Enter.
1.1.4) Dung diém tw do trén mét tia: Create > Point > Free
point >0On a ray: \. \

* Lénh nay cho phép ta dung mdt diém tu do trén mot tia da dung. Sau khi goi
1énh, man hinh xuét hién hop thoai: \\

Free point on a ray

=S
Hame of the ray: | {’1} | A
2y

Hame of the point:

Help | Cﬂncel| Ok |

Pién tén cla tia vao 6 sb (1), c6 thé click nat R dé chon trong bang danh
muc. -

Pién tén ciia diém can dyng vao 6 s6 (2). a han Enter hodc click vao nut
OK. \
* Chu ¥: tia.c6 thé xac dinh boi 2 diém, vi du: tia AB thi goc 13 A va tia di qua B.

1.1.5) Dung diém tw do trén doan thing: Create >Point >Free

point > On {l\segment.°
* Lénh nay cho phép ta dung mot diém ty do trén mot doan thang da dung, vi tri
xcua diém c6 thé thay d6i nhung bi gidi han bai 2 dau mat cua doan thang d6. Sau

kh1 goi 1énh, man hinh xuét hién hop thoai:

\ N

Free point on a segrment

Hame of the segment: 1} J

Hame of the point:

Help | Cancel |

T

N
o
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Pién tén doan théng vao 6 sb (1), co thé click vao nut R dé chon doan
thang trong bang danh muc.

Dién tén cta diém can dung vao 6 s6 (2).

4 han Enter hodc click vao nat OK.

1.1.6) Dung diém tw do trén dwong tron: Create >Point >Free
point > On a circle: A '\
* Lénh nay cho phép ta dung 1 diém tu do trén 1 dudng tron da dung; ta ¢6 the
thay doi vi tri cua diém bang chuot hodc tao 1énh dé diéu khién diém bang ban

phim. Sau khi goi I¢énh, man hinh xuat hién hop thoai: ~ 14

Free point on a circle

Hame of the circle: mJ

Hame of the point:

3

\J

HEIp| Cﬂm::EI|

Dién tén cta duong tron di dung vao 6 s6 (1), hoac click vao nut R dé chon trong
bang danh muc. AN\
Dién tén cta diém vao 6 sd (2) a.han Enter.

1.1.7) Dung dt@n tw do trén cung: Create >Point >Free point
> On an arc:
* Lénh nay cho phép ta dung mot diém ty do trén mot cung tron di dung trude

d6. Sau khi goi 1énh, man hinh xuét hién hop thoai:

\\ Free point on an arc

Hame of the arc: mJ

Hame of the point:

/ A} Help | Cﬂm::EI|

3

Pién tén cua cung vao 6 sb (1), hodc click vao nat R dé chon trong bang danh
muyc.

Dlen tién ctia diém can dung vao 6 s (2). 4 han Enter.

\ 1.1.8) Dung diém tw do véi toa dé nguyén: Create >Point >
Free point >With integer coordinate:

* Lénh nay cho phép ta dung mot diém tu do trong khong gian véi toa do
nguyén. Khi ta ding chudt dé thay doi vi tri cua diém thi ta chi c6 thé di chuyén
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{

diém dén nhiing vi tri co toa do nguyén ma thoi. Sau khi goi 1€nh, man hinh xuat

hién hop thoai:
Free pointwith integer coordinates |25
‘HEJTI.E of the point: (1) E
Help | Cancel | Ok |
[N A 9 - R A N A A A X /\ ! \
bién tén cua diém can dung vao 6 so (1). a han Enter. C /

1.1.9) Dung diém tw do trén truc véi toa dp nguyén: Create >
Point >Free point >On a line, with interger abscissa: B
* Lénh nay cho phép ta dung 1 diém ty do trén mot truc da dung véi toa do cua
diém (trén truc) a s6 nguyén. Khi ta dyng diém tu do trén truc véi toa d6 nguyén
thi toa do ctia diém 1a s6 nguyén ddi voi truc d6 chir khéng phai la toa d0 nguyén
d6i voi hé toa d6 oxyz. Khi ta thay d6i vi tri ctia diém thi chi c6 thé di chuyén
diém dén nhirng vi tri ¢6 toa do nguyén ma thoi. Sm@(hi go1 1énh, man hinh Xuét

hién hop thoai:

Free point on a line, with integer abscissa

[

line {2? points or with coordinate system): | {1}
R
@y

Hame of the point:

Help Cancel Ok

Dién tén truc di qua 2 diém (’fheo th tu diém) hodc truc ctia hé toa do vao 6 sb

(1), c6 thé click nat R dé chon trong bang danh muc.
Dién tén cua diém can ﬁu*ng vao 6 s6 (2). 4 han Enter.

1.1.10) Dung diém tw do trong da gidc 16i: Create >Point >
Free point > In a polygon:
*/Lénh nay gl\lo phép ta dung 1 diém ty do thudc mién trong ctia mot da giac 16
da dung. Sau khi goi 1énh, man hinh xuét hién hop thoai:

Free pointin a polygon

Hame of the polygon: _J

A

Hame of the point:

Help | Cancel |

Dién tén cta da giac vao 6 s6 (1), co thé click vao nut R dé chon trong bang danh

muc.
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Pién tén ctia diém can dyng vao 6 s6 (2). 4 han Enter.

1.1.11) Dung diém tw do trén mat cdu: Create >Point >Free
point > On a sphere:
* Lénh nay cho phép ta dung mdt diém tu do trén mot mit cau da dung. Sau khi

go1 1énh, man hinh xuét hién hop thoai:

Free point on a sphere /\ ' \

Hame of the sphere: mJ

Hame of the point:

HEIp| Cﬂm::EI| ~

bién tén cua mat cau vao 6 so6 (1), cé thé click vao nat R dé chon trong bang

danh muc. \

N
Pién tén cia diém can dyng vao 6 s6 (2). 4 han Enter.

1.2) Dung diém béi toa do cua no'.'\\‘Create >Point >Point by
coordinate(s) |

1.2.1) Dung diém vm tg){ do trong khong gian: Create >Point

> Point by coordinate(s) >In space:
* Lénh nay cho phép ta dung lﬁlem trong khong gian voi toa do cua nd duoc
cho trudce. Khi ta dung diém boi toa dd cta no thi ta khong thé di chuyen diém
dugc. Mudn thay ddi vi tri clia diém thi ta phai thay doi toa do ciia nd. Vao menu
Edit >Edit text of figure, tim dén dong mo ta diém va thay d6i toa do cua no, sau
khi thyc hién xong cli%]( nut Execute, chon Yes. Sau khi goi 1€nh, man hinh XUt

hién hop thoai:
Foint by coordinates in space (3w
’ \ X-coordinate: (1) I
a ¥-coordinate: | {2}
EIR
Z-coordinate: | {3}
‘ N\ Hame of the point: {4}
Help | Cﬂn[:EI| Ok |
Le JLe [l e [ 2 ]l (R0 [E-2]RA2

bién hoanh d¢ cua di€m can dung vao 6 so (1)

bién tung do cua diém can dung vao 6 so (2)
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Dién cao d¢ cua di€m can dyng vao 6 so (3)

bién tén cua diém can dung vao 6 so (4). a han Enter.

X Figure Géospace 1: Text editian = @
File Edit Execute ¢
IGeospace figure (English) -
Murnber of version: 1
X N\
Lxyz with the srmallest dimension of the window as unit: 0.1 - /

Rotations of Rxyz: vertical: -20 horizontal: 25 frontal: O

m

A point with coordinates (1.2.3) in coordinate system Rxyz

End of the figure Toa do cua A

-

1.2.2)Dung diém véi toa dp ciia no)\trong riié‘\t phing: Create >
Point > Point by coordinate(s) >In a plane:
* Lénh nay cho phép ta dung 1 diém voi toa do cho trudc cua nb trong 1 mat
phang da dyng, mat phang ¢ day doc hiéu 1a mit phang toa do. a éu ta ghi & 6 sb
1 1a ABC thi mp(ABC) dugc xac dinh(\mét‘hé toa do co géc la A, hai vécto don vi
la 4B, AC (

AN

Paint by coordinates in a plane ==
Plane (3 points or with coordinate =system): {’1} |
X-coordinate: | (2) a
¥-coordinate: | {3} -
Hame of the point: {4}

Help | Cancel Ok
[ L et o L2 [ RIE2]EA2

D/ién tén ctia 3 diém cua mit phang da dung (vi du ABC) hoic 1 cac mit phang
toa d0 (oxy, oyz, 0xz) vao 6 s6 (1)
Dién hoanh d6 ctia diém can dung vao 6 s6 (2)
. Dién tung d6 cua diém can dyng vao 6 sb (3)
Pién tén ctia diém can dung vao 6 s6 (4). 4 han Enter.

1.2.3)Dung diém vai toa do cua no trén truc: Create >Point >
Point by coordinate(s) >On a line:
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* Lénh nay cho phép ta dung 1 diém véi toa do cho trude cia nd trén mot truc da

dung, truc & day duoc hiéu 1a truc toa dd. a éu ta ghi 6 0 s6 1 1a AB thi duong

théng AB la mot truc toa do co géc la A, vécto don vi la 4B. Sau khi goi 1énh,

man hinh xuét hién hop thoai:

Paint by abscissa on a line

X-coordinate:

Hame of the point:

line {(? points or with coordinate system): (1 ']

|3

(2)

(3)

s

Help

Cancel

Ok

L= |l JUal o [ 3 [[5 ][00

| |u:"‘xv

Dién tén cua 2 diém cua duong théng dé dung (vi du AB) heac 1a cac truc toa do
(0x, 0y, 0z) vao 6 s6 (1)
Dién hoanh d6 cua diém can dyng vao 6 sd (2) \\
Dién tn cua diém can dung vao 6 s6 (3)-@ han Enter.

1.2.4) Dung diém Vm tg(a do cua no trén mot tia: Create >
Point >Point by coordinate(s) >On aray:
* Lénh nay cho phép ta dung l\ﬁlem voi toa do cua no trén 1 tia. Sau khi got

Iénh, man hinh Xuét hién hop thoai:

r

I

AN

Foint by abscissa on a ray (3w
Ray: | (h)
Distance to origin: | (2) R

Hame of the point:

Help

Cancel

Ok

EXEE

| |uﬂv

Dién tén cua tia vao 6 s (1) (néu dién AB thi géc la A)
thoang cach tir géc dén diém can dyng (khoang cach theo hé toa do oxyz mic
dmh) vao 056 (2)

\ Dlen tén cua diém can dung vao 6 s6 (3). 4 han Enter.

1.3) Dung giao diém cia hai dwong thing: Create >Point >

Intersection 2 lines:
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* Lénh nay cho phép ta dung giao diém (néu c6) cta hai duong thang di dung.

Sau khi goi 1énh, man hinh xuat hién hop thoai:

Intersection of twao lines [5e]
First line: || "] )
Second line: | :21 ﬂ
Intersection (point): 31 /\ \
~ &
Help | Cancel | Ok |

Dién tén ctia dudong thang thi nhat vao 6 s (1)

Pién tén ctia duong thang thir hai vao vao 6s6 (2) \\

Dién tén ctia giao diém vao 6 s6 (3). 4 han Enter.

1.4) Dung giao diém ciia dwong thzzlng\ va mat ‘phang: Create >
point > Intersection line-plane:
* Lénh nay cho phép ta dung giao diém cﬁa’ | duc‘ysg thang va 1 mat phang da
dung trudc do. Sau khi goi 1énh, man hinh xuathién hop, thoai:

Intersection of a line and a plane @
Hame of the line: | .1'I
Hame of the plane: | (2) ﬂ
Intersection (point): .31

Help Cancel Ok

Pién tén ctia duong thang vao 6 s6 (1) (vi du a, AB,...)

Pién tén cu}t mit phang vao 6 s6 (2) (vi du, P, ABC,...)

Pién tén ctia giao diém vao 6 s6 (3). 4 han Enter.

1.5). Dung giao diém ciia dwong thang va dwong tron: Create >
Point > Intersection line-circle:

\ 1.5.1) Dung hai giao diém ciia dwong thing va dwong tron:
Create > Point > Intersection line-circle > 2 points:
\ L\énh nay cho phép ta dung 2 giao diém cua 1 dudng thang va 1 dudng tron da

\ dung trude do. Sau khi goi 1€nh, man hinh xuét hién hop thoai:
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Intersection line-circle {2 points) [E3m]
Hame of the line: | (1)
Hame of the circle: .2" | =1
Inter=zection= (points): | 3]
Help | Cancel | Ok | )\
bién tén cua duong thang vao 6 so6 (1) - /

Pién tén ctia duong tron vao 6 s (2)

Pién tén cia hai giao diém vao 6 s6 (3), tén cach nhau boi mot

khoang trang (vi du: A B) A\ ¢

a han Enter.

1.5.2)Dung giao diém thir hai ciia\duong thang va dwong

tron: Create > Point > Intersection line-circle > second point:
* Lénh nay cho phép ta dung giao diém thtr 2 cua\dggng thang va dudng tron da
dung trudc d6. Vi du ta c¢6 diém A nam trén duong tron tim O, dé dung duong
kinh AB ta sir dung 1énh nay dé tlm(gla(\dlem thtr 2 ctia duong thang OA véi
duong tron (O). Sau khi goi 1énh, man hinh xuat hién hdp thoai:

Intersection line-circle (second point) ==

Hame of the line: | :1'|

Hame of the circle: (2) A
| @ |

Existing point:

2° intersection (point): -11

Help | Cﬂnc:el| Ok |

Dién tén ctia duong thang vao 6 s6 (1)
/ Dlen tén ctia duong tron vao o6 so (2)
D1en tén ctia giao diém di cd vao 6 sb (3)

Dién tén cla giao diém thir hai vao 6 sb (4). 4 han Enter.

i

1.6) Dung giao diém ciia hai dwong tron: Create >Point >
\Intersection 2 circles:
1.6.1) Dung hai giao diém ciia 2 dwong tron: Create >Point >

N

Intersection circles > 2 points:
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* Lénh nay cho phép ta dung 2 giao diém cua 2 dudng tron da dung trude do. Sau
khi goi Iénh, man hinh xuat hién hop thoai:

Intersection 2 circles (2 points) @
First circle:

Second circle: ::_-ﬁ.] B
Intersections {(points): '3" /\ \

Help | Cﬂnl::el| Ok |

Pién tén ctia duong tron thir nhat vao 6 sd (1)

Pién tén ctia dudng tron thi hai vao 6 s6 (2) ~ ¢

bién tén cua hai giao diém vao 6 sO (3), tén cach nhau bdi mot
khoang trang (vi du: A B)

2
A

a han Enter. A N

1.6.2) Dung giao diém thir hai\ cua 2 dwong tron: Create >
Point > Intersection 2 circles > second point: R
* Lénh nay cho phép ta dung giao diém thtr 2 cia hai duong tron da dyng trude
do. Sau khi goi 1énh, man hinh XUAt hign ﬁ&) thoati:
Intersection 2 circles (second point) [
First circle: _
Second circle: IT a
Existing point: | @y
2° intersection (point): IT

Help | Cﬂnl::el| Ok |

Dién tén ctia duong tron thir nhat vao 6 sd (1)

Pién tén ctia duong tron thir hai vao 6 s6 (2)

I:)\ién tén ctia giao diém di co vao 6 s6 (3)

Dién tén cla giao diém can dung vao 6 s6 (4). 4 han Enter.
AN 1.7. Dung giao diém ciia dwong thing va mdt ciu: Create > Point >
N\ Intersection line-sphere

\ 1.7.1) Dung hai giao diém ciia dwong thing va mdt ciu:
Create > Point > Intersection line-sphere > 2 points:

* Lénh nay cho phép ta dung hai giao diém ctia 1 duong thang va 1 mat cau da
dung trude do. Sau khi goi 1€nh, man hinh xuét hién hop thoai:

Vowsén Chanh o Nhan - CHPO N, 2 » Y, ‘i (}u “ /éz o Ninh 2
@@/ Thank Min - THIC Ny Gia T Gio T, Ty ik y



i

fm HUG4 G DA4 SU DU4 G PHAA MEM GEOSPACE 2003

Intersection line-sphere (2 points) (5]
Hame of the line: | :11
Hame of the sphere: .2'I B
Intersections {(points): .3]
Help | Cancel | Ok |
Dién tén cta dudng thang vao 6 so (1) N\

Pién tén ctia mit cau vao 6 s6 (2)
Pién tén cta hai giao diém vao 6 s6 (3), tén cach nhau béi mot
khoang tring (vi du: A B) ~ ¢
a han Enter.
1.7.2) Dung giao diém thir hai cii< duong {@agng va mit cau:
Create >Point >Intersection line-sphere > second point:
* Lénh nay cho phép ta dung giao diém thu 2 cia \1 duong thang va 1 mat cau da

dung. Sau khi goi 1énh, man hinh xuét hién hop thoal)?

Intersection line-sphere (zecond paint) (]

Hame of the line: (71%)

Hame of the sphere: :21

= R
Existing point: 5]
2° intersection {point): 41

Help | CﬂnCE|| Ok |

Pién tén ciia duong thang vao 6 so (1)
Dién tén c&b mit cau vao 6 s6 (2)
Dién tén cua giao diém di co vao 6 s6 (3)
Dién tén cta giao diém vao 6 sd (4). 4 han Enter.
( 1@) Dung trung diém ciia doan théing: Create >Point >Midpoint:
* Lénh nay cho phép ta dung trung di€ém cua mot doan thang da dung trudc do.

‘Sau khi goi 1énh, man hinh xuat hién hdp thoai:
AN

Midpaoint

[l
Hame of the =segment: | {1} | R
@,

Hame for the midpoint:

&

Help | Cﬂnl::el| Ok |

Dién tén ctia doan thang vao 6 s6 (1) (vi du AB)
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Pién tén cia trung diém vao sd (2)
a han Enter.
1.9) Dung tam: Create >Point >Center (various):
1.9.1) Dung trong tdm cua tam gidac: Create >Point >Center
(various): Centroid:
* Lénh nay cho phép ta dung trong tam cia mot tam giac da dung tmﬁdo Shu
khi goi 1énh, man hinh xuét hién hop thoai:

Centroid 5]
Hame of the triangle: || (1) | ¢
BN\ O
Centroid: IT ~
Help Cancel Ok

Pién tén ctia tam gidc vao 6 sb (1) (c6 thé click chon cac dinh truc

tié}f) trong ban ve. ’ \ \\

Dién tén cua trong tam Va‘lo 050 (2)

a han Enter. SN\

1.9.2) Du’ng tém ciia dwong tron néi tiép tam gidc: Create >

Point > Center (various) > Incenﬁer
* Lénh nay cho phép ta dung duoc tAm cta duong tron nodi tiép cia mot tam giac
da dung trude do. Sau khi goi Iénh, man hinh xudt hién hop thoai:
| Incenter ==

Hame of the triangle: T_
R
Incenter: {2} B

Help Cancel Ok

e @ién tén cua tam giac vao 6 s6 (1)

Pién tén ctia tAm dudng tron ndi tiép tam giac vao 6 s6 (2)
x a han Enter.
1.9.3) Dung tim dwong tron ngogi tiép tam gidc: Create >
\ Point >Center (various) >Circumcenter:
* Lénh nay cho phép ta dung duogc tdm ctia duong tron ngoai tiép ctia mot tam

giac da dung trude do. Sau khi goi 1énh, man hinh xuét hién hop thoai:
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Circumecenter ==
Hame of the triangle: | {1}
R
Circumcenter: {1}
Help Cancel Ok

Pién tén ctia tam giac vao 6 s6 (1). Vi du ABC,...
Dién tén cta tim can dung vao 6 s (2). ~\ \ 7
a han Enter

1.9.4) Dung truc tam cua tam gidac: Create >Point >Center

(various) > Orthocenter: () ¢
* Lénh nay cho phép ta dung duoc tryc tAm ctia mot tam gidc da dung trude do.
Sau khi goi 1énh, man hinh xuét hién hop thoai: \. N
Orthocenter 5]
Hame of the triangle:’#‘_
Orthocenter: IT ﬂ
Help Cancel Ok

Di{%n tén cua tam gié;sv\éo 6 sb/(1). Vi d,u ABC,...
Dién tén cua truc tdm can dung vao 6 so (2).
a han Enter.
1.9.5) Dung tam ciia mét dwong tron da dung: Create>Point>
Center (various) > Of a circle:
* Lénh nay cho phép t&\dung dugc tam cua mot duong tron da dung trude do (co
thé 1a duong tron giao tuyén hay quy tich cta 1 diém,...). Sau khi goi 1énh, man

hinh xuét hién hop thoai:

e A Center of a circle

3
Hame of the circle: “J

Hame of the center:

HEIp| Cﬂm::EI|

Dién tén cta dudng tron can dung vao 6 sb (1). Vidu cl.

Pién tén ctia tAm can dung vao 6 s6 (2)

a han Enter.

1.10) Dung tim ti cw ciia mét hé diém: Create >Point >Barycenter:
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* Lénh nay cho phép ta dung dugc tam ti cu cuia 1 h¢ diém da dung trude do. Sau

khi goi Iénh, man hinh xuat hién hop thoai:

Barycenter of points with masses [3m]
-Exemple: (R,-2) {B,S}
|L15t of the points with masses: )\
[
Barycenter: = (2) JJ /5 }/\\
Help | Cancel | Ok
L e el oo || & )52 (115 IIunv ¢
Dién hé diém cung voi hé sb cua né vao 6 so (1). O .

Dién tén cua tam ti cu vao 6 so (2).

a han enter.

WY

Vi dy 1: Duyng trong tdm G cua tam giac ABC: .65 (1) ta dién (A,1) (B,1)

(C,1) (c6 khoang tring & giira). Dién G vao 6 sb (23. \

Vidy 2: Dyng dinh D cua hinh binh hanh ABCD v6i A,B,C 1a 3 diém da dung: &
6 56 (1) didn (A,1) (B,-1) (C,1). O sb (2) didn D.
1.11) Dyng anh cua tém boi: Create >Point >Image point by

Point > Image point by > Existing transformation:

1.11.1) Anh ciia diém qua phép bién hinh di tao: Create >

* Lénh nay cho phép ta tim anh cia mot diém qua 1 phép bién hinh da tao trudc

d6. Thong thuong khi dung h1nh néu sir dung 1 phép bién hinh nhiéu 1an ta nén

tao san phép bién hmh‘%’o va ap dung 1énh nay dé giam thoi gian vé hinh. Sau khi

goi 1énh, man hinh xuét hién hop thoai:

\

Irnages by existing transformation

Transformation:

| (1)

Points (to be transformed):

=

| ?)

Image=s of these points:

B

| (3)

Help | Cancel |

Ok |

Pién tén ctia phép bién hinh vao 6 s6 (1). Co thé click nat R dé chon.

bién tén cua diém tao anh vao 6 s6 (2)

Dién tén cua anh can dung vao 6 so (3)
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a han Enter.
1.11.2) Anh ciia diém qua phép doi xung truc: Create > Point
> Image point by > Symetry through a line:
* Lénh nay cho phép ta dung dugc anh ciia mot diém cho trude qua phép dbi
xung truc. Sau khi goi 1énh, man hinh xuét hién hop thoai: )\
Images by reflection = 07 N\

hxis of symmetry: W_

Points {(to bhe transzformed):
| (2) R

Images of these points:

| (3)

Help | Cﬂncel| Ok |

3

\}

Dién tén cua truc ddi xtmg vao 6 sd (1)

Dién tén cla tao anh vao 6 sd (2) \ \\

Dién tén cta anh vao 6 sb (3)

a han Enter. (\ I\

1.11.3) Anh cua diém qua phép doi xurng tam: Create>Point >

Image point by >Symetry througé a point:
* Lénh nay cho phép ta ta dung anh cua mot diém cho truéc qua hép dbi xtimg
tam. Sau khi goi 1énh, man hinh xuét hién hop thoai:

Irnages by central syrmmetry ==

Center of symmetry: l”
Point=s {(to be transformed): J
| (2) R

Images of these points:

(3)

Help | Cﬂncel| Ok |

z Pién tén ciia tAm d6 ximg vao 6 so (1)
Dién tén cta diém tao anh vao 6 sb (2)
Dién tén ctia anh vao 6 s6 (3)
a han Enter.
1.11.4) Anh cia diém qua phép doi xung qua mdt phaeng:
Create > Point > Image point by >Symetry through a plane:
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* Lénh nay cho phép ta dung duoc anh ciia mot diém cho trudc qua phép d6i

xing qua mat phéng. Sau khi goi Iénh, man hinh xuét hién hop thoai:

Images by syrmimetry through a plane (==

Hame of the plane:| {1}

Points (to bhe transformed):

| (2) R | )

Images of these point=s: fi j*'\

| (3) N\
Heu1| Cﬂncel| Ok |

Dién tén ctia mat phang vao 6 s6 (1)
Pién tén cua tao anh qua 6 s6 (2) O
Dién tén cta anh vao 6 sb (3)
a han Enter. \ N

1.11.5) Anh ciia diém qua phép tinh tién (theo vécto): Create>
Point > Image point by >Translation (vector): \\
* Lénh nay cho phep ta dung dugc anh cua 1 diém qua phép tinh tién theo mot

vecto cho trude. Sau khi goi 1énh, man hinh' xuét hién hop thoai:

Irmages by translation (wector) [E3m]

Vector of translation:

[ (1)

Point=s {(to be transformed): El R
| (2) Sl B

Images of these points:

| (3)
Help |  Cancel | ok |
Lz v sl Jluo [ 2 ][5 1022 ]RAe
7 t)ién tén cua vecto tinh tién vao 6 sd (1). Vi du: vec(u), vec(A,B)

) \ d 14
Dién tén cta diém tao anh vao 6 s6 (2)

‘ Dién tén cta diém anh vao 6 s6 (3)
4 han Enter.
1.11.6) Anh ciia diém qua phép tinh tién véi diém - dnh:

Create > Point > Image point by >Translation (point-image):
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* Lénh nay cho phép ta dung duoc anh ctia mot diém qua phép tinh tién véi vecto
tinh tién c6 diém géc va diém ngon la 2 diém da dung. Sau khi goi 1énh, man

hinh xuét hién hop thoai:

Irnages by translation (point-image) =
transforming the point: | {1} [ >\2
into the point: {2} /K ;\
Points {(to bhe transformed): R - V4
| (3)
Images of the=ze point=s:
| 4
(4) i
Help | Cancel | Ok | (N

Pién tén ctia diém gdc clia vecto tinh tién'vao 6 s6 (1)
Dién tén cta diém ngon vecto tinh tién vao 0.s6'(2)

Dién tén cta diém tao anh vao 6 s6 (3)

Dién tén cta diém anh vao 6 s6 (4) \\

a han Enter. N

1.11.7) Anh ciia diém qua phép quay véi truc-géc quay:

Create > Point > Image point by > Rotation (axis-angle):
* Lénh nay cho phép ta dung énlzz)cﬁa mot diém cho trude qua phép quay voi truc
va goc quay cho trudc, chiéu quay theo qui tac “ban tay phai”. Sau khi goi lénh,

man hinh xuét hién hop thoai:”

. Irmages by rotation (axis-angle) @
Angle unit: |radian ~

Hame of the axis:| {” I
Angle: | {2}
Points {(to he tranzformed): R

/ N | (3)

) Images of these points:
| (4)
! \ Help | Cﬂncel| Ok |

L= [ et ke L2 [ R1E-2]RA2

Chon don vi do goc 6 6 Angle unit
Dién tén cta truc vao 6 s6 (1). Chua ¥: truc & ddy mang ¥ nghia 14 truc
toa do (da dung véi diém géc va vecto don vi)

bién s6 do géc quay vao 6 s6 (2)
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Dién tén cta diém tao anh vao 6 sb (3).
Dién tén cta diém anh vao 6 s6 (4)
a han Enter
1.11.8) Anh ciia diém qua phép vi tw véi tém va ti sé vi tw:
Create > Point > Image point by >Homothety (center-ratio):
* Lénh nay cho phép ta dung dugc anh cia 1 diém cho trudc qua phep”&l tu \Xn
tam va ti s6 vi tu. Ti sO vi tu c6 thé 13 mot s6 hodc mot bién di tao hodc ti'sd do

dai 2 doan thang,. .. Sau khi goi Iénh, man hinh xuét hién hop thoai:

Irmages by homothety (center-ratia) @ ~ /
Hame of the center: | {1} |
Ratio: {2}
Points {to be transformed): R \\“
| (3)
Images of these points:
| (4)
Help | Cﬂm::EI| Ok |
BN R EEREEE

Dién tén cua tAm Viﬁbve‘lo 650 (1)

Dién ti s6 vi tw vao 856 (2)

Dién tén ctia diém tao anh vao 6 s (3)

Dién tén cua diém 4nh vao 6 s6 (4)

a han Ente&‘

1.11.9) Anh cua diém qua phép vi tw voi tim-diém-anh: Create >
Point > Image point by >Homothety (center-point-image):
* Lénh nay cho phép ta dung duoc anh cua 1 diém cho trudc qua phép vi tu duogc
tao boi thm - didm - 4nh 1a 3 diém thang hang. Sau khi goi 1énh, man hinh xuat
hién hop thoai:
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Irmages by homothety (center-point-image] |5

Hame of the center: | {1}

Antecedent :

Inage: 3)

R

2

Points {to be transformed):
Images of these points: . /

| (9)

Help | Cﬂnc:el| Ok |

Dién tén cua tam vao 6 so6 (1) )
Dién tén diém goc vao 6 s6 (2)

Dién tén diém anh vao 6 s6 (3) \.

M
Pién tén ctia diém tao anh vao 6 so (4) \
Dién tén ctia diém anh can dung vao 6@6&5)
a han Enter.
? 1.11.10) Anh ciia ditém gua phép chiéu vuéng géc lén dwong
thang: Create > Point >Image point by >Orthogonal projection on a line:
* Lénh nay cho phép ta dl_mgf' @qc anh cua 1 diém cho trudc qua phép chiéu
vudng goc 1én mot duong thang dd dung. Sau khi goi 1énh, man hinh xuat hién
hop thoai: ;
Irmages by orthogonal projection on a line ==

Hame of the line:| lli

Points {to be transformed):
| (2)
Images of these points:

(3)

Help | Cﬂn[:EI| Ok |

2]

’ \ |

Pién tén ctia duong thang vao 6 so (1)
Dién tén cta diém tao anh vao 6 sb (2)
Dién tén cta diém anh vao 6 s6 (3)
a han Enter.
1.11.11) Anh ciia diém qua phép chiéu vuong goc lén mat

phing: Create >Point >Image point by >Orthogonal projection on a plane:
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* Lénh nay cho phép ta dung duoc anh ctua 1 diém cho truéc qua phép chiéu

vudng goc lén mot mat phéng da dung. Sau khi goi Iénh, man hinh xuat hién hop

thoai:
Irnages par orthogonal projection on a plane @
Hame of the plane:| {'”
Points {(to bhe transformed): /\ ,\
| 2) R ~\ \/
Image=s of these points:
| (3)
Help Cancel Ok N {

Pién tén ctia mat phang vao 6 s6 (1)
Dién tén cua diém tao anh vao 6 sb (2) \_ \
Dién tén cua anh (hinh chiéu) vao 6 s6 (3)
a han Enter. \ \\
1.11.12) Anh cua diém qua phép chiéu lén mat phang theo
phwong chiéu la dwong thing cho Wo’& Create > Point > Image point by >
Orthogonal projection on a plane with direction of a line:
* Lénh nay cho phép ta dung d@c anh ctia mot diém cho trude qua phép chiéu
1én mot mit phang véi phuong chiéu 1a duong thiang da dung va khong song song

vO1 mat phéng. Sau khi goi 1énh, man hinh xuét hién hop thoai:

Irnages by projection on a plane with direction of a line ==

Hame of the plane:|| l”

Hame of the line: | {2}

Points (to be transformed):
| (3)

I Images of these points:

11 (4)

: Help Cancel Ok

Dién tén cia mat phang vao 6 so (1)

|2

Dién tén cta duong thiang (phuong chiéu) vao 6 sd (2)
Dién tén cta diém tao anh vao 6 sb (3).
Dién tén cta anh (hinh chiéu) vao 6 s6 (4)

a han Enter.

&
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2. DUNG PUONG: Create >Line:
2.1. Dung dwong thing: Create >Line >Straight line(s)
2.1.1) Puwong thing qua hai diém: Create > Line > Straight
line(s) > Through 2 points:
*Lénh nay cho phép ta dung duoc duong thang di qua 2 diém dd dung. Sau khi

goi 1énh, man hinh xuat hién hop thoai: 07N\
~ &
Lines thraugh twio paints @
Hames of the lines:
W (1) :
. ¢
Help | Cancel | Ok | O

Pién tén duong thang qua hai diém (vi dy AB, Ma yeot)- a han enter.
C6 thé dung nhiéu duong cung lic (vi é‘u AB éf) — céach nhau boi
khoang tring) )

2.1.2) Dung dwong thing song \so\l\dg: Create >Line >Straight
line(s) > Parallel: ’
* Lénh nay cho phép ta dung duong t(}\lérig\di qua 1 diém cho trudc va song song
v6i 1 duong thang da dung. Sau khi goi 1énh, man hinh xuat hién hop thoai:

Line parallel to a line ==
Line through: {1} |
and parallel to the line:l {2} ﬂ
Hame of the line: {3}

Help | Cﬂnl::el| Ok |

Dién tén cta diém ma duong thiang di qua vao 6 s6 (1).
ﬂién tén ctia duong thang song song vao 0 sd (2)
Dién tén ctia duong thiang can dung vao 6 s6 (3). 4 han Enter.
2.1.3) Dung dwong vuong géc véi mot dwong thang: Create >
Line > Straight line(s) >Perpendicular a line:
. *.Lénh nay cho phép ta dung duoc dudng thang di qua 1 diém cho trudc va
vudng goc véi 1 duong thang di cho. Puong thang dung duoc cit duong thang

da cho. Sau khi goi 1€énh, man hinh xuét hién hop thoai:

@VM Thark M - THTT Nyi Gia T G T, Tay Vi 5



fm HUG4 G DA4 SU DU4 G PHAA MEM GEOSPACE 2003

Line perpendicular to a line [£5]
Line through: | {1
and perpendicular to the line:| {2} R

Hame of the line: igi
Help Cancel Ok
N

bién tén cua diém thudc duong thang vao 6 so (1). - /

Pién tén ctia duong thang vudng goc voi dudng can dung vao 6 sd
(2)
bién tén cia duong can dung vao 6 so6 (3). a han Enter.
2.1.4) Dung dwong vuéng goéc véi mét mét phing: Create >
Line > Straight line(s) >Perpendicular a plane: \ \
* Lénh nay cho phép ta dung dugc duong thiang di qua 1 .di€m cho trudc va

vudng goc véi 1 mit phang di dung. Sau khi goi l@h, man hinh xuat hién hop

thoai:

Line perpendicular to a plane | [oE3m]
Line through: _
and perpendicular to the plane:| (2) R
Hame of the line: l_(g]_

Pién tén cia diém thudc dudng thang can dung vao 6 so (1)

Pién tén cﬁ\ﬁ mit phang vudng goc vao 6 s6 (2)

Dién tén ctia duong thang can dung vao 6 sb (3)

a han Enter.

s \" 2.1.5) Dung giao tuyén ciia hai mat phing: Create > Line >

I

Straight line(s) > Intersection of 2 plane:
* Lénh nay cho phép ta dung dugc giao tuyén cua hai mat phang da cho. Sau khi

'\ A N\ b) /’\ A ~ .
goi 1énh, man hinh xuat hién hdp thoai:
T \

S
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Intersection line of 2 planes ==

First plane: | {1} J
R

Second plane: | {2}

Hame of the line: {3}

Help | Cﬂm::EI| Ok |

Dién tén cia mat phang thi nhat vao 6 sb (1) - ,
Pién tén ctia mat phang thir hai vao 6 s6 (2)
Dién tén cla giao tuyén vao 6 s6 (3)
a han Enter. )
2.1.6) Dung dwong phdin gidic ciia méot goc: Create >Line >
Straight line(s) >Bisector line: \_ \
* Lénh nay cho phép ta dung dugc duong phan giac cua 1 goe tao boi 3 diém cho
trudc. Sau khi goi 1énh, man hinh xuét hién hop th@@'{\\
Bisector (3]

Angle (3 pt=): i ”
R
Hame of the bisector line: | { }

Help Cancel Ok |

Pién tén ctia goc (tao-boi 3 diém) vao 6 s6 (1). Vi du ABC,...

Dién tén ctia dudng phan giac vao 6 s6 (2)

a han Enter.. "

* Cha ¥: néu dién AB(&Yhi s€ dung duogc tia phan giac cua goc B.
2.1.7) Dung dwong thing la dnh ciia mét dwong thang cho

truwée (qua mot. phép bién hinh): Create >Line > Straight line(s) > Image of a
line: \\‘
* Lénh nay cho phép ta dung dugc anh cia mot duong thang qua 1 phép bién
+hinh da tao trudce do. Sau khi goi Iénh, man hinh xuét hién hop thoai:
A Line image of a line [£5]
\) Line {to be transformed): W‘
Hame of the transformation: |_(2}_ R
Image line: W

Help Cancel | Ok
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Pién tén ctia duong thang tao anh vao 6 s6 (1)
Dién tén ctia phép bién hinh vao 6 s6 (2)
Dién tén cta dudng thiang anh vao 6 sd (3)
a han Enter.
2.1.8) Dung dwong thing di qua mgt diém va cé vecto chi
phwong cho truwoc: Create >Line >Straight line(s) >Point and vector: i\ '\

/

Line defined by point and wectar @

Line through: | {1} |

Directing vector: R 4

(2) - O
Hame of the line: {3}
Help | Cancel | Ok | A\l

I 8 0 e R 5 LN R

p .2 n . 2 N\ A £
Dién tén cua diém thudc duong thing can dung vao 6 s6 (1)

Pién tén cua vecto chi'phuong vao 6 s6 (2). Vi du: vec(a);

vec(A,B),.. ONN
Pién tén cla du’ong ‘(E?ng can dung vao 6 s6 (3)
a han Enter.

2.1.9) Dung dwong thing vdi hé toa dj (dung I truc toa dj):
Create >Line >Straight line(sﬁ >With coordinate system:
* Lénh nay cho phép ta du’n\é mot truc toa do vdi cac khoang chia dg. Sau khi goi
1énh, man hinh xuét hié}l hop thoai:

Line with coordinate systerm @
Line through: i”_
I | [vector: | (2)
Step for graduatiun:| {3} R
Limits for drawing: | {4}
. Hame of the line: | {5}
Help Cancel Ok
ANNNEEEERE

Dién tén cta diém thudc duong thang can dung vao 6 s6 (1)

bién tén cua vecto vao 0 s0 (2)
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Pién s6 khoang chia do vao 6 s6 (3)
Dién giéi han cta truc can v& vao 6 sb (4). Vi du: -4 4 (c6 khoang
trang gitra -4 va 4)
Dién tén ctia duong thang can dung vao 6 sb (5). 4 han Enter.
2.1.10) Diit tén lai cho dwong thang di qua hai diém: Create >
Line > Straight line(s) > Named, by 2 points: ”\ ’ \
* Lénh nay cho phép ta dit lai tén cho duong thang di qua 2 diém da du:ng Sau

khi goi Iénh, man hinh xuét hién hop thoai:

Line with a name, through 2 points /

Line (2 points): {1} J

Hame of the line:

Help | Cancel |

Pién tén duong thang (2 diém) vao 6's6 @). Vidu AB.
bién teén can dat vao 6 s6 (2)
a han Enter. (\ I\
2.2) Dung tia: Create >Line >Ray(s):
2.2.1) Dung ti'é boi hai diém: Create >Line >Ray(s) >By 2
points
* Lénh nay cho phép ta dung mot tia c6 diém gdc cho trude va di qua mot diém
da dyng. Sau khi goi 1€nh; man hinh xuét hién hop thoai:
Rays ==

Ilﬁla.mes of the (TSH: ﬂ

Help | Cﬂm::el| Ok |

( o, . . . .
Dién diém goc va diém thir hai thudc tia vao 6 so (1). Vi du: AB la tia

c6 goc 1a A va di qua diém B.
\ a han Enter.
\\ 2.2.2) Dat tén lai cho tia tao boi hai diém: Create >Line >
Ray(s) >Named, by 2 points:
* Lénh nay cho phép ta dat lai tén cho tia dugc tao bdi 2 diém. Sau khi goi 1énh,

man hinh xuét hién hop thoai:
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Ray with a name, defined by 2 points

Origim:

HON|
Point of the ray (2) B
Hame of the ray: (3)

Help |

Cancel |

Ok |

Dién diém goc cua tia vao 6 so (1).

bién diém thudc tia vao 6 so (2).

bién tén cua tia vao 6 s6 (3).

a han Enter.

~

2.3) Dung doan thang: Create >Line >Segment(s)
2.3.1) Dung doan thing tao bo’{Z dié}g;\ Create >Line >

Segment(s) > By 2 points:

* Lénh nay cho phép ta dung doan thang c6 dau mut‘%a 2 diém di dung, ta co thé

dung cung lic nhiéu doan thang. Sau khi goi 1énh, man hinh xuat hién hop thoai:

Seqrments

(B

Hames of the segqments:

|

(D

B

Help |

Cancel |

Ok |

Dién tén cia doan théng vao 6 sb (1). Vidu AB, vé6i A, B 14 hai diém

da dung trudc do a éu dyng cung lic nhiéu doan thang thi tén cua

mdi doan CE{ch nhau 1 khoang trang, vi du AB CD EF,.

4 han Enter\}

2.3.2) Pt tén lai cho doan thing tao béi 2 diém: Create >

Line > Segmgnt(s) > Named, by 2 point:

* Lénh nay cho phép ta dat lai tén cho doan thrfmg tao boi 2 diém. Sau khi goi

1énh, man hinh xuét hién hop thoai:

\

\\ segrment with a name, defined by 2 paoints

Hame of endpoints:

Hame of the segment:

Ol ﬂ
@

sl

Help |

Cancel |

ok |

Pién tén cua doan thang vao 6 s6 (1). Vi du: AB véi A,B 1a hai dau

mut cta doan thang d dung.
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Dién tén can dit vao 6 s6 (2)
a han Enter.
2.4) Dung da gidc 16i: Create >Line >Convex polygon
2.4.1) Dung da gidc 16i véi cdc dinh cho trudc:Create >Line>
Convex polygon > By vertices:
* Lénh nay cho phép ta dung duoc da giac 16i boi cac dinh 14 cac dlem’(’ia duﬁg

Sau khi goi 1énh, man hinh xuét hién hop thoai:

Convex polygon defined by its wertices @
List of the vertices (3 to 40): s
[ M | ﬂ ~\
‘Ha.me of the polygon: (2)

Help ‘ Cancel | Ok | \ N

Pién tén cac dinh da dung cia da giac 16i vao 6 s6 (1). Vi du:
ABCDE, ta c6 thé dung da gidc 16i ¢6 téQg?a 40 dinh.
Dién tén cua da giac vao 6 s6(2), tén co toi da 4 ki tu.
4 han Enter. (\ M\
* Thyre hanh: Dyng ta giac 10 ABCD.
bé dung duoc tir glac 16 ABCDga phai dung trudc 4 dinh cua nd va 4 diém nay
phai dong phang. a hu vay ta ¢6.thé dung 4 diém nay 1a 4 diém tu do trong mot
mit phang nao d6, thong thuong ta chon mit phang oxy, hodc dung diém D thudc
mp(ABC). ¢ day ta dung 4 diém A,B,C,D tu do trong mit phang oxy.
- Create > Point > Freixpoint > On a plane (xem phan dung diém tu do trong mit
phang), nhan Ctrl B dé 1dp lai 4 1an thao tac nay.
- Create >Line >Convex polygon > By vertices. Pién ABCD vao 6 s6 (1), dién
pl-vao.d s6.(2). Enter.
a hu vay ta da dung dugc tir giic ABCD véi tén 1 p1 nam trong mp oxy.
‘*Chlrl y: néu 4 diém A,B,C,D khong tao thanh da giac 16i thi s& xudt hién bang
thong bao:

N\

@ Vyugin Thank M - THPE Ny Gia T Go D, Tay Nk o



fm HUG4 G DA4 SU DU4 G PHAA MEM GEOSPACE 2003

The object plwould be irvalid, £E

#1 would be inside the palygon
H1,

Confirmm creation 7

M| N ANNA
~ &

Ta chon Yes va sau do kéo (click gitr phim trai chudt vao diém va kéo) diém dén

khi xuét hién t& giac 16i. Xem hinh:

/
B C E
A C LA
. N :
Trudc khi kéo diém C , Sau khi kéo diém C

2.4.2) Dung thiét dign ciia hinh da di¢n cit béi mét mdt
phing: Create >Line >Convex polygon >Section of a polyhedron by a plane:
* Lénh nay cho phép ta dung dugc 1 da giac 16i 1a thiét dién ctia mot da dién da

dung cat boi 1 mat phéng da dung. Sau khi goi 1€nh, man hinh xuét hién hop

thoai: /
Section of a polyhedran by a plane =
Hame of the polyhedron: ()
Hame of the plane: | (2) ﬂ
Hame of the polygon: (3)
Help | Cﬁncel| Ok |
r

E\ién tén cua da dién vao 6 s6 (1)
Pién tén ctia mat phang vao 6 s6 (2)
x Pién tén ctia da giac (thiét dién) vao 6 s6 (3)
4 han Enter.
* Thire hanh: Cho ti dién ABCD, goi M trung diém cua BC. Hay dung thiét dién

clia tir dién cat boi mp(P) di qua M va song song véi 2 canh AB va CD.

N\

Cach dung:




fm HUG4 G DA4 SU DU4 G PHAA MEM GEOSPACE 2003

- Dung tor dién ABCD, dat tén 1a s1(xem phén Dung da di¢n 161 v&i cac dinh cho
trude)
- Dung trung diém M cta doan BC: Create > Point > Midpoint (xem phan dung
trung diém)
- Dung mat phang (P) di qua M va song song hai duong thang AB va CD: Create
> Plane > Parallel to 2 lines (xem phan Dyng mat phing song song v6i hai duong
thang). Cha y: mit phang (P) khong xuat hién nhu trong phan mém Cal;ri 3D, ta
biét su ton tai ctia (P) qua tén cua nd va qua dong mo ta nd trong bang Rappel.
- Dung thiét dién, dat tén 1a pl: Create >Line >Convex polygoy\ >Section of a
polyhedron by a plane:

+ Pién sl vao 6 sb (1).

+ Pién P vao 6 s6 (2).

+ Pién pl vao 6 s6 (3). Enter. Két qua:

A

. ul

) z
pé quan sat thié‘g dién, ta Qhén gitt phim SHIFT va dung cac phim miii tén va
PGUP, PGDa dé xoay\‘-ginh.
D¢ dat tén cho cac dinh con lai cua thiét di¢én, ta dung giao di€ém cua mp(P) véi
cac canh cua ti dién.

p " 2.4.3) Dung danh cua mgt da di¢én: Create >Line >Convex
polygon > Image of a polygon:

* Lénh nay cho phép ta ta dung 1 da dién 13 anh ciua mot da dién qua 1 phép bién
‘hinh da tao trudc do. Sau khi goi 1énh, man hinh xudt hién hop thoai:

N\
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Folygon image of a polygon (3]
Antecedent polygon: | (1)
Hame of the transformation: (2) |m
Image polygon: (3)
Help | Cancel| Ok |
Pién tén ctia da giac tao anh vao 6 s6 (1) A \

Dién tén ctia phép bién hinh (di tao) vao 6 sb (2)
Dién tén cta da giac anh vao 6 s (3)
¢
. (N
2.4.4) Dung da giac déu: Create > Line > Convex polygon >

a han Enter.

Regular polygon: \ N
* Lénh nay cho phép ta dung 1 da giac déu véi 1 dinh va truc ciia n6 di dung.
Sau khi goi 1énh, man hinh xuat hién hop thoai:

\

Regular polygon (5]
Hame of the axis: " (1)

Hame of a vertex: | @
Hunber of edges (3 to 40):| (3)

Hame of the polygon:

Help Cancel Ok

ER | (TP M R =l D [

Dién tén cua tryc vao 6 sO (1). Truc 1a truc dudng tron ngoai tiép da
gidc can dl{ng
Pién tén cia 1 dinh cua da glac can dung vao 6 s6 (2)
Dién s6 canh cua da giac can dung vao 6 s (3)
p Dién tén cua da giac can dung vao 6 sb (4). 4 han Enter.

3

2.4.5) Dung bao hinh 16i: Create >Line >Convex polygon >
Convex hull:

* Lénh nay cho phép ta dung 1 da giac 16i 1 bao hinh 16i ctia mot s6 diém hoic
mot s6 da giac 16i. Sau khi goi 1énh, man hinh xut hién hop thoai:
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Conwvex hull {(palygon) (3]
List of the points or polygons:
" @) R
‘Ha.me of the polygon: (2)

Help | Cﬂnc:el| Ok |

Dién danh sach cic diém hoic cic da giac 16i vao 6 s6 (1). Chit y cdc
diém cdach nhau béi khodng trang. \ ’
Pién tén ctia bao hinh can dung vao 6 s6 (2).
4 han Enter. /
2.5) Dung dwong tron: Create >Line >Circle: \

2.5.1) Dung dwong tron trén mot mat phing véi tam va bdn
kinh cho truoc: Create >Line >Circle > By plane, center and ;:adius:
* Lénh nay cho phép ta dung dugc 1 duong tron ném trén 'mot mat phang da
dung v61 tam va ban kinh cho trude. Sau khi g(_)i\ léhh, man hinh xuét hién hop
thoai:

Circle defined by center, plane and radius @
Hame of the plane: || l:l) ‘
Hame of the center: (2)
Radius: ﬂ
(3)

Hame of the circle: (4)

Help | CﬂnCE|| Ok |
| | | e R = |

Dién tén ctia mit phang chira dudng tron vao 6 s6 (1).
Bién tén ctia tAm dudng tron can dung vao 6 s6 (2).
p Dién ban kinh ctia dudng tron vao 6 so (3). Bdn kinh c6 thé la so
hodc la tén doan thcfng da dung truoc do.
Dién tén ctia dudng tron vao 6 sb (4)
\ a han Enter.
\ 2.5.2) Dung dwong tron trén mjt mat phﬁng VoI tam va mot
diém thujc dwong tron cho truée: Create >Line >Circle >By plane, center and
a point:
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* Lénh nay cho phép ta dung dugc 1 duong tron trén 1 mit phang da dung voi
tam va 1 diém thudc duong tron cuing nam trén mat phang d6. Sau khi goi 1énh,
man hinh xuét hién hop thoai:

Circle defined by plane, center and a point =
Hame of the plane: ||| (1) |
Name of the center: @ ﬂ A LON
Point on the circle: | @ N /
Hame of the circle: ’T

Help | Cance” Ok

Dién tén ctia mat phang chia dudng tron vao 6 s6 (1). -

Dién tén ctia tim duong tron vao 6 sb (2)

Diéj:n tén ctia diém thudc dudng t’rc‘)n vao Qsé (3),

bién tén cia duong tron vao 6 so6 (4)

a han Enter. » \\
2.5.3) Dung dwong tron voi truc va mot diém thuoc dwong

tron: Create > Line > Circle > By axtfg al?d a point:

* Lénh nay cho phép ta dung dugc'1 dudng tron voi truc ciia nd va 1 di€m thudc

duong tron da dung. Sau khi gé‘i }@nh, man hinh xuét hién hop thoai:

Circle defined by axis and a point (3w

Hame of the axis: W_

Point on the circle: IW R

Hame of the circle: (3)

Help | Can-::EI| Ok |

Dién tén cta truc dudng tron vao 6 s6 (1)

p Dién tén cua diém thudc dudng tron vao 6 sb (2)
Dién tén cta duong tron vao 6 s (3)
a han Enter.

. 2.5.4) Dung dwong tron ngogi tiép tam gidc: Create >Line >

.~ Circle > Circumcircle:
* Lénh nay cho phép ta dung duoc dudng tron ngoai tiép cua 1 tam giac da dung.
Sau khi goi 1énh, man hinh xuét hién hop thoai:
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Circurmcircle @
Hame of the triangle:l (]) |
R
Hame of the circle: (2) B
Help | Cancel | Ok |

Pién tén ctia tam gidc vao 6 s6 (1) |
Pién tén ctia duong tron ngoai tiép tam giac vao 6 s (2) /5 ,\
a han Enter.
2.5.5) Dung dwong tron néi tiép tam gidc: Create >Line >
. . ¢
Circle >Incircle: o\
* Lénh nay cho phép ta dung duoc dudng tron ndi tiép cta 1 tam gidc da dung.

Sau khi goi 1énh, man hinh xuét hién hop thoai: \ \

Incircle

=

Hame of the triangle:| I:l]
R
[ @

Hame of the circle:

Help | Cﬂnc:el| Ok |

Dién tén cla tam giac.vao 0 s0.(1)
Pién tén clia dux‘)’ng. t\xcém ngoai tiép tam giac vao 6 so (2)
a han Enter.
2.5.6) Dung dwong tron giao tuyén cua mdat cdu va mdat
phang: Create >Line > Circle >Section of a sphere by a plane:
* Lénh nay cho phép tQ\\du’ng dugc 1 dudng tron 14 giao tuyén cua 1 mat cau va 1

mat phéng da dung. Sau khi goi 1énh, man hinh xuét hién hop thoai:

Intersection of a sphere and a plane (2%
/ \ Hame of the sphere: _
3 Name of the plane: | (2) B
Hame of the circle: (3)
]
. Help | Cﬂm::el| Ok |

Dién tén cua mat cau vao 6 so (1)
Dién tén ctia mat phang vao 6 s6 (2)
Dién tén cua duong tron giao tuyén vao 0 so (3)

a han Enter.
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2.5.7) Dung dwong tron giao tuyén ciia hai mat cdu: Create >
Line > Circle > Intersection of 2 spheres:
* Lénh nay cho phép ta dung dugc 1 duong tron 13 giao tuyén cia 2 mit cau da

dung. Sau khi goi 1énh, man hinh Xuét hién hop thoai:

Intersection of two spheres 53]

Fi : 1 A\ '\
irst sphere B P
Second sphere: (2) R

Hame of the circle: (3)

Help | Cﬂm:el| Ok | ¢

Pién tén ctia mit cau thir nhat vao 6 s6 (1)
Dién tén cia mit cau thir hai vao 6 sb (2)\
Dién tén cua duong tron giao tuyén vao 0 so (3)
4 han Enter. \\
2.6) Dung cung: Create >Line >Arc:
* Lénh nay cho phép ta dung duoc 1 gijng v6i truc duong tron chtra cung va diém
géc va diém ngon cua cung. Sau khi goi léthl, man hinh xuét hién hop thoai:
Arc of circle (5]

Hame of the axis: {]

Origin: (2) a

Endpoint: (3) B

Hame of the arc: {4)
Help | Cancel | Ok |

Dién tén cua truc duong tron chtra cung vao 6 sb (1). Cha ¥ truc nay
1a truc toa do (c6 gbc va véc to don vi)
Dién tén ctia diém gdc clia cung vao 6 sb (2)
Dién tén ctia diém ngon cta cung vao 6 s6 (3)
\ Pién tén ctia cung vao 6 sd (4).
\ a han Enter.
Cht y: Cung duoc dung theo quy tic “ban tay phai”
2.7) Dung dwong cong: Create >Line >Curve:
2.7.1) Pwong cong cho béi phwong trinh tham sé: Create >

Line > Curve > Parametric:
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* Lénh nay cho phép ta dung dugc 1 duong cong duoc cho boi 1 phuong trinh

tham s6. Sau khi goi 1énh, man hinh xuét hién hop thoai:

Pararmetric curse 23w

Hame of the parameter: h (]) |

Expression of the X-coordinate:

| @ AN
Expression of the Y-coordinate: . /
| 3)

Expression of the Z-coordinate: R

| (4)

Limits {ex: -5 2/3): | (5)

Humber of points (20 to 1000):| (6)

Hame of the curve: (T)

B3 F= | A =l T

Pién tham s6 vao 6 s6 (1) |

Dién biéu thirc cua bién x/&ao Qsé 2)

Pién biéu thirc cua blen y vao 0 s0 (3)

Dién biéu thirc clia bxz‘)n z'vao 0 s (4)

Dién gi6i han ciia tham s vao 6 s6 (5)

Dién s diém cta-do thi vao 6 sd (6) tir 20 dén 1000 diém, sb diém

cang 16m thi do thi cang “min”

Dién tén cu\‘& duong cong can vé vao 6 sb (7). 4 han Enter

2.7.2) Dung quy tich cua mgt diem: Create >Line >Curve >Locus
of a point: \
* E€nh nay cho phép ta dung dugc 1 duong cong la quy tich cua 1 diém da dung.
Sau khi goi fénh, man hinh xudt hién hop thoai:

8
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Locus of a paint

Pilot: (1)

Hame of the point which descrihes the locus:

Humber of points (20 to 1000): | (3)

Hame of the curve:

Help Cancel Ok /\ \

I I | T R e T

5 HE

4

Dién tén cua diém diéu khién vao 6 s6 (1)
Pién s6 diém cua quy tich vao 6 sd (2), tir 20 diéH\IOf)O diém, s
diém cang 16n thi d§ min cang cao. ‘
Dién tén cta quy t{ch vao 656 (3). 4 hénEnter. \
2.7.3) Vé do thi cua mot ham so: Create > Line > Curve >
Graph of a function: ‘ , . \\ q
* Lénh nay cho phép ta v€ do thi cua ham so trén 1 mdt phang voi hé toa do da

tao. Sau khi goi 1¢énh, man hinh XUAt hé;én hop thoai:

Graph of a function % =25
Plane {3 points or with coordinate system): | (1) |
Expreszion of the function {(variabhle X):
(2)
Limits (ex: -5 273): | (3) £
Humber of points (20 to 1000): | (5)
Hame of the curve: {5)
Help Cancel Ok
3|0 P | = R e
¢ @\ién tén cia mit phang chira do thi vao 6 s (1). Chu ¥: mit phang

qua 3 diém hodc 1 hé toa dd. 4 éu ghi 1a ABC thi mat phéng ABC s¢
Y duoc xac dinh mot hé truc toa do voi géc 1a A, hai vecto don vi lan

luot 1a 4B, 4C

Pién biéu thirc cua bién x vao 6 s6 (2). Bién x phai dugc viét in vi du:

X"2-3*%X+2

Dién gi6i han cua bién x vao 6 s6 (3), vi du: -5 5 (c6 khoang tring &

gifra).
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2.8) Vé do thi dang lwéi: Create >Line >Meshing
2.8.1) Quy tich ciia mét diém béi hai (ngwoi) diéu khién:
Create > Line > Meshing >Locus of a point with 2 pilots
* Lénh nay cho phép ta dung duoc quy tich cua 1 diém véi 2 sy diéu khién. Sau

khi goi 1énh, man hinh xuat hién hop thoai: >§
Locus of a point with 2 pilots == ri }\\ -
-}[aximu.m 10000 points (example: 1nnx1nn}-- o /
Hame of the first pilot: (1) |
Humber of values: | (2]
Hame of the second pilot: (3) .
R
Humber of values: | (4)
Hame of the point which describes the locus: (5)
Hame for the meshing: (ﬁ)
Help Cancel Ok |
L L [l Jhao Jl 2 ][22 (130 ][5-2 ez

Dién tén ciia didu khién thir nhdt vao 6 sé (1). Vi du: X. Dién sb

khoang chia vao 6 56

Dién tén cua diéu khién 2 vao 6 s6 (3). Vidu: Y

Dién s6 khoang chia vao 6 sb (4)

Ché §: (2)x(4) khéng Vot qua 100x100

Dién tén cua dlem mo ta quy tich vao 6 s6 (5)

Pién tén c%a mit vao 0 s6 (6). 4 han Enter.

\ 2.8.2) Vé lwdi dé thi ciia ham 2 bién: Create>Line>Meshing

> Graph of a 2-variables function:
>’fLénh néys‘c\ho phép ta dung dugc ludi do thi ctia ham 2 bién sb. Sau khi goi

1énh, man hinh xuét hién hop thoai:

AN
R
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Graph of a 2-wariables function (3w
-{aximm 10000 points (example: 1unx1nn}-
Hame of the function: | (]) -
Limits for the variable 1:| (2)
Humber of values: | (3) ;
R \ )
Limits for the variable 2: | (4) Ki )\\ J
Humber of values: | (5) \
Hame for the meshing: (ﬁ)
Help Cancel Ok &
Lz ]l [[lal lso L2 [ ][RI ]RA2 .

Dién tén ctia ham 2 bién vao 6 sb (1)

Dién gidi han cta bién 1 vao 6 s6 (2) \
Dién tén cua bién 1 vao 6 s6 (3)

Dién gi6i han cta bién 1 vao 6 sd (4). C\iu y: tich s6 6 2 6 (2) va (4)
khong vuot qua 100x100

Dién tén cta bién 1 vao 6 sb (’5

Dién tén cta ludi t@@& va0 6 56 (6). 4 han Enter.

Vi du: Dung mat dugc cho boi phuong trinh: f(x,y)=x*+3"-3x+4y+8.

- Trudc tién ta tao ham hgi bién: Create >a umeric >Function >2-variable

function”
‘ 2-varizbles function [5]
Local wvariahle 1: b
\‘\ Local variable 2: A
\ Expression of the function: R
I \ X2+ 2-3XK+4Y+8
\y
Hame of the function: |ﬂ
r«{ \ Help | Cﬂm::el| Ok |
\ S I = | |
A\

- Sau d6 ta thyc hién 1énh v& d thi dang ludi va dién nhu sau:
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Graph of a 2-variables function (]

-naximum 10000 points (example: 1nnx1uu}-

Hame of the function: f
Limits for the variable 1:|55
Humber of wvalues: |5l]
R t
Limits for the variable 2:[-55 /K f\\
o &

Humber of wvalues: |5l]
Hame for the meshing: |m1|

Help Cancel Ok
= |la (s o [ 3 132 R1RE2]RA .

- Két qua nhu sau: \ >

3) DUNG MAT PHANG: Create >Plane:
* Cht y: Khong giéng nhu phin mém Cabri 3D, khi ding 1énh tao mit phing
trong Geospace thi méibhéng khong duoc hién thi trén man hinh, ching ta nhin
biét su ton tai cua mit phang qua tén va thudc tinh ctia no trong bang rappel. 4 hu
vay, dé biéu dié\n mat phéng ta can dung hinh chir nhat c6 4 dinh nam trong mat
Pﬁng- 3‘*\

3.1) Dung mit phing qua mét diém va chira dwong théing (di cho):

'Create > Plane > By a point and a line:
O \ * Lénh nay cho phép ta dung dugc 1 phang chira duong thang da dung va di qua
1 diém khong thudoc duong thang dé. Sau khi goi 1€nh, man hinh xuat hi¢n hop

thoai:
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Flane defined by a point and a line (3]
Hame of the point: | (]
Hame of the line: | (2) ﬂ
Hame of the plane: |:3]
Help | Cancel | Ok |
Pién tén ctia diém thudc mit phang vao 6 s (1). i\ /\

Dién tén ctia duong thiang vao 6 sb (2)

Dién tén ctia mit phang vao 6 sé (3).

a han Enter. ~

3.2) Dung mdt phing chiva hai dwong (song song hodc cit nhau di
cho): Create >Plane >By two lines: \}
* Lénh nay cho phép ta dung dugc 1 mdt phang chira 2 dudng thang song song
hodc cit nhau d3 dung. Sau khi goi 1énh, man hinh\x%ft hién hop thoai:

Plane defined by twa lines [we3m]
First line: | (1)
Second line: | (2) ﬂ
Hame of the plane: {3)

Help | Cﬂm::el| Ok |

Dién tén ctia dudong thang thir nhat vao 6 s (1)

Pién tén cua duong thang thir hai vao 6 s6 (2)

Dién tén CI{Q mat phang vao 6 s6 (3)

a han Enter.

3.3) Dung mit phing song song véi mét mat phing di cho:
Create> Plane > Parallel to a plane:
* Lénh nay cho phép ta dung dugc 1 mit phang di qua 1 diém va song song voi 1

mat phéng da dung. Sau khi goi 1énh, man hinh xudt hién hop thoai:

A\ Parallel plane 23]
W) Plane containing: (1]
and parallel to the plane: | (2) ﬂ
Hame of the plane: |:3]
Help Cancel Ok

Vowsén Chanky oNhan - CHPE oV, 2 / o D, ‘i (}u “ /é o Ninh )
@@/ Thank Min - THIC Ny Gia T Gio T, Ty ik "



fm HUG4 G DA4 SU DU4 G PHAA MEM GEOSPACE 2003

Pién tén cua diém hodc dudng thing ma mit phang chira nd vao 6 sd

(1) (duong thang phai song song mat phang da cho)

Pién tén ctia mit phang song song vao 0 so (2)

Dién tén ctia mit phang can dung vao 6 s6 (3). 4 han Enter.

3.4) Dung mdt phing song song véi hai dwong thang: Create > )\
Plane > Parallel to 2 lines: i\ ’/\
* Lénh nay cho phép ta dung dugc 1 mat phang di qua 1 diém va song song vdi 2

duong théng chéo nhau da dung. Sau khi goi Iénh, man hinh xuét hién hop thoai:

Plane parallel to twa lines [25] /
5 O\
Plane containing: (1)
First line: | (2)
_ R )
Second line: | (3) N
Hame of the plane: (4)
Help | Cﬂm::el| Ok |

Dién tén cta diém ma métr’phe:mg di qua vao 6 s6 (1)

Dién tén ctia duong thang thir rhw“’lt vao 056 (2)

Dién tén cua duong thing thit 2 vao 6 s (3)

Dién tén ctia mat phéﬁg vao 0 sb (4)

a han Enter. B

3.5) pgrng mét\ \ phang vuong goc voi mot dwong thang da cho:
Create >Plane > Perpendicular to a line:
* Lénh nay cho phép t§ dung duoc 1 mat phang di qua 1 diém va vudng goc véi 1

duong théng da dung. Sau khi goi 1énh, man hinh xuét hién hop thoai:

Perpendicular plane 23]
r \ _
D Plane containing: - H]
and perpendicular to the 1ine:| {2,] ﬂ
i \ Hame of the plane: (3)
\ Help | Cancel Ok

Pién tén ciia diém ma mat phang di qua vao 6 s6 (1)
Dién tén ctia duong thang vudng goc vao 6 sb (2)
Dién tén cia mat phang vao 6 s6 (3)

a han Enter.
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3.6) Dung mat phdng trung trwc ciia doan thing: Create >Plane >
Perpendicular bisector:
* 1énh nay cho phép ta dung duoc mit phang trung truc cua 1 doan thang da
dung. Sau khi goi 1énh, man hinh xuét hién hop thoai:

Perpendicular hisectar plane

Hame of the segment: | (]) J /X }\

Hame of the plane:

Help | Cancel |

Dién tén cia doan thang vao 6 s6 (1) )

Pién tén ctia mat phang vao 6 s6 (2)

4 han enter. \ N\
3.7) Dung mat phang voi phwong trinh tong quat cho truodc:

Create> Plane > By an equation: \ \}

* Lénh nay cho phép ta dung dugc 1 mat phiang véi phuong trinh tong quat cua

no. Sau khi goi 1énh, man hinh XuAt hl(éln ngp thoat:

Plane defined by an equation [we3m]
I'Use the capital letters X,¥ and Z. Example: 21{—3!{+Z+5=[ll

Equation:
“ (1) E|R
‘Ha.me of the plane: (2)

Help Cancel Ok

L= L el o L& )2 [RIE2|RA2

Dién phuong trinh ciia mit phang vao 6 sé (1). Cha ¥: cac bién
X,Y,Z dung ki ty Ia HOA. Vi du: 2X-3Y+Z+5=0

g s ) .
Dién tén ctia méat phang vao 6 s6 (2)
a han enter.
QAN 3.8) Dung mit phing gin véi mot hé truc toa dp: Create >Plane >

\\ With a coordinate system:
* Lgnh nay cho phép ta dyng dugc 1 mat phang véi 1 hé toa do véi goc va 2

vecto co s da dung. Sau khi goi I€nh, man hinh xudt hién hop thoai:
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Plane with a coordinate systern (3]
First vector: | (2)

Second vector: | (3)

Hame of the plane: IW

Help Cancel | Ok | fi ’&

L L Jlal Jhao L2 {58 [R0[E-2]EA

Dién tén cua diém gdc vao 6 s6 (1)
Dién vécto don vi thir nhat vao 6 s6 (2). Vi du: vec(A,B) dé chi vécto
AB, hodc vec(u) dé chi vécto u ‘
Dién tén cta vécto don vi thit 2 vao 6 sb Q)

bién tén ctia mat phang vao 6 s6 (4)

a han enter. N\ \}
3.9) Dit tén lai cho mat phing dwng boi'3 diém: Create >Plane >
Named, by 3 points: ?Q \\!

* Lénh nay cho phép ta dat lai tén cho mat phang tao boi 3 diém. Sau khi goi
1énh, man hinh xuét hién hop tﬁa\%\

Plane with a narme, defined by 3 points ==

Plane {3 point=s): | (1) |
R
Hame of the plane: ( ) o

Help | Cﬂm::el| Ok |

Dién tén cta 3 diém vao 6 sd (1)
Dién tén cia mat phang vao 6 s6 (2)
7 a'han enter.
y , . .
4) TAO PHEP BIEN HINH: Create >Tranformation:
~ 4.1) Phép doi xirng qua mdt phang: Create > Tranformation >
1\
Symmetry through a plane:
\* Lénh nay cho phép ta tao 1 phép dbi xing qua mit phang da dung. Sau khi goi

1énh, man hinh xuét hién hop thoai:
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Syrnrmetry through a plane @
Hame of the plane: | (]j
R
Hame of the symmetry: {2) B
Help | Cancel | Ok |
Pién tén ctia mat phang vao 6 s6 (1) ) )
Pién tén ciia phép bién hinh vio 6 sb (2) ANWA

a han enter.

4.2) Phép doi xirng truc: Create >Tranformation > Symmetry
through a line: &\ ¢
* Lénh nay cho phép ta tao 1 phép ddi xtmg qua 1 duong thang da dung. Sau khi

goi 1énh, man hinh xuét hién hop thoai:

Dy

N

Reflectian

Hame of the axis: (1) J

Hame of the symmetry:

Help | Cancel |

Dién tén cta truc dpl xing vao 6 sd (1)

Pién tén cia phép bleg hinh vao 6 s6 (2)

a han enter.

4.3) Phép doi xirng tdm: Create >Tranformation through a point:
* Lénh nay cho phépta tao 1 phép d6i xtmg qua 1 diém d3 dung. Sau khi goi
1énh, man hinh xuét hién hop thoai:

Central symmetry

Hame of the center: MJ

/ %\ Hame of the symmetry: (2)

Help | Cancel |

1 Dién tén clia tim d6i xtmg vao 6 s6 (1)
Dién tén ctia phép bién hinh vao 6 sb (2)
a han enter.
4.4) Phép tinh tién (theo vecto di cho): Create >Tranformation >

Translation (vector):
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Lénh nay cho phép ta tao 1 phép tinh tién v&i vécto tinh tién di tao. Sau khi goi

1énh, man hinh xuét hién hop thoai:

Translation fwectar)

Yector:
[ @) E|R
‘Ha.me of the translation: |:2] > i

Help | Cancel | Ok % /

x|l |Ual e L3 2 505 IIum

Dién tén cta vécto tinh tién vao 6 sb (1). Vi du: vec(A,B), vec(u),. ..

Dién tén ctia phép bién hinh vao 6 sb (2)

a han enter. \

4.5) Phép tinh tién véi diém-anh: \Create gT ranformation >
Translation (point-image):
* Lénh nay cho phép ta tao 1 phép tinh tién voi Vecfé tinh tién tao boi 2 diém da
dung. Sau khi goi 1énh, man hinh xuét hién hop thoai:

Translation (point-image) (3]

transforming the point: _
into the point: IT R

Hame of the translation: IT

Help | Cﬂm:el| Ok |

Didn tén cia diém vao 6 sé (1)

Pidn tén cta anh vao 6 sé (2)

Dién tén ctia phép tinh tién vao 6 s (3)

é\hén enter.
Chu Y1 diém A, anh B thi phép tinh tién 13 phép tinh tién theo vécto AB

4.6) Phép quay voi truc-goc quay: Create >Transformation >
‘Rotation (axis-angle):
U Leénh nay cho phép ta tao 1 phép quay voi truc da dung va goc quay tuy y. Sau
khi goi Iénh, man hinh xuat hién hop thoai:
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Rotation (axis-angle) 5]
Angle unit: ’Eﬂ%—r)l—;'
Hame of the axis: | (2) |
Angle: | (3) ﬂ
Hame of the rotation: (4) )\
Help | Cancel | Ok | /K "\\
™ Y 4
BN R EE R RE

Chon don vi do goc & 6 sb (1), radian hodc do (degree)

Dién tén cua truc vao 6 sd (2), truc ¢ day la truc tgg\d(f)/(véi géc va

diém, hodc truc di dung trudc) .
Dién tén cuia phép quay vao 6 s6 (3) \
a han enter.

Chu ¥: chiéu quay thuc hién theo quy tic “Ban tay phai”
4.7) Phép quay véi truc va 2 diém: Create >Tranformation >

Rotation (axis and 2 points): ? 2\

* Lénh nay cho phép ta tao 1 phép quay véi truc da dung va 2 diém da dung tao

thanh goc quay. Sau khi goi lér{;ki,}ﬁén hinh xuat hién hop thoai:

Rotation (axis and 2 points) [25]

-T]lE angle i=s defined by a diedral-

Hame of the axis: | E]J |
Point in the first half-plane: (2) a
Point in the second half-plane: IT B
Hame of the rotation: (4)

f \ Help Cancel Ok

Dién tén cia tryc vao 6 s6 (1)

Pién tén ctia diém thudc nira mat phang thir nhat vao 6 sb (2)
NN Dién tén cta diém thudc nira mit phang thr hai vao 6 s (3)
Pién tén ctia phép quay vao 6 s6 (3)
a han enter.
Chu y: Phép quay thuc hién theo quy tic “Ban tay phai”
4.8) Phép vi tw vdi tim-ti sé vi tw: Create >Tranformation >

Homothety (center-ratio):

@VM Bhank Min - THIC Nyi Gio T, G D, Ty o Nink "



fm HUG4 G DA4 SU DU4 G PHAA MEM GEOSPACE 2003

* Lénh nay cho phép ta tao 1 phép vi tu v6i tam 1a 1 diém d3 dung va ti s6 vi tu
tuy y. Sau khi goi 1énh, man hinh xuét hién hop thoai:

Homothety (center-ratio) (3w
Hame of the center: (1) |
Ratio: | (2) B > \
Hame of the homothety: (3:] /K s\
. 4
Help | Cﬂnc:el| Ok |
Lz )L et oo )l 2 [ [0 2-3]RA2
Pién tén cta tAm vi tu vao 6 s6 (1) ) {

Dién ty s vi tu vao 6 s6 (2)

Dién tén ctia phép vi tu vao 6 s (3) \ \
a han enter.

4.9) Phép vi tw véi tam-diém-inh: Sreate > Tranformation >

Homothety (center-point-image):

Hornothety (center, point-irmage) 5]

Hame of the center: (1)

Antecedent: |: ]
Image : (3)

Hame of the homothety: (4)

Help | Cﬂm::el| Ok |

%

Dién tén c@ tam vi tw vao 6 sd (1)
Pién tén ciia diém vao 6 s6 (2)
Dién tén cta anh vao 6 s (3)
, Dién tén cua phép vi tu vao 6 s6 (3)

4 han enter.

Chu y: Tam-diém-anh phai thang hang.

A 4.10) Tich ciia hai phép bién hinh: Create >Tranformation >
\~Composition of 2 tranformations:
* Lénh nay cho phép ta tao 1 phép bién hinh 14 tich ctia 2 phép bién hinh di tao

truée d6. Sau khi goi 1énh, man hinh xuat hién hop thoai:
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Compaosition of 2 transformations

.

- Y

o
| |E|

Fir=t transformation:

;‘
-
2]

followed hy:

Hame of the result of composition: (3)
Help Cancel Ok > \
Pidn tén cia phép bién hinh thir nhit vao 6 sb (1) ANWA

Dién tén ctia phép bién hinh thir hai vao 6 s (2)
Dién tén ciia phép bién hinh tich vao 6 s6 (3)
A 1A ¢
a han Enter. ~
5) CAC LENH THUQC VE SO: Create > Numeric:
5.1) Tao bién sé thuc tw do thujc mét\dogn: \C\‘qceate >Numeric >
Free real variable in an interval:
* Lénh nay cho phép ta tao 1 bién sb thuc tu do.co t{le thay doi gia tri bang ban

phim trong 1 doan [a;b] tuy y. Sau khi go1 Iénh, man hmh xuat hién hop thoai:

Free real wariable in an intersal

Limits {ex: -5 273): JJ

Hame of the wvariabhle:

Help Cancel Dk

IEN | T e | ||unv

Pién gi¢i han ctiia doan vao 6 s6 (1). Vi du -5 2/3 (c6 khoang trang)
dé biéu dlé% cho doan [ ﬂ Pién tén ciia bién vao 6 s6 (2).

a han enter.
* Chay: Khl\ta str dung 1énh tao bién sb tu do, dé thay doi gi tri cua bién ta su
dung'cac phlm mili tén. 4 éu tao nhiéu bién ta phai st dung 1énh Piéu khién bang
‘ban phim (Piloting >Piloting with keyboard) dé chon bién can diéu khién, hodc
tao\lénh dé chon béng cach nhan phim diéu khién (Create > Command >Selection
. for piloting with keyboard) .

5.2) Tao mot bién so thuc tw do: Create >Numeric > Free real
variable:
* Lénh nay cho phép ta tao mdt bién s thuc tu do, ta co thé thay doi gia tri cua

bién bang ban phim Sau khi goi 1énh, man hinh xuat hién hop thoai:
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Free real wariahle

‘Ha.me of the variahle: - J

Help | Cﬂnc:el| Ok |

Dién tén cta bién sb can tao vao 6 sb (1)

i han enter. \

5.3) Tao m¢t bién s6 nguyén tw do thupc mét doan: Ereaté >
Numeric > Free integer variable in an interval:
* Lénh nay cho phép ta tao 1 bién s nguyén tu do thudc 1 doan, ta ¢o thé thay
d6i gia tri cua bién bang ban phim. Sau khi goi 1énh, man hinh Xuét hién hop
thoai:

Free integer wariable in an intersal

Limits {ex: -5 273): JJ

Hame of the variable:

Help Cancel Dk

0 TR0 | = T IIunv

Dién gi6i han cta @gjn vao 0'sd (1). Vi du: -5 2/3 dé biéu dién cho

doan [—5;2}
3

Dién tén cua biénvao 6 sd (2)

a hanenter. .

5.4) Tao m@t bién s6 nguyén tw do: Create >Numeric > Free integer
variable:
* Lénh nay cho phép ta tao 1 bién sd nguyén ty do, ta c¢6 thé thay doi gia tri cta
bién béng bé}ﬁ phim. Sau khi goi I¢nh, man hinh xuét hién hop thoai:

Free integer wariable

‘Ha.me of the variabhle: - J

Help | Cancel| Ok |

Dién tén cua bién s6 nguyeén can tao vao 6 so (1)
a han enter.

5.5) Do dac hinh hgc: Create > Numeric > Geometric
measurement :
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5.5.1) Do ban kinh cua mot dwong tron: Create >Numeric >
Geometric measurement > Radius of a circle:
* Lénh nay cho phép ta do ban kinh ctia 1 duong tron da dung, don vi do 1a don
vi cta hé toa do6 mic dinh, ta c6 thé st dung phép do nhu 1 bién trong cac tinh
toan vé sau. Sau khi goi 1énh, man hinh xuét hién h()p thoai:
Radius of a circle X N\

Hame of the circle: mJ

Hame of the radius:

Help | Cancel |

Dién tén ctia dudng tron vao 6 sb (1)

Dién tén cho ban kinh vao 6 sb (2). Tén\ne‘ly du’q\c}\dfmg dé tinh toan

nhu mot bién.

a han enter. \ : ’ ?

5.5.2) Tinh khodng cach tw 1 diém dén 1 dwong thang:

Create > Numeric > Geometric measwenkent > Distance point-line:
* Lénh nay cho phép ta tinh khoang cach tir 1 diém dén 1 duong thang da du:ng,
ta c6 thé st dung két qua cia phép do nhu 1 bién sb trong cac tinh toan vé sau.

Sau khi goi 1énh, man hinh xuét hién hop thoai:

Distance from a pointto a line 5]
Hame of the point: (1)
Hame of the line: | (2) ﬂ
Hame of the distance: {3}
Help | Cancel | Ok |
p Dién tén cua diém vao 6 so6 (1)

Dién tén cia duong thang vao 6 s6 (2)
Pién tén dé hién thi khoang cach vao 6 sd (3)
a han enter.

5.5.3) Khodng cdch tiv 1 diém dién 1 mdt phing: Create >
Numeric > Geometric measurement > Distance point-plane:
* Lénh nay cho phép ta tinh khoang cach tir 1 diém dén 1 mat phang da dung, ta
c6 thé st dung két qua cta phép do nhu 1 bién sd trong céc tinh toan vé sau. Sau

khi goi 1énh, man hinh xuét hién hop thoai:
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Distance frorm a point to a plane

Hame of the point:

Hame of the plane: |

Hame of the distance:

Help | Cancel |

bién tén cua diém vao 6 so6 (1)

Dién tén ctia méat phang vao 6 s6 (2)

Dién tén dé hién thi khoang cach vao 6 s (3)

a han enter.

¢
.

5.5.4) Tinh dién tich cua mot tan( gidc: gq«zate >Numeric >

Geometric measurement > Area of a triangle:
* Lénh nay cho phép ta tinh dién tich cua 1 tam glag da du:ng, két qua ctia phép

do c6 thé dugc st dung nhu 1 bién trong cac tinh toan vé sau. Sau khi goi lénh,

man hinh xuét hién hop thoai:

A

¥

Area of a triangle

Hame of the triangle:

Hame of the area:

=
[ ﬂ
@

Help | Cancel |

Ok |

Dién tén cua tam giac vao 0 s0 (1)
Dién tén cu\a dién tich tam giac vao 6 so

a han enter.

2)

5.5.5) Tinh dién tich ciia mét da gidc 16i: Create >Numeric >

Geometric measurement > Area of a convex polygon:
\\) A 4 2 7 /‘\ . /( 1 /( 2 2. 4
* Lénh nay cho phép ta tinh dién tich cta 1 da giac 161 bat ki. Két qua ctuia phép

‘do co thé duoc st dung nhu 1 bién so trong cac tinh todn vé sau. Sau khi goi I¢nh,

man hinh xuét hién hop thoai:

Area of a convex solid

Hame of the convex solid:

Hame of the area:

“J

Help | Cancel |
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Pién tén cua da giac vao 6 sd (1)
Pién tén cta dién tich vao 6 s6 (2)
a han enter.
5.5.6) Tinh thé tich ciia mot vit thé: Create >Numeric >
Geometric measurement > Volume of a solid:
* Lénh nay cho phep ta tinh thé tich ctia 1 vat thé, két qua ctia phép do c6\the sﬁ\

dung nhu 1 bién s6 trong cic tinh toan vé sau. Sau khi goi 1énh, man hmh Xuat

hién hop thoai:

Wolurme of a salid

Hame of the solid: nj

Hame of the volume:
3

\J

Help | Cancel |

Pién tén cua vat thé (khdi cau, khdi da. dlgn) vao 6 s (1)
Dién tén cta thé tich vao 0 s0(2)
a han enter. AN
5.5.7) Tinh sé do ciia géc hinh hoc: Create >Numeric
/
>Geometric measurement > .Geometric angle:
* Lénh nay cho phép ta tinh sd/do cua 1 goc hinh hoc, két qua ctia phép do ¢ thé
duogc st dung nhu 1 bién trong cac tinh toan vé sau. Sau khi goi Iénh, man hinh
xuét hién hop thoai:
\ A\
Gearnetric angle [we3m]
Angle unit: lm

Angle (3 pts): | (1) _ﬂ
@

Hame of the measurement:

: Help Cancel Ok

Chon don vi do ¢ 6 “Angle unit” (d0 hoac radian)
: Dién tén cta 3 diém vao 6 s6 (2). Vi du ABC dé tich s6 do goc B.

\) Dién tén cta phép do goc vao 6 (3)
a han enter.
5.6) Phép tinh dai s6: Create >Numeric >Algebraic calculation
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* Lénh nay cho phép ta tinh toan 1 biéu thirc dai sd, két qua cta phép tinh dugc

dung nhu 1 bién sb trong cac tinh toan vé sau. Sau khi goi 1énh, man hinh xuét

hién hop thoai:

Algebraic calculation

Expres=sion of the calculation
ﬁp (1)

EIR
‘Ha.me of the calculation: {2]

Help | Cancel |

Ok

ErE R == E

||unv

vafiable function: ONN\

* Lénh nay cho phép ta tao ham s 3 1 bién s6 thuc. Sau khi goi 1énh, man hinh

xuat hién hop thoai:

function:

\

Pién tén cta phép tinh vao 6 so (2). Enter:
, N\
5.7) Tao ham so: Create > Numeric >F tgtction:

5.7.1) Tao ham mét bién: Create > Numeric >Function >1-

1-wariable function %]
Hame of the variable: | 1 |
Expres=sion of the function: R
(2) B
Hame of the function: {3]
Help | Can-::EI| Ok |
\ L |La [ o || 2 ][22 IR

M
bién tén cua bién s6 vao 6 so6 (1)
Dién bi€u thirc ctia ham s6 vao 0 s6 (2)
bién tén ctia ham s6 vao 6 so6 (3)

a han enter.

s A « R , A ’ ’ \ A A ’ B .
bién bicu thirc can tinh toan vao 6 so6 (1). Vi du: a®2-3a+2; sin(a) +
3cos(a);

norm(vec(u))+vec(u)§vec(v);....

5.7.2) Tao ham 2 bién: Create > Numeric >Function >2-vafiable
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* Lénh nay cho phép ta tao ham s6 2 bién sd thuc. Sau khi goi 1énh, man hinh

xudt hién hop thoai:

2-wariables function [z

Local wvariable 1:
Local wvariahle 2: {2] J >\E
R I\ \

Expression of the function: /X ;\
3) ANV
Hame of the function: {4]
Help | Cﬂm::EI| Ok | P
B AN EEEEEE N

Pién tén ctia bién thir nhat vao 6 s6 (1)

Pién tén cua bién thir hai vao 6 s6 (2) Y

Dién biéu thirc ctia ham sd vao 6 s6.(3)

Dién tén ctia ham sb vao 6 s6 (4) N\

a han enter. N

5.7.3) Tao ham 3 bién: Create > Numeric >Function >3-vafiable

function: A o\
* Lénh nay cho phép ta tao ham : 3'bién sb thuc. Sau khi goi 1énh, man hinh

xuét hién hop thoai:

I-wvariables function [e3m]

Local wvariable 1: | {1
Local wvariabhle 2: {2]
Local wvariahle 3: {3] R

Expres=zion of the function:

(4)
( \ Hame of the function:| (D)
Help | Cancel | ok |
QN Lz v sl o L2 {58 2123
N\ Dién tén cta bién thir nhat vao 6 sb (1)

Dién tén cta bién thr hai vao 6 s (2)
Dién tén cta bién thir ba vao 6 sd (3)
Dién biéu thirc cua ham s vao 6 sb (4)
Dién tén ctia ham sb vao 6 s (5)
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a han enter.

5.7.4) Ham so cho béi bing gid tri: Create > Numeric >Function

>Function defined by values:

* Lénh nay cho phép ta tao ham s6 cho boi bang gia tri. Sau khi goi 1énh, man

hinh xuét hién hop thoai:

| Function defined by walues
Edit

Mame of the function | {1]

[ "With interpalation

(2)

Help |

o [ ]S

Cancel |

Ok ‘

Antecedent  Image

| (3)

Add

(4)

Antecedents Images

Dién tén ctia hams6 vao 6 s0 (1)

1

AN\
SO

\

Pién tao anh vaanh vao 6 sd (3). Chua ¥ cach nhau béi mot khoang
tring. Clio@lﬁt Add, gia tri vira nhap s€ duoc chén vao bang (4)
Lap le,\1i cac thao tac cho dén khi nhap hét cac gia tri can nhap.

a han enter.

. 5.8) D@) s6 khong hoi quy : Non-recurrent sequence:

Mon-recurrent sequence @
Index of the first term: {1]

( \ Expres=sion of the term with index n: ElR
| (2) |

Hame of the segquence:

(3)

Help Cancel

Ok

= v |l feo [ 2 |[2 02032 ]RA

bién chi s6 cua s6 hang dau tién cuia day vao 6 so (1).
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Pién biéu thirc cua sb hang thir n cia diy vao 6 s6 (2).
Dién tén cta diy s6 vao 6 s6 (3). Vi du : u... Cha ¥ : ta viét u(n) dé
chi ra d6 1a s hang thir n cta diy s u
a han enter.
5.9) Diiy so héi quy bdc 1: Non-recurrent sequence of order 1:
* Lénh nay cho phép ta tao 1 ddy s6 hoi quy bac 1. Sau khi goi 1énh, méﬁjhinh’/ \

xudt hién hop thoai:

Recurrent sequence of order 1 [E3m]

Index of the first term: | {1] ¢

Yalue of the first term:| {2]
Expression of the term with index n: ﬂﬂ
| (3)

(4)

Hame of the =eguence:

Help Cancel Ok

I | T | T |

Dién chi s6 cua sb6 hang dau tién cua diy vao 6 sb (1)

Dién gia tri cta sb hang dau tién cta diy vao 6 s6 (2)

Dién biéu thirc cua s\' ang thtr n cia diy vao 6 s6 (3)

Pién tén ctia diy sb vao 6 sd (4).

a han enter. 4

5.10) Diy 56 hoi quy bic 2: Non-recurrent sequence of order 2:
* Lénh nay cho phép t&\&ao 1 day s hoi quy bac 2. Sau khi goi 1énh, man hinh

xuét hién hop thoai:

Recurrent sequence of order 2 ==
7 Index of the first term: | {1] |
3
Yalue of the first term: | {2]
‘ Yalue of the second term:| {3] ElR
A\ Expression of the term with index n:
| @)
k Hame of the =seguence: {5]
Help Cancel Ok
E3| =S| | =B e e | 2

Dién chi s6 cuia s6 hang dau tién ctia ddy vao 6 s6 (1). Vidu: 1
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Dién gia tri cuia s0 hang dau tién cua day vao 6 so6 (2). Vidu: 1

Dién gia tri ctia s6 hang thr hai ctia diy vao 6 s6 (3). Vi du: 1

bién bi€u thurc ctia s6 hang thtr n cia day vao 6 s6 (4). Vi du: u(n-

1)+u(n-2)

bién tén cua day so vao 6 s6 (3). Vi du: u.

Trong vi du trén ta di tao duoc day s6 ¢6 u=1,u=1,u,=u, 1 +u,., (diy Flﬂam’)\
5-11) Chi sé ciia sé hang thir nhét ciia day: Index of the f rst null

term of a sequence:

* Lénh nay cho phép ta dit lai chi sd ciia s hang thir nhat cia 1 dety sO da tao.

Sau khi goi 1énh, man hinh xuét hién hop thoai:

Y

Index of the first null term of 3 sequence

Hame of the seguence: -

Hame of the index: {2]

5

W

Help | Cancel |

ok |

Pién tén cua diy vao 6 s@@l), (
Dién tén cua cua chi s0'vao 0 so (2)
R 1 A 0O\

4 han enter. )

6) XAY DUNG HE TQA PQ MOI: Create > Coordinate system:
* Lénh nay cho phép ta xay dung lai 1 h¢ truc toa d6 mdi trong khong gian. Sau
khi goi I¢nh, man hinh xuat hién hop thoai:

Coordinate systerm

Origim:

(1)

First wvector: | {2]

Second vector: |

™ Third vector: | {4]

Hame of the coordinate system:

(9)

B3

ﬂ

Help Cancel

Ok

B R E R

|

Dién tén cua diem goc vao 6 so (1).

Dién tén cua véc to co s¢ thr nhat vao 6 s6 (2). Vi du: vec(u),

vec(A,B),...

bién tén cua vécto co so thir hai vao 6 so (3)
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Dién tén cta vécto co sd thit ba vao 6 s (4)
Dién tén cua hé toa dd vao 6 sd (5)
a hén enter.
7) PAT LAI DO DAI PON VI: Create > Length unit:
* Lénh nay cho phép ta dat lai do dai cua don vi khac véi do dai cia don vi trong
hé toa do mac dinh oxyz. Sau khi goi 1€nh, man hinh xuét hién hop thoaﬁ? ’/&

Length unit
Yector: |
Hame of the unit: &
O\
Help | Cﬂm::el| %
Lo [ Jlat o )L 2 ][ ||||:|||| ||um, \
\\3

Dién tén cta vécto don vi vao 6 sd (1)
Dién tén cua don vi vao 6 sb (2) \ \}
a han enter.
8) TAO VECTO: Create > Vep}m; (
8.1) Tao vecto boi bleu thire: Create >Vector > Vector Expression:
* Lénh nay cho phép ta tao 1 Veet} cho boi 1 biéu thic cla cac vecto di tao trudce
do. Sau khi goi 1énh, man hinh xuat hién hop thoai:

Wector expression

Yector expression: | JJ

Hame of the vector:

Help Cancel Dk

L J[a el fao L& )52 {21 IIunv

o

e ?‘ién biéu thirc véc to vao 6 s (1). Biéu thirc & day 1a tong, hiéu cua
cac vecto, tich cua vecto voi 1 s, tich ¢c6 hudng cua hai vecto,. ..
N Pién tén ciia vecto vao 6 s6 (2). Vi du: vec(u),vec(A,B)...
a han enter.
\) 8.2) Tao vecto boi toa dp cua no: Create >Vector > By coordinates:
* Lénh nay cho phép ta tao 1 vecto cho bdi toa d§ ciia nd. Sau khi goi I¢énh, man
hinh xuét hién hop thoai:
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Wector given by its coordinates 5]
X-coordinate: {1]
Y-coordinate: | {2]
ElR
Z-coordinate: | {3]
Hame of the wector: | {4] >\
Help | Cﬂm:el| Ok | fi ’& /
. Y4
L L el o || & ]38 (1212 ]Rns

Dién hoanh d6 cta vecto vao 6 sb (1)
Dién tung do cua vecto vao 6 s6 (2) N
bién cao do cua vecto vao 6 s6 (3) :
Dién tén cua vecto vao 6 sb (4). Vi du: Ve&(u) N\

a han enter.
Chu ¥: Vecto 1a ddi twong khong vé duoc ra man\hu{h n6 chi'dung dé tinh toan
hoic str dung trong cac phép bién hinh, ..

9) TAO VAT THE: Create > §Ohx
9.1) Tao da di¢n 16i: Create > Solid > Convex polyhedron:
9.1.1) Da dt;etky& voi cac dinh cho truoc: Create > Solid >

Convex polyhedron > By vertices:
* Lénh nay cho phép ta tao 1 lghéi da dién 16i tir cac dinh ctia da dung cua né. Sau
khi goi I€nh, man hinh xuat 1\1ién hop thoai:

%
Convex polyhedran 5]

||List of the vertices {3 to 40):
W (1) R
\ ‘Ha.me of the polyhedron: ]2]

r \ Help | Cﬂm::EI| Ok |

by

Dién danh sach cac dinh vao 6 s6 (1). Téi thiéu 1a 3 va téi da 1a 40
AN dinh.
\ Chu ¥: 3 dinh dau tién trong cach ghi trén s& xac dinh mat phang chinh khi ta
khai trién hinh da dién.

Dién tén cta da dién vao 6 sd (2)

a han enter.
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9.1.2) Dung phén giao ciia mét khoi da dién véi mét nira
khong gian: Create>Solid> Convex polyhedron > Intersection polyhedron/half-
space:

* Lénh nay cho phép ta dung 1 khdi da dién 13 phan giao cua 1 khdi da dién da
dung vé6i 1 nira khong gian xac dinh boi 1 mit phang va 1 diém thudc nira khong

gian do. Sau khi goi 1énh, man hinh xuat hién hdp thoai: N \
- &
Intersection polyhedronfhalf-space [25]
Boarding plane: {1}

Point in the half-space:

R
Hame of the polyhedron: {3] J -
Hame of the intersection: {4]

Help Cancel Ok

Pién tén ctia mat phang giéi han cua nira @ong gian vao 6 s6 (1)

Pién tén ciia diém bat ki (da du’ng) thuoc\nufa khong gian vao 6 s6 (2)
Dién tén cua khdi da dién {yaq 6:sb (3)
Dién tén cua phan giao vao 0's0 (4)
a han enter. b )
9.1.3) Dung phan giao ciia hai khéi da dién: Create > Solid >
Convex polyhedron > Intersectwn of 2 polyhedrons:
* Lénh nay cho phep ta du:ng 1 khéi da dién 13 phan giao cua hai khi da dién 16i

da dung. Sau khi got lénh, man hinh xuét hién hop thoai:

Intersection of two polyhedrons (3]

Fir=t polyhedron: | {1] |
Second polyhedron: | IEI B
( \\\ Hame of the intersectiun:| {3]

Help | Can-::el| Ok |

\ Dién tén cua khoi da dién tht nhat vao 6 s (1)
Dién tén cua khoi da dién tht hai vao 6 s6 (2)
Dién tén ctia phan giao vao 6 sb (3)
a han enter.
9.1.4) Dung dnh cia mét khoi da dién: Create > Solid >
Convex polyhedron > Image of a polyhedron:
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* Lénh nay cho phép ta dung 1 khoi da dién 13 anh cta 1 khéi da dién 16i 43 dung

qua 1 phép bién hinh di tao trude do. Sau khi goi I¢nh, man hinh xuét hién hop

thoai:

Irmage of a polyhedran (2%

Polyvyhedron {(to bhe tranzformed): | {1 |

Hame of the transformatiomn: {2] B /\ \

e Y 4

Image polyhedron : {3]

Help | Cancel | Ok |
A A . A A ) A A ¢
bién tén cua khoi da dién (tao anh) vao 6 so6 (1). ~

Dién tén cuia phép bién hinh vao 6 so (2)

Dién tén cua khoi da dién anh vao 6 so (3\2

, >
a han enter.
9.1.5) Dung khéi ling tru déu: \\Create > Solid > Convex
polyhedron > Regular prism:
* Lénh nay cho phép ta dung 1 khoi lé(hg try déu véi truc, chiéu cao va 1 dinh cua

no. Sau khi goi 1énh, man hinh XUAt hién hop thoai:

Regular prism ==
Hame of the axis: {1] |
Height: | (2)
Hame of a vertex of the basi=s: lEI ﬂ
Hunber of edges (3 to 40): | (4)
Hame of the prism: {5}
Help Cancel Ok
§ B3 F= | e =l D e | 2
Dién tén truc cua khbi lang try vao 6 $6 (1). Truc duoc xac dinh baéi 2
diém hodc 1a truc toa do.
' A . A ) A+ 1w \ A K A , X1y A
\ bién chiéu cao cua khoi lang try vao 6 so (2). Chiéu cao c6 thé la so
\\ hodac 1a mot phép do nao do.

bién tén cua dinh dau tién ciia mat day vao 6 so6 (3)
bién s6 canh vao 6 so6 (4) (tir 3 dén 40)
Dién tén cua khoi lang tru vao 6 so (5). 4 han enter.

Chu y: Lang try doc dung tuan theo quy tic “ban tay phai”
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9.1.6) Dung khéi chép déu: Create > Solid > Convex
polyhedron > Regular pyramid:
* Lénh nay cho phép ta dung dugc khdi chop déu voi truc, chibu cao va 1 dinh
cua mat day. Sau khi goi 1€énh, man hinh xuét hién hop thoai:

Regular pyramid ==
Hame of the axis: {1] | K\ \
Height: | (2) ( ’
Hame of a vertex of the basi=s: {3] ﬂ
Hunber of edges (3 to 40): | (4) P
Hame of the pyramid: {5]
Help Cancel Ok
B3| 0 T | =l R |

Dién tén truc cta khdi chop vao 6 sb (1)

Dién chiéu cao ctia khdi chop vao 6 sb (23

Dién tén ciia mot dinh cﬁa(’\mef?t day vao 6 s6 (3)

bién so6 canh cua da giac day vao 6 so (4)

Dién tén cua khéi éhg’)}y va0 0'sb (5).

a han enter.

9.1.7) Dung bao hinh 16i ciia cdc diém, da gidc, cdc khoi da

dién: Create > Solid > Convex polyhedron > Convex hull:
* Lénh nay cho phép ta du‘n\g 1 khéi da dién 1a bao hinh 16i cua cac diém, da giac,
khéi da dién da dung. §au khi goi 1énh, man hinh xuét hién hop thoai:

Polyhedral conwvex hull (3w
List of the points olygons or polyhedrons:
/ | (1) R
N !
‘Ha.me of the polyhedron: {2]
Help Cancel Ok
3\

bién danh sach cac diém, da giac hodc da di¢n vao 6 so (1)
bién tén cua da dién can dung vao 6 so (2).
a han enter.

9.2) Dung khoi ciu: Create > Solid > Convex polyhedron >Sphere:
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* Lénh nay cho phép ta dung 1 khdi cau véi tAm da dung va ban kinh ctia né. Sau
khi goi Iénh, man hinh xuat hién hop thoai:

Sphere defined by center and radius (3]
Hame of the center: | {1] |
Radius: | {2] B
Hame of the sphere: {3] /X ,\
. 4
Help | Cﬂnl::el| Ok |
Le JLe [l o [ 2 ][5 [0 [2-2]RA2
Dién tén cua tdm khoi cau vao 6 sb (1) ) {

bién ban kinh cua khoi cau vao 6 s6 (2)
bién tén cua khoi cau vao 6 s6 (3) \ N\

a han enter.

9.3) Dung mét khoi tru: Create > So@d > Convex polyhedron >
Cylinder:
* Lénh nay cho phép ta dyng 1 khéi qu V{l truc va ban kinh cua n6. Sau khi goi
1énh, man hinh xut hién hop thoai:

Cylinder defined by axis and radius (3w
Axis (=egment): {1] |
Radius: | {2] B
Hame of the cylinder: {3]

‘ Help | Cﬂm::el| Ok |
Lz L et o L2 [ IR ]RA2

Pién tén truc (12 mot doan thiang) vao 6 s6 (1). Vi du AB.
7 Dién ban kinh cta hinh tron day vao 6 s (2)

Pién tén cia khéi tru vao 6 s6 (3)

a han enter.

. 9.4) Dung khoi non: Create > Solid > Convex polyhedron >Cone:

\* Lénh nay cho phép ta dung 1 khdi non véi dinh, tim va ban kinh cta mat day.

Sau khi goi 1énh, man hinh xudt hién hop thoai:
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Cone defined by wertex and basis (3]
Yertex of the cone: | {1] |
Center of the basis: {2]
R
Radius of the hasis:| {3] B
Hame of the cone: {4]
Help Cancel Ok K\ \
~ Y4
B3 F N Y =l

Pién tén cuia dinh khoi nén vao 6 s6 (1)
Dién tdm cta hinh tron day vao 6 s6 (2) =
Dién ban kinh cta dudng tron ddy vao 6 sd/(3)
Dién tén cta khdi nén vao 6 sb (4) \
a han enter.
9.5) Dung mét khoi non cut: Create > S\glid > Convex polyhedron >
Furtum of a cone:
* Lénh nay cho phép ta dung 1 khoi n(én cut vo1 tam va ban kinh cua hai mét day.

Sau khi goi 1énh, man hinh xuét hién hop thoai:

Furstum of cone defined by the radii and centers of the two basis (3w
Center of the basis 1: {1] |
Radius of the hasis 1:| {2]
Center of the hasis 2: {3] R
Radius of the basis 2:| {4]
Hame of the frustum of cone: {5}
Help Cancel Ok
I | S P = |
f \ 14
Dién tdm cua hinh tron nho vao 6 so (1)
Pién ba kinh ctia hinh tron nhé vao 6 s6 (2)
' A A ; \ \ , \ A A
\ bién tam cua hinh tron 16n vao 6 s6 (3)

Dién ban kinh cta hinh tron 16n vao 6 sd (4)
Dién tén cta khdi ndn cut vao 6 sd (5). 4 han enter.
9.6) Dung hinh khai trién ciia mét khéi da dién: Create > Solid >

Convex polyhedron > Development of a polyhedron:
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* Lénh nay cho phép ta duyng hinh khai trién ctia 1 hinh da dién d4 dung. Sau khi

go1 1énh, man hinh xudt hién hop thoai:

Developrment of a polyhedron ==
Hame of the polyhedron: | {1] |
Opening coefficient (0 to 1): | {2] ﬂ >\E
Hame of the development: {3] /X f\
. Y 4
Help Cancel Ok
ARNMBEEEEE

Pé dyng hinh khai trién ctia mot khéi da dién ta chn cé mot he s§ mo
(Opening coefficient) la mot s6 thue thudc doan [0;1]. (xem cach tao bién sb thuc
thudc doan). ‘ ’ ‘ AN S

bién tén cua khoi da di¢n can khai trién vao 6'so (1).

Dién tén cta hé s mé (di tao) vao 6. SQ\ (2). 4 han enter. Dung céc

phim mili tén dé diéu khién su d6ng/mad cia hinh khai trién.
* Chu y: Trong cach dung khéi da dlq(n taoboi cac dinh cho trude, thi 3 dinh dau
tién s€ xac dinh mat phang chinh khi khai trién hinh da dién. Vi du: khi dung ti
dién P1 tao béi cac dinh BCDf{' @hinh khai trién c6 dang nhu sau:

A

. 10) HIEN THI: Create >Display:
\) 10.1) Hién thi mot bién so dang ton tai: Create >Display >Existing
numeric variable:
* Lénh nay cho phép ta hién thi 1én man hinh 1 bién s6 dang ton tai. Sau khi goi

1énh, man hinh xut hién hop thoai:
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Display of the value of an existing numeric variable (3w

Hame of the numeric wvariahle: {1]

Humber of decimal places (0 to &) :| {2] B

Hame of the display: Afl {3]
Help Cancel Ok

[N
Y 4 4 Y 7 4 C /

bién so cac chir s0 trong phan thap phan cua bién vao 6 s6 (2)

O s6 (3) dé mac dinh.

a han enter. ~

10.2) Hién thi dé dai ciia mét doan thang: Create >Display >

: \ N>
* Lénh nay cho phép ta cho phép ta hién thi d¢ dai cua 1 doan thang 1én man

Pién tén ctia bién (dang ton tai) vao 6 s (1).

e

Length of a segment:

hinh. Sau khi goi 1énh, man hinh xuét hién hop thoai:. !

Display of the length of a seqrment 23]

Hame of the segment: | l”

Humber of decimal places {0 to 6) :| {2] R

Hame of the display: AfD {3]
Help Cancel Ok

Dién tén cta doan thang (2 diém) vao 6 s (1).

Dién s6.cac chit s6 trong phan thap phan cia bién vao 6 s6 (2)

O 56 (3) dé mic dinh.

a han enter.

10.3) Hién thj toa dp ciia mét diém: Create >Display >Coordinates
of a point:.
* Lénh nay cho phép ta hién thi toa do cua 1 diém da dung 1€n man hinh. Sau khi

goi 1énh, man hinh xudt hién hop thoai:
i

A Display of the coordinates of a point 23w
WS Hame of the point: | {1] |
Humber of decimal places {0 to &) :| {2] B
Hame of the display: Af0 {3]
Help Cancel Ok
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bién tén cua diém vao 6 so (1).

bién so cac chir s0 trong phan thap phan cua bién vao 6 so (2)

O s6 (3) dé mac dinh.

a han enter.

10.4) Hién thi phwong trinh ciia mét mdt phéing: Create >Display >

Equation of a plane:

'\

2 . s \ O\ V7
* Lénh nay cho phép ta hién thi phuong trinh tong quat cia 1 mat phang da dung

lén man hinh. Sau khi goi Iénh, man hinh xuét hién hop thoai:

Display of an equation of a plane

Hame of the plane:

X

@ ]

Humber of decimal places {0 to 6) :|

Hame of the di=play:

(2)

ﬂ

Help Cancel

Ok

Dién tén ctia mat phang vao 6's6 (1).

Dién s6 cac chir so trong Q'hén thap phan cta bién vao 6 s0 (2)
\IL

O s6 (3) dé mac dinh,
2 1 A e\
a han enter. Q “

10.5) Hién thi vin ban: Create >Display >Text:
* Lénh nay cho phép ta hién ;hi 1 cau cha thich 1én man hinh. Ta chi c¢6 thé cho

hién thi cau véi tiéng Viét khong dau. Sau khi goi 1énh, man hinh xuét hién hop

thoai:
Display of a text @
Text to display:
| (1) E[R
g \ ‘ Hame of the display: [Af0 {2]
»
Help | Cﬂm::EI| Ok |
TR\ R | T | | e |
\ Pién van ban can hién thi vao 6 s (1).
O s6 (2) dé mac dinh.

a han enter.
11) TAO LENH: Create >Command >

@f@/ Tharn Man - THTC Nyi Gia T Go L, Tag N
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11.1) Tao Iénh dung hinh theo khéi: Create >Command >Whole-
drawing:
* Lénh nay cho phép ta tao 1 1€nh dé an/ hién 1 hinh da dung béng cach nhan
phim. Sau khi go1 I¢énh, man hinh Xuét hién hop thoai:

Corntmand forwhole-drawing @ > \}
-Separate the names by spaces- /i ;\\ J

ODbhjects to modify:

| (1)
by pres=sing the key: IT ﬂ

Hame of the command: Cm0 {3] (\ {
Help | Cﬂm::el| Ok | )

Dién tén cac dbi tugng s& dugc diéu khiéhxvéo 0 ééj\)(l).
Dién phim diéu khién vao 6 s6 (2) (khong phan bigt chit hoa/thuong)

O s6 (3) dé mic dinh, \)

a han enter. A

11.2) Tao lénh dung hinh th\l{g budoc: Create >Command > Step-
drawing: BN

* Lénh nay cho phép ta tao 1 1énh hién thi timg budc dung ciia 1 hinh di dung

béng cach nhan phim. Sau khi goil¢nh, man hinh xudt hién hop thoai:

Caormtmand for step by step drawing (3]

-Separate the names by spaces-
3

Objects to modify:

| (1)
\ by pressing the key: IT R
Hame of the command: lm]

Help | Cﬂm::el| Ok |

\
¢ \

Dién tén cac ddi tuong s& duoc dicu khién vao 6 s6 (1).
W Dién phim diéu khién vao 6 sé (2) (khong phéan biét chit hoa/thuong)
O s6 (3) dé miac dinh.
a han enter.
11.3) Tao Iénh tao vét: Create >Command >Trace:
* Lénh nay cho phép ta tao 1énh tao vét cho cac dbi tugng bang cach nhan phim.
Sau khi goi 1énh, man hinh xuét hién hop thoai:
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Command for entering in trace mode ==

-Separate the names by spaces-

Ohjects whose trace will bhe drawn:

H (1)
EKey for entering into the mode: 12' =
Hame of the command: le]{3] |

)
AN\
SO

Help Cancel Ok \

bién tén cac doi tuong can tao vét vao 6 so (1)

Dién phim diéu khién vao ché d tao vét vao 6 s6(2) -
O s6 (3) d mic dinh. O
a han enter.

4 b v \ ™
11.4) Tao lénh tao vét theo yéu ciu: éwate >Command > Trace-

A

demand: \
* Lénh nay cho phép ta tao 1 1énh tao vét theo ygl%\élu cho cac d6i twong bang
cich nhan phim. Sau khi goi Iénh, mz‘}mhinh xuét hién hop thoai:

Comtmand for entering in trace-dermand mode @

-Yuu will use BRETURH to keep a trac:e-

Ohject=s whose trace will bhe drawn:

H (1)
Key for entering into the mode: {2] R
Hame of the command: le]{3]

Help Cancel Ok

Dién {én cac dbi tuong can tao vét vao 6 s6 (1)
Dién phim di€u khién vao ché dd tao vét vao 6 so (2)
- g)\s?) (3) dé mic dinh.
a han enter.
N 11.5) Tao lénh thoat khoi ché do tao vét: Create >Command >
| bx}ting trace mode:
\\\ * Lénh nay cho phép ta tao I¢énh thoat khoi ché d6 tao vét. Sau khi goi 1énh, man
hinh xuét hién hop thoai:
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Caormmand for exiting trace mode

by pressing the key: | {1] J

Hame of the command: le]{2

Help | Cancel |

Dién phim diéu khién thoat khoi ché d¢ tao vét vao 656 (1).

O sb (2) dé mic dinh. ANWA

a han enter.

11.6) Tao lénh chon doi twong dang diéu khién bang ban phim:
Create > Command > Selection for piloting whith keyboard: . (
* Lénh nay cho phép ta tao 1énh Iyra chon ddi twong dé diéu khién bang ban phim
bﬁng cach nhan phim. Sau khi goi I¢nh, man hinh xué{ hién hgpthoai:

Command for selection of piloting with the keyhoard (3w

Hame of the free ohject to pilot

H (1)
by pressing the key: IT B
Hame of the command: IW{S]

Help Cancel Ok

Dién tén cua doi tugng can dicu khién (thuong la cac bién so tu do)

vao 656 (1)

Dién phim diéu kﬁién vao 656 (2)
O s6 (3) dé méc\\dinh.

a han enterﬁ\

Y nghia: Gid st ta c6 nhiéu bién sb tu do can thay doi gia trj bang ban
phim,; do m&i lan chi diéu khién dugc duy nhét 1 bién nén ta phai tao cac phim dé
hj’,a chon déi\f\ugng can diéu khién. Vi du: cac bién a, b lan luot gan cho cac phim
A,B. Khi mudn thay d6i gi4 tri bién nao thi ta chi viéc nhan phim tuong tng roi
‘diing phim miii tén dé diéu khién.

\ 11.7) Tao lénh sw dung sw tinh todan: Create >Command > Derect
\ affectations:
* Lénh nay cho phép gan vi tri cho mdt diém tu do, truyén cho bién tu do mét gia

trj cu thé hay két qua cta su tinh toan nao d6. Cé thé thirc hién cung luc cho
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nhiéu d6i tuong, cac doi tuong cach nhau boi khoang tréng. Sau khi goi 1énh,

man hinh xuét hién hop thoai:

Command for direct affectations

-Separate the names by spaces-

Free ohjects: !\ )\\
I (1) \ CS ’

given positions or values
| (2)

hy pressing the key: {3] e
Hame of the command: le]{d-] (\

Help | Cﬂm::EI| Ok |

3

L= |l [l o L2 [ (R0 E-2]EA2

Dién cac doi tuong tu do can tac déngwﬁé sO (1)
bién tén diém, gid tri hodc biéu thirc tinh toan tuong Ung vao 0 so

N
(2)- B\VA\Q
Dién tén phim diéu khién vao'6 s6 (3)

a han Enter. I \S\

11.8) Tao I¢nh tao sw thay déi ngdu nhién: Create > Command >
Random affectations: P
* Lénh nay cho phep ta tao kenh dé thay d6i gia tri ctia 1 bién tir do trong 1 doan,

thay doi vi tri cua dl?\% tu do thudc doan, trén duong trom,... bang cach nhan

phim.
) : Caormrmand for randorn affectations (3]
\ -Separate the name=s by spaces-
\
K \y Objects to by randomely affected:
W (1)
~ by pressing the key: {2] B
{
N\ \ Hame of the command: Cmi0 {3]
“ Help | Cﬂm::EI| Ok |

Dién tén cua cac doi tugng can di€u khién vao 6 s6 (1). Cac doi
tuong thuong 1a bién, di€ém tu do,...

Dién tén cua phim diéu khién vao 6 s6 (2)
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O s6 (3) dé mac dinh.

a han enter.

MBOi 1an nhan phim diéu khién thi ta dugc mot gia tri hoidc vi tri nhau nhién

cua bién hoac di€ém.

11.9) Tao Iénh sir dung bién nhé: Create > Command > Memorieds >§

affectations:

AN
N

(N

* Lénh nay cho phép ta tao 1énh dé tra bién tu vé gid tri cta no tai thoi diém tao

1énh béng cach nhin phim. Sau khi goi Iénh, man hinh Xuat hién hop thoai:

Command for memorised affectations

X3

ODbhjects whose present value will be zaved:

[ (1)

then given back by pressing the key:

Hame of the command:

(2)
Cm0(3)

Help Cancel

Ok

¢

A

bién tén cac doi tugng can nh& gia tri hodc vi tri cia n6 ¢ thoi diém

hién tai vao 6 s6 (1(),( W\
Dién tén phim diéu khién vao 6 sb (2).
O s6 (3) dé mic dinh.

a han enter. 4

Lénh nay cho phép tra cac ddi tuong da chon vé vi tri hodc céac gia tri da

nhé khi nhén phim diéu khién,

11.10) Tao I¢nh thay doi cich nhin hinh: Create >Command >

Change of view:

‘ 3\)\ 11.10.1) Tao Iénh thay doi cich nhin hinh béi sw ghi nhé

cdch nhin hién thoi: Create >Command >Change of view >By memory:

¥ L\énh nay cho phép ta tao 1énh dé tra vé cach nhin hinh tai thoi diém tao 1énh

X :bé“mg cach nhan phim. Sau khi goi 1énh, man hinh xuat hién hop thoai:

\)

@f@wyén Chanh cNhan - Wf% fV é C@a T, C@ D, %cw// o Ninh

105



fm HUG4 G DA4 SU DU4 G PHAA MEM GEOSPACE 2003

Cornrmand far saving a wiew

EX3

Hame of the command:

then given back by pressing the key: i”

R
Cmd

Help Cancel

Ok

bién phim di€u khién vao 6 so6 (1).

O s6 (2) dé mac dinh.

a han enter.

C LA s T N\ N .,
Lénh nay cho phép ghi nh¢ cach nhin hién tai, khi ta xoay hinh ¢ cac vi tri

dé quan sat, néu muon tré lai cach nhin da nh¢ ta chi viéc nhan phim da thiét dat.

11.10.2) Tao lénh thay doi cdciknhin Qinh theo mot mat

phéng chinh di¢n: Create >Command >Change of view >By choice of a front

plane:

* Lénh nay cho phép ta tao 1énh thay ddi cach nh1n hién thoi vé cach nhin hinh
theo mot mat phang chinh dién bang %chﬁhan phim. Sau khi goi 1énh, man hinh

xuat hién hop thoai:

W

Cormand for a frant plane

Hame of the plane: | {1]

Humber of =tep=s {1 to 50):

by pressing the key: |

Hame of the command:

2) ﬂ

Help Cancel

Ok

Dién tén ctia mat phang can nhin vao 6 so (1)

’ Pién s6 cac budc xoay hinh vao 6 s (2) (tir 1 dén 50)

S “ A « R \ A A
Dién tén cua phim diéu khién vao 6 so6 (3)

O s6 (4) dé mac dinh.

a han enter.

) 11.10.3) Tao I¢nh thay déi cdch nhin hinh theo mét phép
quay twong doi: Create >Command >Change of view >By relative rotation:
* Lénh nay cho phép ta tao 1énh xoay hinh theo 1 phép quay twong dbi, véi truc

quay 1a duong thiang di qua gdc toa 6 va co vécto chi phuong tao boi 2 diém

@ Vyayin Thanh M - THIT Nyi Gia T, G D, Ty Vi
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thudc hinh v&. Chiéu quay ctia hinh theo quy tic “ban tay phai”. Sau khi goi 1énh,

man hinh xuét hién hop thoai:

Commmand for relative rotation of the picture (3w
hngle I.mit.rI kﬂdiﬂn -

hxial wector: {2] | > \
Angle: | {3] /K ’\

_ |— R ~\ \7
by pressing the key: {4
Hame of the command: Cmﬂis]

Help Cancel Ok | &
(N

L L Jlal Jhao L2 )52 (R0 [R-2] 202

Chon don vi doéésé(l) N\
Dién vécto truc vao 6 sd (2). Vecto truc ¢o thé 1a vecto cua hinh v&.
Pién goc quay vao 6 s6 (3) . \\
bién phim di€u khién vao 6 so6 (4)
O s6 (5) dé mac dinh.
a han enter.

Khi ta tao xong I¢nh nay thi ﬁ’l@b lan nhan phim diéu khién thi hé truc s& quay

h

quanh truc quay da chon.

11.10.4) Tao Iénh thay déi cdch nhin hinh theo mét phép
quay tuyét doi: Create >Command >Change of view >By absolute rotation:
* Lénh nay cho phep tQ tao lenh xoay hinh theo 1 phép quay tuyét doi, voi truc
quay 1a duong thang di qua gdc toa do voi vécto chi phuong c6 toa do ¢ dinh

bang cach nhan phim. Sau khi goi 1énh, man hinh xudt hién hop thoai:
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Cormand for absolute rotation of the picture (3]
_Cuurdinates of the axial wector:
Angle unit:
X-coordinate (+ forwards): | {2] |
¥-coordinate {(+ to right}:| {3] j\“\
Z-coordinate {+ upwards): | {4] fli )\\ u/l
E| BR|| |
Angle: | {5] \ o /
by pressing the key:
Hame of the command: Cmi {?] p
Help Cancel Ok .
L= |l el o 12 [Z 1522

Chon don vi do goc & 6 s6 (1)

Dién hoanh d6 ctia vecto vao 6 s6 (2) §\ \
Dién tung d¢ cta vecto vao 6's6 (3) \
Dién cao do cua vecto Vé@ﬁ s0 (4)

Pién s6 do goc quay vao ”msé) %

Pién tén phim diélﬂ@%@ vao 6 sb (6)

O s6 7 dé mic dinh. :

a han enter.

¢z
11.11) Tao lIénh lap: Create >Command >Iterative creation:

Cornrmand for iterative creation 53]

Objects to reproduce: W_
1 hntecedents to replace:| {2]
y\\ respectively by: | (3) R
by pressing the key: IT
Hame of the command: CmbD

Help Cancel Ok

bién tén cua cac do1 tuong can sao chép vao 6 so (1)

Pién tén ctia cac ddi tuong trude khi thay thé vao 6 s6 (2)
Pién cic ddi tugng thay thé theo thir tu boi vao 6 s6 (2)

Dién tén phim diéu khién lip vao 6 s (3)
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O s6 (4) dé miac dinh.
a han enter.
11.12) Tao lénh lip mét hodc nhiéu ciu tricc lgnh: Create >
Command > Command repetition:
* Lénh nay cho phép ta tao 1énh dé lap 1 hodc nhiéu cau tric 1énh véi s6 1an lap )\
tuy chon béng cach nhin phim. Sau khi goi I¢énh, man hinh xuat hién h@p’}hoai’}\

Caormrmand far repetition of same cammand(s) [e3m]
Commands to repeat:
W (1)
Maximum number of times: | {2]
Minimum delay {50 to 60000 :ms}:| {3] £
hy pressing the key: {4]
Hame of the command: Cmﬂ{ﬁ]
Help Cancel Ok
[w |la el e [ 3 12 RNE= R

Dién céc 1énh can lap vao 656 (1)
Dién s6 lan 1dp t6i da vao 6/s6'(2)
Dién thoi gian trd gi{’g cac lan lap vao 6 s6 (3) (tir 50 ms dén 60.000
ms)
Pién tén phim diéu khién vao 6 sb (4)
O s6 (5).dé mac dinh.
a han enter,"
11.13) Tao lénh tao bing cdc gid tri (ciia ham sé): Create >
Command >Table of values:
p \

Dy
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Cornrmand for showing an array of walues 25

VYariables {(pilot first) and decimal places {0 to 6):

W (1)

Initial value of the pilot: | (2)

\

Step for piloting: | {3] El R \ > )
o |5 NN

Humber of rows: | {4] [(S /\

by pressing the key: {5]

Hame of the command: CmD0 {ﬁ]

Help Cancel Ok
3 S 1N R = T

Dién tén bién véi sd cac chir sb sau phén@ép phan vao 6 s6 (1) theo
cu phap (n,1) (x,5),...
Dién gi4 tri ban dau cua bién vao 6 s bﬁ
Dién s6 budc nhay vao 6 s6(3)
Dién s6 dong cua bang va \%(4)
bién tén cua phim em\khlen vao 6 56 (5)
O s6 (6) dé miac dinh.
a han enter.
Vi du: can l1ap bang gia tri cua ham $6 y=x2+2, Vo1 gia tri ban dau cua x 1a -1.41,
cac gia tri cua x cach nhau 2 don vi, bang gdm c6 5 dong. Ta thuc hién nhu sau:
- Tao bién sb thuc tu dQQa (Create >a umeric >Free real variable)
- Tinh gi4 tri cua bleu thirc t=a’+2. (Create >a umeric >Algebraic calculatlon)
- Dung Iénh tao bang 6 s6 (1) dién (a,2) (t,3). O sb (2) dién -1,41. 6 s6 (3) dién 2.
O(SO (4) dlen\(S) O s6 (5) dién B. a han enter.
Khi nhan ph1m B, s€ hién bang gia tri nhu sau:
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n_| Figure Géasp.., O ﬂ
Copy the table  Option
a t

-1,41
o,59 =,348
2,59 8,708

4,59 | 23,068 fli )\\

6,59 | 45,428 \(\ &

11.14) Tao lénh tao phép chiéu xién:

Command for ablique projection (3]

-‘ur a unit vector, orthogonal to the sc:reen:_
¥-coordinate of the projection (-2 to 2): | {1]

Y-coordinate of the projection (-2 to 2} :| {2]

EIR
by pressing the key: {3]
Hame of the command: le]{l'-”

e v lal Jlao [ ][5 {11 2R
III. CAC LENH KHAC: -
1. Cac I¢énh vé dicu khién: Piloting:

11) Chgn\\@ﬁ'i twong can diéu khién bang ban phim: Piloting >
Piloting with keyéoard:
* Lénh nay cho phép ta chon 1 trong nhiéu bién s6 tu do dé di€u khién bang ban
phim. Sau kl&\)ﬂ goi 1énh, man hinh xuét hién hop thoai:

-
e

| Piloting with keyboard o] x|
0k Cancel | H
p . e e ;
Q\N\ none
\\\ h free real
\ c free real
< | | o

Chon d6i tuong can diéu khién bang cic phim mili tén & hop thoai
nhu hinh bén, click OK.
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1.2) Piéu chinh cdc tham sé cia thao tic diéu khién bang ban
phim: Piloting > Change parameters of piloting with keyboard:

Modify pilating pararmeters @

Can be changed by the keys + or - -

|Step for piloting:|0.1 (1) _QE /K }/\\
Help Cancel Ok

L= L sl ko [ 3 ][5 [IR1E-2]EA2

Khi sir dung ban phim dé thay doi gia tri cia mot bién tu do, ta'can quan tam dén
“pbudc nhay” cua bién (tirc 1a khoang cach gitra hai gia tri lién nhau). Pé thay doi
gia trj ctia “budc nhay” ta co thé st dung 1énh nay. AN Y
Khi hop thoai hi¢n I€n, dién gia tri cua “budc nhay” vao 6 sd (1.4 éu & 6 “Can
be changed by the key + or -” 1 Yes thi ta c6 thé tﬁa%déi gia tri cua budc nhay
bang phim + hodc — ma khong can goi lai Iénh nay.

1.3) Gidi han sy diéu khién: Piloting > Loop the piloting'
Khi ta sir dung 1énh diéu khlenpmot bién tu do trong mot doan, néu mudn khi gla
tri cia bién khi dat dén gia fri ctia bién nay néu tiép tuc diéu khién thi s& trd vé
gia trj ctia bién kia, ta c6 thé str dung 1énh nay.
Vi du: Ta ¢6 bién d 1a bién tw do co gia tri thuoc doan [0;5]. Khi dung cac phim
mili tén dé thay doi gid. tri'cua d, néu d dat gia tri 1én nhat 1a 5 ta tiép tuc diéu

khién nira thi gia tri cﬁﬁ\\bién s€ tr& ve gid tri cua bién dudi 1a 0.

n_ ] Lu:u:upthe pllu:utlng _@ﬂ
\ T 0 k ................ ——
\ | d free real in [0,5]
¢ Y
1| | i

‘Chon dbi twong can diéu khién & hop thoai hién 1én va click OK.

. 1.4) Hiiy bé I¢énh gidi han sw diéu khién bing ban phim: Piloting >

\) Unloop with keyboard:
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= LInIu:u:up the pllu:utlng 0| x|
' Cancel ‘ Help

| d free real in [0,5%] (loop piloting)

« | ]
Pé hity bo 1énh g10’1 han sy diéu khién bang ban phim ta str dung 1énh nay.
Chon dbi twong can hity bo 1énh trong hop thoai, click OK. ”} '\

’
1.5) Gdn gid tri cho mot bién tw do: Piloting > Affect a free

numeric variable:
Khi str dung mot bién tu do, néu mudn gan cho bién mot gia tri ,I{ao’do thi-ta co
thé str dung 1énh nay. Sau khi duoc gan gia tri, bién nay van 1 bién tu do (van co

thé thay doi gié tri cia nd bang ban phim)

3

N
Affect a free numeric wariahle

Hame of the '.raria.hle:- J
R

given value:

| (2)

Help | Cr:m-::el| Ok |

| |uﬂv

L L el Jheo L2 [ Jl00

Dién tén cta bién Vé\(i 656 (1)

Dién gia tri can gan cho bién vao 6 sb (2)

a han Enter.

1.6) Doi m@t dig\m tw do dén mét diém khdc: Piloting > Place a free

Place a free point an a point

[
\ Hame of the point: _ﬂ
2

i to place on the present position of:

Help Cancel Ok

Khi do1 mét diém tu do dén vi tri cia mot diém khac, diém do6 van

point on a point:

con tu do.
bién tén cua diém can doi vao 6 s6 (1)
bién tén cua diém dich can doi dén vao 6 so6 (2)

a han Enter.
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1.7) Pinh vi tri ciia mét diém tw do béi toa dp ciia né: Piloting >
Place a free point by its coordinates:

Place a free paoint by coordinates ==
Hame of the point: | {1] |
X-coordinate: | {2] -
¥-coordinate: | (3) N /K ’\
] . 4
Z-coordinate: | (4)
Help | Cﬂncel| Ok |
L JLE [l o [ 2 )] (032 ]RA2 ~N\

Lénh nay cho phép di chuyén mét diém tir do trong khong gian dén vi tri co
toa d6 xac dinh, sau khi doi dén diém ndy van con tLI\QO.

)
Dién tén diém can di chuyén vao 6:s6 (1) \
Dién hoanh d6 cua vi tri dén cﬁa\diém vao 686 (2).
bién tung dd cua vi tri-dén ciia di€ém vao 0 so (3).
Dién cao do cua vi tgi d;é{ ctia diém vao 6 sb (4).
Click OK.
1.8) Khoi dong/bo 3{@1 dong bién thoi gian: Piloting > Activate
timer (maj T).
1.9) Dinh thoi gian tré giia hai lin doc ciia bién thoi gian: Piloting
> Duration between time reading:

Duration between time readings

In milliseconds {50 to G0000): I]l] J
Help Cancel Ok
e . Dién thoi gian (mili gidy) vao 6 s6 (1). 4 hin Enter
1.10) Nhdp khéu: Piloting > Import
2. Céc 1énh hién thi: Showing:

2.1) Lwa chon doi twong cin tao vét: Showing > Trace selection:

:|Tra|:e selection |EI ﬂ

Ok Cancel ‘

A free point in space
B free point in space

‘| | 2
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Lua chon ddi tuong can tao vét trong hop thoai (mot hodc nhiéu doi
tuong). Click OK.

2.2) Ché dé tao vét (chon-bé chon): Showing > Trace mode (flip-
flop):

Cé thé vao ché do tao vét trén thanh cong cu bang céch click vao nut

| NN

~ /
O ché dd tao vét thi mét sb 1énh khong thuc hién duoc, dong 1€nh

YUE
A

YLIE
b

plan
izale

hodc nut 1énh bi mo di. Xem hinh:
|| @| ol W] > | < []55|00 oo [P T | BB b |5+
2.3) Ché @b tao vét theo yéu cau (chon-bé chon): Showing > Trace-
demand mode (flip-flop): \. 0N
C6 thé vao ché do tao vét theo yéu cau trén thanh c¢éng cu bang cach

]

click vao nut | 22| N

O ché d6 tao vét theo yeu cau, vét khong tu dong duorc tao. Dé tao vét
ta phai nhan Enter. W\

2.4) Mo bdn%r mo ta \tg"t cd cdc doi twong trong bing vé : Piloting >
Reminder (F2) : Phim tat la F2.

2.5) Mo bang chu thich cua ban vé (néu co): Showing > Comments
(F3) : Phim tit F3. ’

Khi stt dung'mot ban v& ciia nguoi khéac ta nén xem bang chu thich
nay dé hiéu rd hon vé §{\;'I6 cua tac gia. Khi v€ hinh ta cling nén tao bang chu
thich nay dé ngudi khac co thé sir dung bang vé (cach tao : Edit > Edit
comments).

( 2.6) Hién thi hodic dn di tén ciia diém : Showing > Display the
names. of the points (maj a )
TN 2.7) Tach tén ciia diém (khi bi che khudt): Showing > Split the
names of the points (maj S).
N 2.8) Hién thi hodc an hé truc toa dj trong khong gian: Showing >
Display Rxyz coordinate system (maj R). C6 thé st dung nit 1énh \i‘ trén thanh

cong cu.

@VM Thanh NMan - THTC Nya Gia T G D, Ty ik “
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2.9) Chon/ bo chon ché do nét vé dam: Showing > Thick Drawing

(flip-flop). C6 thé sir dung nut 1énh @ trén thanh cong cu.
2.10) Phéng to hinh: Showing > Larger (>): C6 thé nhan phim tat

SHIFT+>, hodc st dung nut Iénh ﬂ trén thanh cong cu.

2.11) Thu nhé hinh: Showing > Smaller (<): C6 thé nhan phJ{n tat\

/
SHIFT+<, hodc st dung nut I¢énh |_1 trén thanh cong cu.

2.12) Chon/ bé chon ché d¢ hién thi hinh vé dang day (it ci cdc
nét vé déu lien): Showing > Wire mode display. C6 thé str dung'nut 1énh

J trén thanh cong cu.

2.13) Chon/ bé chon ché dp hién thi hinh vé nét diit véi dwing b
che khudt: Showing > Dotted hidden parts. C6 thé sir dung nit 1énh rén
thanh cong cu. N\

2.14) Nhin hinh trong mitphdng riéng: Showing > Isolate plane.
Co thé st dung nut I¢nh @ trén(\thair}h cong cu.

Izalate a plane |23
Front plane: |Yeg -

‘Ha.me of the plane: | {1] -E
Help Cancel

Chon Yes g\o Front plane. Dién tén ctia mat phang can quan sat vao 0
s6 (1). 4 han Enter.
Lénh nay cho phép ta quan sat mot dbi tugng hay hinh vé nao do

trong mit phang riéng da chon. Vi du ta dung thiét dién cua hinh chop, mudn
quan sat hinh dang cua thiét dién nay thi ta chon mat phéng chira thiét dién dé
nhin. Xem hinh:
i

\
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3. Cac 1énh khac: Other :

3.1) Cdc kiéu vé: Other > Drawing styles: Co thé mé bang niit ﬂ

trén thanh cong cu

Shyles [E3m]

Point

o

Line

Meshin

Coord.

Brush
NO 0
LI

not

drasm drasm

Selection

rR| 2 (XD

Lénh nay cho phép hién thj bang lya chon cac kiéu v&, bao gom:
- Ki€u mau sac: gom 24 mau

- Kiéu diém: Gém g\kiéQ va cong cu dé diéu chinh tén diém
(khi tén diérq bi che khuat thi chon cong cu nay va click vao
diém cin didu chinh).

- Kiéu duong: Gom 4 kiéu.

- Kiéu dan ludi: Co6 8 kiéu, danh cho v& mat 2 bién hodc quy

| tich ctia'2 diéu khién.

- Kiég\‘tmc: c6 2 kiéu, chia don vi va khong chia don vi
- 46t v&: Co 6 kiéu. Trong d6 nit a O dé bo dinh dang kicu vé
cta doi tuong, kiéu O dé dinh dang nét vé khuét cho ddi tuong

d’;'f'tm drasm

- : Cho an, hién thi mot vai doi twong trung gian

cua hinh v¢.
* Khi kiéu v€ nao duoc chon thi s€ hién thi & 6 Seclection
* 4 4t |R| @& mo bang mo ta cac dbi tuong.

* a0t 7] dé mo hudng dan sir dung

*aut @ dé dong bang Styles
3.2) Gidi han nhitng phén hinh vé: Other > Clipping: Lénh nay cho

phép giéi han hinh vé& tir mot phan bén trong ciia hinh da dién 16i. 4 éu ta chon
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lénh nay cho mot hinh 16i da 4p dung kiéu nét khuat hay gach soc thi nd mét kha

nang che cac duong khuat.

Clip sorne drawing inside a comwvex

=)

-Separate the names by spaces-

Hame of the convex solid:

Objects whose drawing will he cllpped R

| (2)

Help | Cancel |

ok |

Pién tén ctia vat thé vao 6 s6 (1). Vidu sl (tu: dién SABC)
Dién tén cac ddi twong can gidi han vao 6 sb (2). Vi é\ s1 (tr dién

SABC nhu trén)

a han Enter. Puoc hinh sau:

X W

>

Trudce khi z';p dung lénh Clipping  Sau khi ap dung lénh clipping

3.3. Htiy bo lénh Clipping: Other > Unclipping:

\ X Llncllpplng

0k Cancel

=[5 ]ES]

Help ‘

51 convex polvhedron with wvertices ABCS

N Chon dbi tuong can hity bo 1énh gi6i han. Click OK.

\

O 3.4) Chinh siva/ Nhin ban mét hinh vé (phim tit Ctrl+M):

\

Sau khi chon 1énh hién thi hop thoai sau:

hModification/Duplication of an object

‘Ha.me of the ohject: ls |J

Help | Cancel |

Dk|
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Dién tén cua do1 tugng can chinh stra vao 6 so (1). Vi du: sl. 4 han Enter

xudt hién tiép hop thoai:

Corwex polyhedran

=]

Li=s=t of the wvertices (3 to 40):

mADEC

(1)

‘Hame of the polyhedron: |51 {2]

R

Help |

Cancel |

Ok |

~

\

/

* Hiéu chinh tén cac d6i tuong & 6 s6 (1) hodc s6 (2) thi s& hiéu chinh d6i

tuong. 4 han Enter. Vi du:

Cornvex polyhedron [E3m]
List of the vertices {3 to 40):
[E3EE R

‘Hame of the polyhedron: |51

Help |

Cancel |

Ok |

E

i . ?\\ \S
5\
. E
D .

Tr

Hiéu chinhca hai 6 thi 12 nhan ban cac déi tuong. 4 han Enter. Vi du:

\

‘\

B

r‘c

[}

Cornvex polyhedron [E3m]
List of the vertices {3 to 40):
|EJJBC R

Hame of the polyhedron:

<€)

Help |

Cancel |

Ok |

D

O

¢
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A E.
« B
N
I /
Truwdce Sau
3.5) Lap lai lénh vira thuwc hién: Other >Suppres (Ctrl B&: Phim tat

: O\
Ctrl B hoac nut 1énh \"i‘ trén thanh cong cu.

Lénh nay cho phép goi lai 1€nh vira thuc hién, diéu nay giap tiét kiém
kha nhiéu thoi gian trong khi sir dung Geospace. Vi dﬁ: Ta can ?ao diém tu do
trong khong gian, ta str dung lénh Create > Point > Free point > In space. a éu
phai tao nhiéu diém thi phai mat nhiéu lan dé chQn\leﬁq\h, ta sir dung phim tat Ctrl
B d¢ lap lai 1énh nay. |

3.6) Xéa mot hodc nhiéu a4 ‘tirong trong bdn vé: Other >Suppess:

Lénh nay cho phép ta xoa (\:Sc d6i tuong trong bang v&. Sau khi chon 1énh,
xuat hién hdp thoai sau:

X Suppress = @
0k ‘ Cancel Help

B free point in space
C free point in space

E free polnt in space

£, convex polyhedron with wvertices RDBC

52 convex polvhedron with wvertices EDEBC

’ z\

I

Ta chon cac d6i twong can x6a trong bang Suppress, c6 thé chon nhiéu ddi
‘tuong bang cach két hop cac phim SHIFT, Ctrl véi phim chudt trai (xem hinh
_\trén, ta chon x6a diém A va D). Click OK.

3.7) Doi tén mot doi twong: Other > Rename:
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Renarne [=5]
.Separate the names by spaces-

01ld names:

[ (1)

Hew names:

| 2) O}
J _/
Help | Cancel | Ok | /i \
Pién tén cil vao 6 sb (1). Pién tén méi vao 6 sd (2). 4 han Enter.
3.8) Tdi hién lai lich sur vé hinh: Other > History

e

¢
I#Gnecusr:uau:e_l — o) x| (\\
H+ )
H?
e M
> N
D
g, convex rolyhedron with wvertices ADBC

Lénh nay cho phép tai hién lai lich str v& hinh theo timg budc, bang cach

click vao nat 11* |f i é\dié\l\l khién viéc v& hinh. a it H? 4 xem trg gitp, nit hal
dé thoat. Cha v O ché (%(&j\néy mdt s6 1énh s& khong thuc hién duoc.
3.9. Loc, kiém tra: Other > Filter:
" 3.9, 1) Cim di chuyén déi twong: Other > Filter > Forbid

\
pﬁoting: \y
| Forbid piloting o] x|

‘\; \ ................ D k ................ Cancel

A\ \
\

HS oW
Hh
nd
m
m
o
u}
=
[ad
ot
H
[ad
i}
o
i}
[y
m

* N
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Lénh nay cho pheép cAm di chuyén mdt hodc nhiéu ddi tuong tu do. Ta chon
cac doi twong can cam trong bang hién ra (xem hinh trén), c6 thé két hop phim
Ctrl voi phim chudt trai dé chon nhiéu d6i twong. Doi twong nao di bi cdm s& cd
dau (*) & sau dong mo ta trong bang Rappel.

3.9.1) Cho phép di chuyén doi twong tré lai: Other > Filter >

Allow piloting: 7\
o~ ¢
= Allowy piloting o] x|
e : k Cancel
A free point in space [¥) Ve
E free point in space (¥) N
< | ﬂ
Chon doi tuwgng can hiy bé 1énh cam. Click OK. Y

3.9.3) Céam truy cdp: Other > Filter > Forbid access:

Lénh nay cho phép cim truy cap dén ddi tu()ng( nao d6. a éu ddi twong nao
dé bi &p dung Iénh nay thi né khong }guét hién trong bang mé ta ddi twong trong
ban v&, vi vy ta ciing khong thé sur dhng\dé dé 1am ddi tuong trung gian dé tao
cac d6i tugng khac. Doi tuong bi cam truy cap van co6 thé di chuyén dugc. Ta ¢o
thé st dung 1é€nh cAm truy cép\‘c\Qo cac dbi tuong da duoc dinh nghia trude nhu

goc toa do, cac truc toa do, cac vecto don vi...

7 ' Forbid access O] x|
E Ok Cancel Help
......................................... .
OoXy plane with coordinate svstem (o,i,7) =
- =

0¥z plane with coordinate systewm (o,j.k)
— =
02X plane with coordinate system (o,k,1)

A free point in space (%)
B free point in space E
C free point in space

f \ D free point in space -

Dy

Chon ddi twong can ap dung 1énh trong bang Forbid access. Click OK.
AN 3.9.4) Cho phép truy cip doi twong tré lai: Other > Filter >
. Allow access:
Lénh nay cho phép huy bo 1énh cam truy cp cho d6i tuong dd bi cAm truy

cap.

@@/ Thanh Mhin - THIC Nyi Gia T G D, Ty N e
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7] Allow access = @

Ok : Cancel Help

B free point in =pace

51 convex polvhedron with wvertices ADEBC

32 convex polvhedron with vertices EDBC

Chon d6i tuong can huy bo Iénh. 4 han OK. /Y )/\\ -
. ™
3.10) Bao vé: Other > Protect:
7| Protect |E|_|£
................ o | Cancel el .
.......................................... (\\

A free point in space [¥) -
C free point in space

D free point in =pace

E free point in space [¥)

s convex polyhedron with wvertices ADBC/E

52 convex polyhedron with vertices EDBC _

Lénh nay cho phép bao vé cac d6i twong. 4 éu é%i tuong dugc bao vé boi
1énh nay thi n6 khong con chinh stra, ’1@1 n%ap dung kiéu (styles), khong thé xo6a
hay doi tén duoc nira.

Chon cac dbi tuong can lga@% Click OK.

3.11) Hiiy bé ché dé bao vé: Other > Unprotect:
X Llnpru:utect _ ol x|

Cancel

Help

- =
0XY¥ plane with coordinate system (o, 1,]]

—
0¥Z plane with coordinate =ysten (u,] k]

02X plane with coordinate syvstem (o, k 1]
B free point in =space
\ C free point in space

"~ Chon déi tuong can hity bo Iénh bao vé. Click OK.
3.12) Thay déi hé menu lénh: Other > Modify menus:

@04 oyen T/mn/L %/an - Zij/@}% 4/(' % %;tl C?’ @0% ?W// & V 123
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n_| Figure Géospace 1: Modifiy the menus O ﬂ
0k Cancel Help

Authorized menus Forbidden menus

Lreate | s [ 2 Create |

1 Paint ] [ 2-1 Paint ]

1-1 Free paint | [ 2-1-1 Fres point |
In zpace 211101 a paolygon
On a plane
On aline

2
2-
2-
-1
-2
-3
-4 On aray p 3] —
5
-B
-7
-8
-3
-1

m

On a zeqgment
On a circle
On an arc
With integer coordinates
With integer abzcizza
1 On a zphere
2-1-2 Point by coordinate(s]
2-1-2-1 In space
2-1-2-2 On a plane
21-2-30n aline
21-2-4 Onaray

2-1-3 Interzection 2 lines &g -
1| | F

11
11
11
11
11
-1-1
11
11
11
11

R B B R Y

Lénh nély cho phép ta giam b6t mot s6 1énh oil@*nenu 4 éu mudn bo bot ta
chon 1énh can bo va di chuyén né sang cot bén phai. 4 éu mudn chon lai ta

\

chuyén no sang bén trai. (\ﬁ )
3.13) Tao mot nguyen mdéu: Other > Create a prototype:
Lénh nay cho phép ta tao Ii’lbt nguyén mau (cac ddi trong thudng hay sir
dung) dé bd sung vao menu dung hinh. (Xin xem k¥ hon céch tao ¢ phan sau)
4. Cac Iénh bién tap: Edit:
4.1) Sao chép hinh anh (tw dong): Edit > Copy picture (automatic):
Khi chon 1énh nay, toan bd man hinh cta ban vé sé dugc sao chép
vao bd nhéd may, ta co thé dan vao MS Word, MS PowerPoint, MS Paint,...

Mudn sao chép mot phan ndo d6 cia hinh v&, ta click nit irel

trén
thanh cong 01} va click chuot vao dong ké doi cia khung hinh chir nhat vira hién

ra va keéo de diéu chinh khung hinh chir nhat bao quanh hinh can sao chép. Xem

‘hinh:
\

@ Vyugin Thank M - THPE Ny Gia T Go D, Tay Nk i
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. \ N
4.2) Sao chép hinh anh (ché do diéu chihh): Edit > Copy picture
(adjust copy):

N
Adjusted copy of the picture [eE3m]

Type of cop¥: |Yectorised - coulour j

Reference unit: ||Ength unit nyzj

|Hu.mher of millimeters for the unit:-g
Help | Cancel Ok

* Chon kiéu sao chép (Type of copy): ¢6 3 kiéu lyra chon.

- Vectorised — coulour: Do hoa vecto — d6 hoa diém.
- Bitg{ap (coulour): D6 hoa diém (anh mau)
- Vectorised — black and white: P4 hoa vecto - anh den trang.
* Chon don vi tham chiéu (Reference unit): c¢6 2 kiéu lra chon
’ - length unit Uxyz: Do dai don vi cua h¢ toa d§ Oxyz.
\ - width of picture: chiéu rong cua anh
: * Pién s6 milimet cho don vi vao 6 4 umber of millimeters for the
unit.
\} 4.3) Sao chép dong mé ti déi twong trong bing Rappel: Edit >
Copy selected descriptions:
Lénh nay cho phép chép cac dong mé ta cac ddi tugng trong ban vé

vao bod nhé. Ta chon mét hodc nhiéu dong mo ta cac ddi tuong (co thé két hop

@@/ Thark M - THTT Nyi Gia T G T, Tay Vi "
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phim Shift, Ctrl véi chudt trai dé chon nhiéu dong), click OK. Sau d6 ¢o thé dan
dong mo ta vao Word hoac Powerpoint,..
4.4) Soan thdo vin ban cua hinh vé: Edit > Edit text of figure:

] Figure Géospace 2 : Text edition = @
File Edit Execute 7
IGeospace figure (English) - !\

Kumber of version: 1

Usyz with the smallest dimension of the window as unit: 0.7
Rotations of Rxyz: vertical: -20 horizontal: 2b frontal: O
~ Dbong mb ta cdc d6i tuomg cé trong bang v

m

A free pointin space
Free object A, parameters: -0 76687795191, -2 460283804223, 0.462161609

End of the figure

-

Vin ban nay bao vé hinh v, bat ctr su ¢h\a§/ d6i nao trong vin ban nay
cling s€ lam thay doi hinh v&. Ta c6 thé thém, sira, x6a cac doi tugng co trong ban
v& bang cach thém, xoa, sira cac dongxlen]{trong van ban nay theo ding cu phap
ctia chuong trinh. 4 éu nam Vung tieng Anh va cl phap 1énh cua chuong trinh, ta
¢ thé vé& hinh bang cac dong Ielﬁl tir mot trinh soan thdo van ban nao d6 (nhu
a otepad, MS Word,...) r0i copy dan vao vin ban nay.

Sau khi thuc hién xong, click vao 1énh Execute trén thanh menu. Xuét hién bang

thong bao sau, click Yes.
[ Attention ! Lihjﬁ

\

This text has a correct syntax,
! % PReplace present fiqure?

Yes |
| .

........................................

‘ r ~ 2 A 2 ~ r.* ~ . \ e 2 )\ .
Vi du: Ban hady m¢é mot ban vé mdéi (khong gian) va copy doan van ban sau roi

. 'd4n vao trude dong End of the figure. Click Excute r6i click Yes.

A free point in space
Free object A, parameters: 0,1,0

B free point in space
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Free object B, parameters: 1,3,1
Segment [AB]

E

—

i

Pay 1a két qua:

Poan 1énh trén cho phép tao 2 diém tu do A, B trong khong glg)} o1 }\)

doan thang AB, véi toa do hién tai cua A la (0,1,0) va cua diém B/1a (1,3,1). a a éu
ta di chuyén diém A va B thi toa d6 nay s& thay doi.

4.5) Soan thdo phén chii thich ciia bin vé: Edit > T ext comments:

Lénh nay cho phép tao van ban chu thich cho hinh vé, ta c6 thé ghi chu

cach dung hinh, cach sur dung hinh vé, dé bai toan,. . L N\

* ' Figure Géospace 1: Editing comments ol x|

Edit %:em
with not drawn expressions

Nhap van ban cha
thich vao khung nay

B E NN EE RN

Text with drawn expressions

s A

>

Sau khi thyc hién xong, click Update.
Chu y: Khi dung hinh ta nén tao bang cht thich nay dé khi chia sé ngudi khac sé
\\ biét cach sir dung hinh v& nay. Pé xem bang cht thich nay nhan phim F3
4.6) Lénh hoan tac (Undo): Edit > Undo: 1L&énh nay cho phép huy bd
1énh trudc d6. Lénh nay khong co phim tat nhu trong cac phan mém vé hinh hay

soan thao van ban khac.
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4.7) Lénh lam lai (Redo): Edit > Redo: Lénh nay cho phép lam lai
1énh vira huy bo (undo) trude d6. Lénh nay ciing khong c6 phim tit.
4.8) Lénh gioi han hinh anh: Edit > Limit picture:
Lénh nay cho phép giéi han phan hinh v& dé thuc hién sao chép phan
hinh vé& d6. C6 thé click vao nat @ trén thanh cong cu dé thuc hién 1énh nay.
5. Cac 1énh vé cach nhin: Views R ,\
5.1) Tré vé cdch nhin ban dau: Views > Initial view (CTRL- F1):
Lénh nay cho phép tré vé cach nhin hinh mic dinh cia chuwong trinh
Geospace. Phim tit CTRL-F1. ~ ¢
5.2) Cdch nhin hinh véi mdt phing oyz la mét phang chinh dién
(song song vdi man hinh): Views > Standard view with oyz as front plane (F7).
Lénh nay cho phép quan sat hinh v& voi mat phang oyz song song voi
man hinh. Phim tit F7. \
5.3) Cach nhin hinh voi mat phang oxy la mdat phang chinh dién
(song song véi man hinh): Views ?é‘tandard view with oxy as front plane
(F8). ,
Lénh nay cho phép quan sat hinh vé& véi mit phang oxy song song vai
man hinh. Phim tit F8.
5.4) Cach nhin hinh véi mét phang ozx la mit phang chinh di¢n
(song song voi man hinh): Views > Standard view with ozx as front plane (F9).
Lénh nay CIQO phép quan sat hinh v& véi mat phang ozx song song véi
man hinh. Phim tit F9.
5.5) Nhin hinh voi mat phting chinh dién khac: Views > View with

another front plane:
Lénh nay cho phép nhinh hinh theo mot mat phang chinh dién do ta
Ivra chon.
QN Chaosing the frant plane
Hame of the plane: ’T‘
Humber of steps (1 to 50}: 5I] [2

Help Cancel Ok

Dién tén mat phang vao 6 s6 (1).
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Pién s budc xoay hinh trd vé cach nhin theo mat phang chinh dién
(tir 1 dén 50 budc) vao 6 sd (2). a han Enter.

5.6) Nhin hinh theo cach nhin truwoc do: Views > Precedent view
(F11).

Lénh nay cho phép tro vé cach nhin hinh theo cach nhin vira thyc
hién tru6c d6. Phim tat F11. ANNA

5.7) Nhin hinh theo cach nhin ké tiép: Views > Next view (F12):

Lénh nay cho phép nhin hinh theo cach nhin ké tiép (néu da dung
1énh Precedent view). Phim tat F12. . ¢

5.8) Nhin hinh theo cach nhin co dinh mat phang chinh dién hién
tai: Views > Fron plane maintained:

Lénh nay cho phép c¢d dinh mit phang c}\unh dlen hlen tai. Ta khong
thé xoay hinh bang phlm SHIFT két hop v&i phim mu1 tén. Ta chi co thé xoay

hinh theo truc di qua géc O va vudn goc voi man hﬁ’lh may tinh bang cach click

chudt phai dé con tro chudt bién théﬁh @ va thuc hién xoay hinh. Ta c6 thé

click nut ﬂ trén thanh cong cu d & thuc hién 1énh nay.
5.9) Nhin hinh theo phép chiéu xién: Views > Oblique projection:
Lénh nay cho phép nhin hinh theo mét phép chiéu xién
5.10) Nhin hinh theo phép chiéu xién véi toa dp chidu:
6. Céc 1¢nh vé ciia s0: Window
6.1) Kiéu X%p 16p: Window > Cascade
6.2) Kiéu xép doc: Window > Tile (horizontal)
6.3) Kiéu xép ngang: Window > Tile (vertical)
( @.\4) 4 éu mo cung lac nhiéu tap tin hinh vé&, ta co thé lwa chon ctra s6
dang hoat dong bang cach click vao dong tén ciia ban vé trong menu Window.
S 7. Cac Iénh trg giap: Help
7.1) Trg gitip phan mat phang: Help > Help for Geoplan
7.2) Tro gitip phan khong gian: Help > Help for Geospace
7.3) Vé thong tin chuong trinh: About
7.1) Tro giap phan mém Geoplan-Geospace: Help > Help for
Geoplan-Geospace
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III. MOT SO MINH HQA DUNG HINH VOI GEOSPACE:

1. Tao ban vé ban diu:

Khi v& hinh, thong thuong ta can tao 1énh quay hinh ty dong theo 1 truc nao
do dé quan sat va lénh tra vé cach nhin hinh mic dinh. Dé d& mat thoi gian cho
cong viéc nay trong mdi 1an vé hinh, ta ¢ thé tao san ban vé& véi cac 1énh nay dé
st dung cho cac 1an sau. A ’/\

M6 1 ban vé trong khong gian (File > 4 ew Geospace figure), thuc hién cac
Iénh sau:

- Tao 1énh thay d6i cach nhin hinh vé cach nhin hinh boi su Aghl'hho (Create
> Command > Change of view > By memory), gan 1énh nay cho phim:so 0.

- Tao 1énh xoay hinh quanh truc oz mot goc 2/dg boi phep quay tuong d6i
theo vec(k), gan cho phim s 2. (Create > Command > Change of view > By

Relative rotation). Pién nhu hinh sau: \

Command far relative rotation of the picture @
hngle unit: |degree -
Axial vector: |\.|"El:l:k:l
Angle: |2
R

by pressing the key: |2|
Hame of the command: Cml

Help Cancel Ok
Lz e sl lao [ 2 {58 [R5 ]RA2

- Tao I¢nh lap cAu triic 1énh Cm1 (vtra tao & trén) 180 lan dé tu dong xoay
hinh 1 vong quanh truc oz, gan Iénh cho phim Q (Create > Command >

Cpmmand repetition). Dién nhu trong hinh:

3
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Command for repetition of some command(z] 5]

Commands to repeat:

Cml

Maximum number of times: |1 a0

Minimum delay (50 to 60000 m=s): |5|] £

by pressing the key: |ﬂ

Hame of the command: Cm? /\
Help | Cancel Ok

L e el o || 2 |58 |10 |23 ]Rn2

- Tao chu thich dé huéng dan st dung 1énh: 8 ;
+ Tao chi thich: “4 han phim so 0 -> ve ¢ach nhin hinh ban dau”
Nl

(Create > Display > Text). Pién nhu hinh: \

Digplay af a text

s
Text to display:
“m 50 0 -> ve cach nhin hinh ban dau ﬂﬂ

‘ Hame of the display: |Af0

Help | Cancel | Ok

-
\EERR S

B33 N B =

+ 4 héan Ctrl B dé tao tiép cac cha thich: “a han phim so 2 -> quay 2
do”, “4 han phim Q -> quay 1'vong quanh 0z”.

- Luu lai ban vé véi tén “Ban ve goc”, dat thudc tinh Read Only cho ban vé
dé tranh luu dé, ban vé ndy sit dung cho céc 1in khic ma khong cin phai 1ap lai
cac thao tac nay v6i moi lan vé.

2. Tao mdt nguyén miu (Prototype, gidng nhu cac cong cu thuong
ding caa Sl\gétchpad):

Prototype giup cho ta tao cac Iénh dung nhanh cac hinh thuong dung nham
z giﬁP giam bt thoi gian dyng hinh. Chang han, trong cac 1énh dung hinh cua
phan mém khong c6 1€nh gitp ta danh dau goc vudng. Muon danh dau goc

\ vubng, ta phai tao 1énh cho no. 4 éu trong ban vé& ¢ chira cic prototype thi trong

menu Create co thém dong 1énh “Object from prototype” (xem hinh):
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Solid 3

Dbject from prototype L} r b ector

Display N Gocvuong
Dau goc 1

Command ¥ Dau goc 2
Dau goc 3

Dau gac vuang
Mat cau qua 4 diem trong KiG
Thue hanh: Tao prototype danh dau goc vudng:
Gia str ta c6 goc ABC, ta can danh du goc vuodng tai B-Ta tao prototype
Dau géc vudng nhu sau: S
- Tao 3 diém A,B,C tu do trong khong gian.
- Dung mat cau sl tim B, ban kinh 0,2 1an luot cét céo‘&ubng thrfmg AB
tai E,F va BC tai G, H. Xem hinh:

F= <
B
\ TE
- Dung dudng thang 11 qua F va song song BC, 12 qua G va song song
AB.
\ - Dup‘g I 1a giao diém cua 11 va 12.
- Dung da giac 16i v6i cac dinh BFIG dit tén 1a v.

, - Vao menu Other > Create a prototype. Dién nhu sau:

192
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Creation of & prototype [E5m]

Title of prototype:
|Dﬂl.l goc vuong

Antecedent obhjects:
ABC R

Re=zulting obhiject: |"u"

Pattern phrase: /\ j \
“"u"|ﬂ dau goc vuong ABC ~ &
Help | Cancel | Ok |

- Vao van ban mo ta hinh vé (Edit > Text of figure) x0a di cac buoc dung

hinh sau dong 1€nh:

“Uxyz with the smallest dimension of the window as unit: 0.1
Rotations of Rxyz: vertical: -20 horizontal: 25 frontal: o”

chi

chira lai cac doan 1énh ¢6 céu tric nhu sau:
Beginning of [Dau goc vuong] \ \\
A given point
B given point
C ai . VAN
given point

s1 sphere with center B and radius 0.2 (length unit Uxyz)
F intersection point 2 of line (AB) and sphere sl
G intersection point 1.of line (BC) and sphere s1
|1 parallel line to line (BC) through point F

|2 parallel line to line (BA) through point G

I intersecti‘(\n point of lines 12 and |1

v convex polygon with vertices BFIG

Interface description

vila'dau goc vuong ABC

@htecedent 1 (point):

Antecedent 2 (point):

Antecedent 3 (point):

Result (convex polygon):

Specific help not written.

End of [Dau goc vuong]

a hu vay, cac prototype dugc mo ta giira 2 cu 1énh:

Beginning of [<Ten cua prototype>|

@r@/ Tharn Man - THTC Nyi Gia T Go L, Tag N 1



‘m HUG4 G DA4 SU DU4 G PHAA MEM GEOSPACE 2003

End of [<Ten cua prototype>]
Trong d6: <Ten cua prototype> do nguoi st dung dat.
- O doan 1énh trén, ta co thé thay cac cau lénh:
Antecedent 1 (point):

Antecedent 2 (point):
Antecedent 3 (point): -~ \

Thanh cac cau lénh: ) 4

Diem thu 1:

Diem thu 2:

Diem thu 3: O

Pé s dung prototype nay ta chi viéc goi 1énh (Create > Object from
prototype > Dau goc vuong), sau d6 dién tén cia 3 diém x4c dinh goc va tén cua
dau goc vudng vao cac 6 tuong ung. Chi ¥: Dau goc vudng dugce tao & diém thir
2 cua goc. O\

Ta c6 thé tao nhiéu prototype trong mot ban vé va luu ban vé nay thanh ban
v& gdc (nhu phan trén) dé str dung cho céc{ﬁn sau.

That ra, tap tin hinh v& cua GeoplanGeospace don thuan 14 cac tap tin van
ban (ta c6 thé chuyén phan m& ffng cua tap tin *.g2w, *.g3w thanh *.txt, *.doc
va mé bang trinh soan thao vin ban nhu 4 otepad, MS Word dé xem, nguoc lai ta
cling c6 thé soan thao cac 1énh dung hinh theo ding cau tric 1énh cta chuong
trinh va luu lai dang tap tin'ctia chuong trinh). Do d6, dung lugng cua tap tin cua
Geospace rat nho so VQ‘L mot s6 phan mém khac (nhu Sketchpad chang han), day
cling 12 mot wu diém cta phan mém nay. Thay cb co thé tham khao thém cac
prototype da tao san trong tap tin Cong cu tu tao.g3w.

~~ 3. Phén chia mjt khoi da dién thanh cac khoi tir dién:

Trong\seich gido khoa Hinh hoc 12, ca co ban va nang cao déu c6 bai toan
chia 1 khéi da dién thanh cac khdi tr dién, ching ta c6 thé sir dung phan mém
Geospace dé dung hinh va didu khién tach cac khéi tir dién va xoay hinh dé hoc
sinh quan sat rd hon. Ching ta thuc hanh chia 1 khéi 1ap phuong thanh 5 khdi ttr
dién: Y tudng cta cach dung hinh nay 1a ta dung khdi 14p phuong véi cac dinh co
toa do cu thé, sau do dung 5 khdi ta dién tir cac dinh cua hinh 1ap phuong va hop
thanh khéi lap phuong d6. Sau d6 ta dung 4 khdi tr dién 1a anh cta 4 khéi tir dién
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da dung & budc trén (trir khoi tr dién ¢ trung tAm) qua 4 phép tinh tién theo céc

vécto ¢o thé thay doi toa dd bang ban phim (dé di chuyén cac khoi t& dién). Sau

d6 an cac khoi tt dién hop thanh khéi 1ap phuong va khi 1ap phuong di.

Cac budc dung cu thé nhu sau:

Mo ban vé géc da tao d muc 1.

Dung diém cac diém A (2;-2;0); B(2;2;0); C(-2;2;0); D(-2;-2;Q\(Cre’/&¢e
> Point > By coordinate(s) > In space)

Tao phép tinh tién T1 véi vecto tinh tién 1a 4vec(k) '(Create >
Transformation > Translation (vector)) ~ ¢

Dung cac diém A’, B’, C’, D’ 1a anh cua A, B, C, D qua phép tinh tién
T1 (Create > Point > Image point by) \

Dung céc t¢ dién tdO=A'DBC'; tor di¢n \[d1=A']§\]5A; td2=C'A'BB';
td3=C'A'DD'; td4=C'BDC (dung phim sf} 2'dé xoay ‘hinh dén vi tri d&
quan sat cac dinh dé dung hinh) (C?e%zte > Solid > Convex >
Polyhedron) ’

AN _

Tao nét khuat cho hinh bang cach click vao biéu tuong \-_""‘ trén thanh
cong cu, click chon {)1\@ tuong [ o] trong bang Styles, click nut R,

chon céc td0 dén td4, déng bang Styles. Click vao biéu tuong trén
thanh cong cu dé vao ché do hién thi hinh & kiéu v& nét dut - nét lién.
Tao 4 bién tu do a,b,c,d thudc doan [0;10] (Create > Numeric > Free
real variable &b an interval)

Tao 4 vecto:

+ vec(vl) co toa do (a;-a;0);

+ ng(VZ) c6 toa do (b;b;0);

+ vec(v3) cb toa do (-c;-c;0);

+ vec(v4) c6 toa do (-d;d;0).

(Create > Vector > By coordinates)

Tao 4 phép tinh tién t1 theo vecto vec(vl) , t2 theo vecto vec(v2), t3
theo vecto vec(v3), t4 theo vecto vec(v4) (chi y phan biét chit hoa,

thuong) (Create > Transformation > Translation (vector))
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- Tao lénh thay dbi su Iya chon ddi twong dugc diéu khién bang ban phim
(Create > Selection for piloting with keyboard). Gan cho cac bién tu do
a, b, ¢, d duoc diéu khién bang cac phim A, B, C, D.
- Tao cac tr dién:
+k1 13 anh cta td1 qua phép tinh tién t1
+ k2 14 anh ctia td2 qua phép tinh tién t2 N\
+ k3 1a anh ctia td3 qua phép tinh tién t3
+ k4 13 anh cua td4 qua phép tinh tién t4
(Create > Solid > Convex polyhedron > Image of a polyhedr‘on)
- Tao kiéu v& nét khuat-nét lién cho cac tir dién k1, k2, k3, k4 (nhu trén da
tao)
- An cac dinh va cac khéi tir dién td1, td2, \d3 td4. ( Vao bang Styles,
Chon céng cu 4 ot draw, chon cdc doi tLrO’ng can dn, déng bang Styles)
- Lan lugt nhan cac phim A, B, C, D va dﬁng cac phim mili tén dé di
chuyén cac khéi tir dién dugc tach va cho xoay hinh dé quan sat.
Pay 1a hinh v& co ban nhat dé mmh\hoa cho viéc tach khéi da dién thanh
cac khoi tir dién, thay co @ thé cai tién thém hinh v& sao cho dep hon va
hay hon bang cach phdi hop céc 1énh v& hinh theo khéi, theo budc dé thé
hién duoc cach chia khdi 1ap phuong theo ting budc. Hinh vé nay duoc luu
trong tap tin “Chia kh\of lap phuong.g3w”
\ N\

\
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I
o

A

4. Tao vat thé tron xoay: A

¥

Chuong trinh Hinh hoc 12 phan ban c6 cac bai toan vé mit tron xoay, ta c6
thé str dung phan mém Ge@paee dé minh hoa cho cac bai hoc gitup cho hoc
sinh dé dang nam bat duoc bai hoc tdt hon. Sau day la 1 s6 vi du cu thé vé
cach dyng mat tron xoay:
a. Dung mgt phagng P, quay quanh truc d:
- Dung diém I l\a\d1ém tu do trén truc oz.
- Dung mat phang p1 di qua I va vudong géc voi duong thang oz
- Dungdiém M 1a diém tu do trong mat phang pl.
~ = Tao tham s6 t 1a tham sd tu do thudc doan [0;27[}

3

- Tao phép quay Q vdi truc oz, goc quay t.
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Ok | RN

Rotation [axz-angle] @
Angle unit: |radian ~
Hame of the axis: |DZ
Angle: |t R
Hame of the rotation: |Q|
Help | Cﬂnc:el|
[ [ (et o 13 [ R

- Dung diém P 1a anh cta diém M qua phép quay Q.

Images by exizting transformation

55 NN

Transformation:

Points (to be transformed):

—

M

Images of these points:

I

R

Help | Cancel | Ok

- Dung diém P1 1a anh cua P qua phép dbi xtng truc oz

Irmages by reflection

sl

Axis of srmmﬂtrf:|nz

Points (to be transformed):

P

Images of these points:

o)

P1

\\ | Help |

Cancel |

Dkﬂ

- Dung P2 la anh cua P1 qua phep chiéu vudng goc 1én mat phang oxy

7 A\

»

Images par orthogonal projection on a plane

=)

Hame of the plane:|uxy

Points (to be transformed):

|P1

Images of these points:

o)

P2

Help Cancel

Dk|

- Duyng P3 13 anh cta P qua phép chiéu vudng goc 1én mit phang oxy
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- Dung da giac p2 c6 cac dinh PP1P2P3, an di cac diém P1, P2, P3. Che
di tén ctia diém M ta c6 dugc hinh anh cua 1 mit phang quay quanh truc
0Z.

Kéo thay doi do rong mp (P)

&

F

/

. , \
- DeE tao truc quay ta dung duong thang voi \t}'uc toa do (Create > Line >

Straight line(s) > With a coordinates system), dién nhu sau:

Lire with coordinate spstem |23
Line through: n]
VYector: |vec:(u,|]
Step for graduation: |'|.2 ﬂ
Limits for drawing: |—|].1 11
Hame of the line: |[:||
Help Cancel Ok
e v Ul o [ 2 (58 [R13]RA

a hu vay ta da tao xong mat phang P 1a mat phang quay quanh truc d. Dé
thay.do6i chiéu cao ctia “mit phing quay” ta kéo diém I, dé thay doi d6 rong
ta kéo diém M. Bé quay mait phang ta ding cac phim mili tén trén ban

" phim. Két qua nhu sau:
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-P///

,—// \ /

—

Luu lai thanh tap tin “mp_quay.g3w” dé st dung cho c¢4c lan sau.

b. Dung mdt tru tron xoay tao béi dwong thing | nam trong mp P va
quay quanh truc d: \

M6 tap tin “mp_quay.g3w” da tao trudc d().\ N
Duyng diém tu do A trong tir giac p2 (Create > Point > Free point > In a
polygon). N\

Duyng diém B 14 4anh ctua A qua phép tinh tién (4/5)vec(o,l) (Create >
Point > Image point by > Tra(ﬁslét}on (vector)

Duyng doan thing AB (Create > Line > Segment (s) > By 2 points). An
cac diém AB (chon céﬁ;g cu Styles trén thanh cong cu, click a ot draw va
chon dbi tuong can an, OK)

Tao vét cho doan tﬁ'fmg AB (Showing > Trace selection), chon mau

xanh cho doan AB.\\
\) 7
Vao ché do tao veét lién tuc ® vacho xoay mat phang P (dung cac phim

miii tén) dé tao mat tru. Xoay hinh theo cac goc do khac nhau dé quan

sat. \

Dy
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c. Dung mdt non tron xoay:

- Mo tap tin “mp_quay.g3w” ONN

- Tao diém tu do A thu@g'SQan théng ol (Create > Point > Free point > On
a segment).

- Tao diém ty do B nim trong t&r giac p2 (Create > Point > Free point > In
a polygon). ’

- Dung doan thzlmg AB (Create > Line > Segment (s) > By 2 points), chon
v€ mau Xanh.\\

- Tao vét cho doan thang AB (Showing > Trace selection).
\
- Vélo\ché do tao vét 1 va diéu khién quay mat phéng dé tao mit non.

by
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d. Tao vong xuyén: N

M6 tap tin “mp_quay.g3w’” ONN

Dung diém ty do A nlirgjmng tor giac p2.

Duyng duong tron ¢l ¢6 tam A, ban kinh 1, thuéc mp (PP1P2) (Create >
Line > Circle > By plane; center and radius)

Tao vét cho dudng tron cl (Showing > Trace selection).

Vao ché do ta&vé’tlvé diéu khién quay mat phang dé tao vong xuyén.

>
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i,
e,
\%ﬁim

T

<

-
<

S
&7

iy

P iy
W iy
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e. Tao mt vit thé tron xoay(\bc’l(”t\ki: (hinh chiéc binh hoa).
Két hop cac hinh vé fa:\S(') thé tao hinh thanh chiéc binh hoa. Céc budc
thue hién nhu sau:

- Mo tap tin “mp_quay.g3w’”’

- Dung4 diém tu do 0/1, 02, 03, 04 nam trong tr giac p2.

- Dung cac du’(‘ypg fhéng 11,12,13,14 di qua cac diém ol, 02, 03, 04 va
vuong gbc méﬁ\phéng (PP1P2).

- Dung cac diém tu do k1, k2, k3, k4 lan luot trén cac duong th'flng 11, 12,
13, 14.

-\ - Taq\4 bién tu do a, b, ¢, d thudc doan [0, 2pi].
- Tao 4 phép quay ql, q2, q3, g4 véi gbc quay lan luot 1a a, b, c, d.
t - Duyng diém tu do h nam trong ti giac p2.

- Dung hl la anh ctia h qua phép quay ql.

- Dung h2 1a anh ctia h1 qua phép quay q2.

- Dung h3 la anh ctia h2 qua phép quay q3.

- Dung cung cl c6 truc olkl, diém dau 1a h diém cudi hl.

- Dung cung c2 c6 truc 02k2, diém dau 1 h diém cudi h2.
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- Dung cung c3 c6 truc 03k3, diém dau 1 h diém cudi h3.

- Dung diém h4 13 anh ctia h3 qua phép tinh tién vec(k).

- Dung h5 1a anh ctia h4 qua phép quay ql.

- Dung doan thfmg h3h4.

- Dung cung c4 c6 truc o4k4, diém dau 1a h4 diém cubi h5.

- Tao cac 1énh diéu khién cac bién tw do a, b, ¢, d, t gan cho cé@hirﬂ)&,
B,C,D,T.

- Kéo céc diém ol, 02, 03, 04, k1, k2, k3, k4 va diéu khién cdc bién a, b,
¢, d sao cho cac cung tao thanh hinh dang ctua chié¢ binh hoa. Sau'do an
di cac duong thang 11, 12, 13, 14 va chon kiéu diém khéng hién thi tén
diém dé co thé diéu chinh hinh dang vat thé khi muén. thay doi.

- Tao vét cho cac cung cl, c2, ¢3, ¢4 va doan h3h4. C\c; thé chon mau sic
cho cac duong dé vat thé trong hap dan hon. |

- Vao ché d6 tao vét va nhan phim T, diéu léhién xoay mat phéng dé tao
vat thé. 8

- Thay cb c6 thé tham khao hitgfl \;é\;")r tap tin “vat the tron xoay.g3w”

@Vw Bhanks Man - THIC Ny Gia T Go Do Ty Nk »
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5. Tao vat thé tron xoay tao béi hinh phang giéi han béi cac dwong

y={(x), truc ox, x=a, x=b khi xoay quanh truc ox:

Ta c6 thé sir dung phin mém Geospace dé minh hoa cho bai toan tinh

thé tich vat thé tron xoay tao boi hinh phang gidi han boi cac duong

y=1(x), x=a, x=b, truc ox khi quay quanh truc ox. Cac budc dung hinh

\

s

nhu sau: N\

PN

- Mo tap tin “ban ve goc.g3w”

- Duyng diém 1(0,1,0), X(1,0,0)

- Tao bién s6 thuc tu do t thudc doan [0, 2pi] ~ ¢

- Tao Y la anh cua I qua phép quay véi truc ox, géc quay la t.

- Tao ham s6 y=f(X), chang han ham sb y=X72-2X, dt 1a ham s6 f.

o \
- Tao 2 bién s thyc tu do al, bl A\ N

- Tao 1énh chon ddi twong diéu khién bﬁng\bém phim gan cho céc bién al,

b1, t cac phim didu khién A, B, T. N

- V& db thi g ctia ham s6 f da tgo, gidi han d thi tir al dén bl (néu al>bl
thi ta diéu khién gié tri ciia al 520 cho nhé hon b1, dé d& kiém tra c6 thé

cho hién thi gia tri cﬁefal\, bl 1€n man hinh). Dién nhu sau:

Flane {3 points or with coordinate system): |L:IW

Expression of the function {(variabhle X}):

109
Limits {ex: -5 273): lal bl
Humber of points {20 to 1000): |1I]I]

Hame of the curwve: q

Graph of a function ==

ﬂ

Help Cancel Ok

Ln v |l e )L 3 )2 IR E 2R

- Duyng diém A (al, f(al)), B(bl, f(bl)) trong mit phang oXY.

- Duyng diém a, b 1an luot 12 anh ctia A, B qua phép chiéu vudng goc 1én

duong thang ox.
- Dung cac doan théng aA, bB. An cac diém A,B.X.Y.
- Tao vét cho cac doan théng aA, bB va do thi G.
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- Vao ché d6 tao vét, nhan phim T va diéu khién béng cac phim miii tén
dé quay mit phang tao mit tron xoay. Cho xoay hinh dé quan sat.
- C6 thé chon mau sic cho cac duong dé hinh vé& trong hap dan hon.

Pé thay d6i ham s ta Véﬁ inu Edit > Edit text of figure va d6i lai ham

4 . N A A 1
sO, va click vao Iénh Execute, Yes. Xem hinh:

LI L UUJ‘J‘JL L. FL“ (SR LR A B

v image of | by rotation with axis ox and angle t {radian)
Dirawing of v undrawn
X point with coordinates (1,0,0] in coordinate system Rxyz
Drawing of > _smallmark, undrawed name
f function: x| 4—Tha§; ham so nay bing ham s6 khac
al free real
Free object a1, parameter: 091695639853
b1 free real
Free; object b1, parameter: 267889442025

¢ Tuong ty ta c6 thé minh hoa cho bai toan vat thé tron xoay quay quanh

truc oy. Thay co c6 thé sang tao thém cho hinh minh hoa duoc phong

Iy X x .
u, na an non. am a0 ninn nay o tap un va € ron xoay truc
QN phu, hap dan hon. Tham khao hinh nay & tap tin “vat the t yt
\\ \ LY)
\ \ ox.g3w”.
~ %én d‘dy &L 1 58 muf/b %/j@ che e clwnf %M@A i /@/w’bn mem @emfwwe. @&4/

lo n/id%? i togn ca bin v t%ucm? W/@ nhit bmng viée an? hink hinh /,zc/, @
@@L/ Thanh NMan - THTC Nya Gia T G D, Ty ik »
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dé i n/uimy @ W y me v W J%u@t cia moi 65207 %& %% v wdli |

) oy - U :\‘.
jwgen sich whi nay s¢ giip ich cho qug Chay G, div mat phi M«ﬁ@;éx w‘"
gy wy ¢ gipe il oho quj Thiy phin kit iy
?m/n% da,y cia mink. Q\ /

G hicn thic cia lin thin cin kit han ok, hig gian thi Khing ei nin chua
P ) P A . » |~ /. o » )5 \X\)\} >
qua qui tinh tham hhio sich nay vi whing m\&%%/m wita, Chiy “Ci e the ty
s f NP " ; p A s N 2 ) a [ . A )
minh m i va W% cliw it 4@«7@4 va /@%@ licn cho cZML? Wﬁ/ %Z/LM’%

ol nghn g b g g2y iy Cing oght Ching tn teng doy foe
%‘;0%? qud tiinh W//b 1it\hoan \thanh gw%é’n sach chic chin cm whicw thiow 5L,
mang dude s ?a/@ % chan’thanh i 747/ %@ %@ Ve cudi am?, néw cé /Mif lien

| N 1
sich n@% (u‘;;? n@%}@ %@ vuh [Mf tim MW ?‘75” " 0577 sbe cia tac W
\\\

@ww Tharn Man - THTC Nyi Gia T Go L, Tag N s



